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Notice
Every effort was made to ensure that the information in this book was com-
plete and accurate at the time of printing. However, information is subject to 
change.

Avaya Web Page
The world wide web home page for Avaya is:
http://www.avaya.com

Preventing Toll Fraud 
Toll Fraud is the unauthorized use of your telecommunications system by an 
unauthorized party (for example, a person who is not a corporate employee, 
agent, subcontractor, or working on your company’s behalf). Be aware that 
there is a risk of toll fraud associated with your system and that, if toll fraud 
occurs, it can result in substantial additional charges for your telecommunica-
tions services.

Avaya Fraud Intervention
If you suspect that you are being victimized by toll fraud and you need techni-
cal assistance or support, call the Technical Service Center’s Toll Fraud Inter-
vention Hotline at 1.800.643.2353.

Providing Telecommunications Security
Telecommunications security of voice, data, and/or video communications is 
the prevention of any type of intrusion to, that is, either unauthorized or mali-
cious access to or use of, your company’s telecommunications equipment by 
some party.

Your company’s “telecommunications equipment” includes both this Avaya 
product and any other voice/data/video equipment that could be accessed via 
this Avaya product (that is, “networked equipment”).

An “outside party” is anyone who is not a corporate employee, agent, subcon-
tractor, or working on your company’s behalf. Whereas, a “malicious party” is 
Anyone, including someone who may be otherwise authorized, who accesses 
your telecommunications equipment with either malicious or mischievous 
intent.

Such intrusions may be either to/through synchronous (time-multiplexed and/
or circuit-based) or asynchronous (character-, message-, or packet-based) 
equipment or interfaces for reasons of:

• Utilization (of capabilities special to the accessed equipment)
• Theft (such as, of intellectual property, financial assets, or toll-facility 

access)
• Eavesdropping (privacy invasions to humans)
• Mischief (troubling, but apparently innocuous, tampering)
• Harm (such as harmful tampering, data loss or alteration, regardless of 

motive or intent)
Be aware that there may be a risk of unauthorized intrusions associated with 
your system and/or its networked equipment. Also realize that, if such an intru-
sion should occur, it could result in a variety of losses to your company, includ-
ing but not limited to, human/data privacy, intellectual property, material 
assets, financial resources, labor costs, and/or legal costs).

Your Responsibility for Your Company’s Telecommunications Security
The final responsibility for securing both this system and its networked equip-
ment rests with you – an Avaya customer’s system administrator, your tele-
communications peers, and your managers. Base the fulfillment of your 
responsibility on acquired knowledge and resources from a variety of sources 
including but not limited to:

• Installation documents
• System administration documents
• Security documents
• Hardware-/software-based security tools
• Shared information between you and your peers
• Telecommunications security experts

To prevent intrusions to your telecommunications equipment, you and your 
peers should carefully program and configure your:

• Avaya provided telecommunications systems and their interfaces
• Avaya provided software applications, as well as their underlying hard-

ware/software platforms and interfaces
• Any other equipment networked to your Avaya products

Federal Communications Commission Statement
Part 15: Class A Statement. This equipment has been tested and found to 
comply with the limits for a Class A digital device, pursuant to Part 15 of the 
FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial 
environment. This equipment generates, uses, and can radiate radio-fre-
quency energy and, if not installed and used in accordance with the instruc-
tions, may cause harmful interference to radio communications. Operation of 
this equipment in a residential area is likely to cause harmful interference, in 
which case the user will be required to correct the interference at his own 
expense.

Industry Canada (IC) Interference Information
This digital apparatus does not exceed the Class A limits for radio noise emis-
sions set out in the radio interference regulations of Industry Canada.

Le Présent Appareil Nomérique n’émet pas de bruits radioélectriques dépas-
sant les limites applicables aux appareils numériques de la class A préscrites 
dans le reglement sur le brouillage radioélectrique édicté par le Industrie Can-
ada.

Trademarks
All trademarks identified by ® and ™ are registered trademarks or trademarks 
of Avaya Inc. All other trademarks are the property of their respective owners. 

Ordering Information
Call: Avaya Publications Center

Voice 1 800 457-1235   International Voice +1 207 866 6701
Fax 1 800 457-1764      International Fax +1 207 626 7269

Write: GlobalWare Solutions
200 Ward Hill Avenue
Haverhill, MA 01835 USA
Attn: Avaya Account Management

Email: totalware@gwsmail.com

Obtaining Products
To learn more about Avaya products and to order products, visit 
www.avaya.com. 

European Union Declaration of Conformity
The “CE” mark affixed to the equipment means that it conforms to the refer-
enced European Union (EU) Directives listed below:
EMC Directive 89/336/EEC   
Low-Voltage Directive73/23/EEC
For more information on standards compliance, contact your local distributor.

Warranty 
Avaya Inc. provides a limited warranty on this product. Refer to your sales 
agreement to establish the terms of the limited warranty. In addition, Avaya’s 
standard warranty language as well as information regarding support for this 
product, while under warranty, is available through the following web site: 
www.avaya.com/support.
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About this book

Purpose

This book, Avaya™ S3400 Message Server featuring Avaya™ Modular 
Messaging (MM) Release 1 Installation, Issue 2, contains instructions for 
assembling and administering an S3400 messaging system. It includes 
procedures for equipment set up, configuration, initial administration, 
acceptance testing, and cut to service. 

Intended audiences

This book is intended primarily for the on-site technical personnel who are 
responsible for installing the system and performing initial administration and 
testing. 

We assume that the users of this book have completed a relevant hardware 
installation training course. See ‘‘Related resources’’ on page xi for 
information on training.

Changes to this book

Changes from Issue 1 (March 2003) to Issue 2 include:

� Some installation procedures have been updated in Chapter 4, 
‘‘Administering the MAS,’’ and Chapter 5, ‘‘Completing initial 
administration.’’

� A new Appendix F, ‘‘Recovering from a catastrophic disk failure,’’ has 
been added.
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How to use this book

Before you begin any installation:

� Complete all the worksheets listed in Appendix A, ‘‘System planning forms.’’ 
You cannot complete an installation without having this material complete and 
accurate. Some of the material must be provided in advance by the customer.

� Read Chapter 1, ‘‘Installation site requirements.’’ This chapter contains 
information on prerequisites and site preparation, including the tools and 
equipment you need to complete an installation. 

� Obtain the documentation you will need to complete the installation. See 
"Required software and documentation" in Chapter 2, ‘‘Installing the system 
hardware,’’ for details.

From there, read and use each chapter in the order presented. 

For an overview of the complete installation process, see Appendix B, ‘‘Installation 
checklist.’’ Procedures are listed in the order in which you must perform them.

Trademarks

The following trademarked products are mentioned in this book:

� Adobe and Adobe Acrobat are registered trademarks of Adobe Systems 
Incorporated.

� AUDIX, Avaya, and DEFINITY are registered trademarks of Avaya Inc.

� Linux is a registered trademark of Linus Torvalds.

� Microsoft, MS, MS-DOS, Windows, and NT are trademarks or are 
registered trademarks of Microsoft Corporation in the U.S. and other 
countries. 

� Netscape and Netscape Navigator are registered trademarks of Netscape 
Communications Corporation.
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Related resources

This section describes additional documentation and training available for you to learn 
more about the installation of this system.

Documentation

See the inside front cover for information on how to order documentation for this 
product.

Note: Always refer to the appropriate CD-ROM or book for specific information 
on planning, installing, administering, or maintaining an Avaya system. 
See the online catalog for more information on other books and CD-ROMs 
in the documentation set.

Technical assistance

Remote 
support 
center

Your project manager or systems consultant is responsible for providing you with the 
telephone number of your remote support center.

The following numbers are available for technical assistance with Avaya products and 
services:

Help on the 
system

Online help is available for both the system and administration command-line screens. 
On the web-interface screens, use the Help button. On the command-line interface, 
press F6 (Choices) from the field for which you want the help. 

Training 

For information about product training, go to the Avaya web site at www.avaya.com 
and click Training.

Within the United States 
and Canada

Call 1-800-242-2121 x85474.

Within any other country Call your local distributor.

http://www.avaya.com
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How to comment on this book

We are interested in your suggestions for improving this information. Use one of the 
following methods to communicate with us:

Please be sure to include the name of this book:

Avaya™ S3400 Message Server featuring Avaya™ Modular Messaging (MM) Release 
1 Installation, Issue 2. 

Method Contact

Email infodev@avaya.com

Voice mail or fax number 303-538-9625
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1
Site requirements

This chapter describes the site requirements for installing an Avaya™ S3400 Message 
Server system. 

Section Page

Installation site requirements 1-2

• Environmental requirements 1-2

• Weight and space considerations 1-2

• Customer-provided cabinet requirements 1-3

• Installation area requirements 1-3

• Power requirements 1-4

• Grounding requirements 1-4

Tools 1-5

Test equipment 1-5

Initial switch and LAN administration 1-6

• Initial switch or PBX administration 1-6

• Initial LAN administration 1-6

• Preinstallation planning forms 1-6

Demarcation points 1-7

• Demarcation point for switches (PBXs) 1-7

• Demarcation point for LAN connectivity 1-7

System security 1-8
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Installation site requirements

This section describes the physical requirements for the installation site, including 
environmental, weight, space, and power considerations.

Environmental requirements

Table 1-1 lists the environmental conditions that must be maintained in the area where 
the system is installed and maintained.  

Weight and space considerations

Table 1-2 lists the weight, height, width, and depth of each Message Storage Server 
(MSS) and the Messaging Application Server (MAS).One MSS and at least one MAS 
must be installed for every S3400 Message Server system.  

Table 1-1. Environmental requirements

Operating state Temperature Humidity (noncondensing)

Operating +10 to +35ºC 
(+50 to +95ºF)

20 to 60% 

Non-operating 
(in storage or 
being shipped)

-20 to +50ºC 
(-4 to+122ºF)

20 to 90%

Table 1-2. Server weight and space considerations

Server Weight (full) Height Width Depth

Message Storage Server 
Standard configuration 
(MSS-S)

41 lb.
(18.5 kg)

6.8 in.
(17 cm)

16.9 in.
(43 cm)

18.9 in.
(48 cm)

Message Storage Server 
High-availability 
configuration (MSS-H)

53 lb.
(24 kg)

6.8 in.
(17 cm)

16.9 in.
(43 cm)

18.9 in.
(48 cm)

Messaging Application 
Server (MAS)

40 lb.
(18 kg)
(without port 
boards)

6.8 in.
(17 cm)

16.9 in.
(43 cm)

18.9 in.
(48 cm)
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Customer-provided cabinet requirements

If the S3400 system is installed in a rack-mounted configuration, the 
customer-provided cabinet must meet the following requirements: 

� The cabinet must contain a 4-post rack to support the servers’ weight.

� The sliding rails and extender brackets provided with each server are 
designed for mounting in cabinets 22.5 to 32 inches in depth.

� The customer-provided cabinet must be secured to the floor before 
attempting to mount any units.

� The cabinet height needs to accommodate the number of units to be 
mounted (see Table 1-2 for server height).

Installation area requirements

Observe the following when determining where to place the system: 

� Maintain an air-distribution system that provides adequately cooled, 
filtered and humidity-controlled air. 

� Do not install the system such that the ventilation or fan openings will be 
blocked.

� At least two technicians are on site and available to mount the units.

� For T1/E1 connections, the circuits require isolation from exposed lines. 
For T1 lines, the customer must provide a CSU (T1) at the building point 
of entry. This CSU must be UL Listed and/or CSA Certified. For E1 lines, 
either the network provider or the customer must provide a CSU (E1) or 
other equivalent protection that has the product safety approvals 
required by the local jurisdictions. 

� Systems installed in Finland, Norway, Sweden and Australia must be 
installed in a restricted-access location. A restricted-access location is 
defined as an installation location where access can be gained only by 
service personnel or customers who have been instructed on the 
reasons for the restricted access and safety precautions that must be 
taken. A restricted-access location also allows access through the use of 
a tool (such as a lock and key) or other means of security.

CAUTION: To reduce the risk of fire, use only No. 26 AWG or 
larger telecommunication line cord.!

ATTENTION: Pour réduire les risques d’incendie, utiliser uniquement 
des conducteurs de télécommunications 26 AWG au de 
section supéleure.

!
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Power requirements

Table 1-3 lists the power requirements for the MSS-S, MSS-H, and MAS. The AC 
power supply source for the servers needs to be single phase 3-conductor (line, 
neutral, and ground) with a 15 A circuit breaker for 100-127 Vac installations or a 10 A 
circuit breaker for 200-240 Vac installations. 

Consideration must be given to the connection of the system to a branch circuit with 
respect to overload or overcurrent protection. Check the system's ratings to ensure 
that, together with other equipment connected to the same branch circuit, that an 
overcurrent or overload condition does not exist.

Grounding requirements

The system relies on the ground connection through the mains socket-outlet for 
continued safe operation. Ensure that the AC main outlet to be used to power the 
system (via the power cord or UPS) is a grounded outlet. If you are unsure of the 
ground integrity of the outlet, have a trained and certified electrician check the outlet. 

In addition, observe the following grounding requirements when determining where to 
place the system:

� Use only the power cord assembly provided to connect the system to the 
universal power supply (UPS) or to an AC mains outlet.

� Install the system within 6 feet (2m) of a grounded AC mains 
socket-outlet.

� Do not use extension cords with the system.

Table 1-3. Server power requirements

Server # of power 
supply units Volts AC Hertz Amperes 

120V/240V

MSS-S 1 100-240 +/– 10% 50/60 +/– 3 Hz 10/5

MSS-H 2 100-240 +/– 10% 50/60 +/– 3 Hz 6/3 for each 
supply

MAS 1 100-240 +/– 10% 50/60 +/– 3 Hz 10/5

WARNING: The S3400 Message Servers must be connected to an 
earthed mains socket-outlet. Failure to do so will result in 
allowing a hazard to be present that could cause severe 
personal injury or death.

!
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Tools

It is recommended that you have the following tools on site to successfully install a new 
system: 

� A medium-width flatblade screwdriver 

� A No. 2 Phillips screwdriver 

� A small pair of needlenose pliers 

� A small pair of wire cutters 

� A sharp, pointed instrument such as a ballpoint pen

Test equipment

Recommended test equipment for a successful installation includes: 

� A volt/ohm meter. 

� At least one telephone that is connected through the switch or Private 
Branch Exchange (PBX). It must be of the same type as the majority of 
telephones the customer will be using on the system. If the message 
waiting indicator (MWI) for the system is a lamp, the test telephone must 
be equipped with a lamp. If the MWI is a stutter tone, it must be able to 
give the stutter notification. The test telephone must be placed so that 
you can easily see the monitor while using it. 

� If fax messaging is to be installed, you need access to a fax machine.

CAUTION: System grounding must comply with the general rules for 
grounding provided in article 250 of the National Electrical 
Code (NEC), National Fire Protection Agency (NFPA), or the 
applicable electrical code in the country of installation.

!

CAUTION: Do not use the point of a lead pencil. The graphite can 
damage a circuit card, and cause problems such as 
electrical shorts.

!
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Initial switch and LAN administration

This section describes the initial switch or Private Branch Exchange (PBX) and local 
area network (LAN) administration that must completed by the customer before or 
during the installation of system hardware. 

Initial switch or PBX administration

Initial switch or PBX administration may or may not be complete when you arrive on 
site, depending on the contract or customer agreements. When you install a new 
system, the switch must be administered to support the following situations: 

� Testing each channel to be connected to the system before assigning 
the channels to the system or another application. During this testing, 
you must be able to call each channel individually. 

� Testing the system with at least one test subscriber. 

� Performing cut-to-service procedures that provide the subscribers with 
an active coverage path.

Verify that initial switch administration and testing is complete.

Initial LAN administration

The LAN administrator must administer the LAN for the messaging system. Some 
LANs might be administered prior to your arrival on site. Other LANs require that the 
administration for a new system be done at the time of installation. 

Preinstallation planning forms

It is crucial to coordinate the IP addresses that will be used with your Avaya messaging 
server with those on the corporate LAN. If you specify an Ethernet address for the 
Avaya server that conflicts with another Ethernet endpoint, the resulting problems with 
traffic on the local area network may be extremely difficult to diagnose and solve.

Complete the planning forms in Appendix A, ‘‘System planning forms,’’ prior to 
beginning an installation. By acquiring IP addresses, server, and domain name 
information in advance, you can save hours of installation time and debugging.

Note: Avaya is not responsible for the installation, administration, or test 
of communications between customer computers and the LAN.



June 2003

Site requirements

1–7585-310-326, Issue 2

Demarcation points

This section lists the demarcation points for switches (PBXs) and LAN connectivity.

Demarcation point for switches (PBXs)

The demarcation point switch (PBX) connections to the S3400 Message Server is the 
wall field for Avaya switches. 

For non-Avaya switches, it is the end of the connector of the Avaya-provided cables for 
the port boards. Avaya service technicians dispatched for the system installation are 
not responsible for making any connections directly to switches that are not maintained 
by Avaya.

Demarcation point for LAN connectivity 

The demarcation point for the LAN connection to the S3400 Message Server is the 
physical Ethernet interface on the messaging server that connects to the corporate 
LAN. The customer is responsible for: 

� The LAN cables that connect the messaging server to the corporate 
system (unless the customer uses the Avaya-provided cables, in which 
case the demarcation point is the modular connector at the end of the 
LAN cables). 

� LAN administration not performed on the S3400 Message Server 
system.

� Maintaining the TCP/IP addresses and administration on the system 
after cutover, unless otherwise specified by contract.

� Providing the IP address, subnet mask, and gateway information for 
administration on the system, as well as any DNS server IP information 
and corporate domain names.

Avaya service technicians dispatched for system installation are not responsible for 
troubleshooting the customer's LAN.

Note: Avaya recommends joint acceptance testing for systems integrated 
with switches that are not maintained by Avaya. 
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System security

During an installation, security of the customer's system is your responsibility. You must 
take precautions to protect: 

� Password security

� System security during the installation

Password security 

To protect password security: 

� Change the passwords for the system administrator (sa), voice mail 
administrator (vm), and craft logins on the MSS before beginning system 
verification and acceptance testing.

� Do not leave written passwords laying out or allow anyone to see them.

� At the first opportunity, give the passwords directly to the customer's 
designated representative.

� If you suspect that the security of any password has been compromised, 
notify your project manager or system administrator.

System security during the installation

To protect system security during the installation: 

� Remove all test subscribers and test mailboxes from the system when 
the procedures instruct you to do so.

� Do not configure any unassigned mailboxes. 

� Always log off the system if you will be leaving it unattended, even for a 
short period of time.

Note: Unassigned mailboxes are mailboxes that have an 
extension, but no subscriber assignment. 
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2
Installing the system hardware

This chapter describes how to install the S3400 Message Server system hardware.   

Note: Before you can successfully complete the tasks in this section, you 
must have read Chapter 1, ‘‘Site requirements,’’ and verified that all 
the site installation requirements have been met.

If any of the site installation requirements have not been met, do 
not continue with the hardware installation tasks in this chapter. 

Introduction 2-2

Unpacking the system hardware 2-3

• Required and optional hardware 2-3

• Required software and documentation 2-5

• Saving the packing materials 2-6

Installing the system hardware 2-6

• Installing the UPS and optional EBMs 2-8

• Installing the S3400 servers 2-12

• Installing the KVM switch 2-25

• Connecting the Ethernet cables 2-29

• Attaching ferrites 2-31

• Connecting the USB modem on the MAS 2-32

• Connecting the MSS RMB 2-34
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Introduction

An S3400 Message Server system contains two servers: a Message Storage Server 
(MSS)—either the Message Storage Server Standard configuration (MSS-S) or the 
Message Storage Server High-availability configuration (MSS-H)—and one or more 
Messaging Application Server (MAS) units. The servers are connected through a 
private Ethernet LAN to operate as a unified system. 

This chapter is organized as follows:

� "Unpacking the system hardware" on page 2-3

� "Installing the system hardware" on page 2-6

Because an S3400 system installation requires many steps, make a copy of the 
checklist in Appendix B, ‘‘Installation checklist.’’ Check off items as you complete them 
to track your progress.
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Unpacking the system hardware

This section lists the required and optional hardware, software, and documentation 
needed to successfully install and maintain an S3400 Message Server system. 

Required and optional hardware

Table 2-1 lists the required and optional hardware needed to set up an S3400 system. 
Verify that all the hardware components needed for this installation are on site.

Table 2-1. Required and optional hardware 

Item Quantity Required/optional

S3400 system components:

Message Storage Server (MSS)—either the Message 
Storage Server Standard configuration (MSS-S) or the 
Message Storage Server High-availability configuration 
(MSS-H)

1 required

Messaging Application Server (MAS) 1 minimum, 
4 maximum

required

Server AC power cables 1 per MAS server,
1 per MSS-S server,
2 per MSS-H server

required

Front bezel 1 per server required

Rack-mount assembly (rails, handles, brackets, and 
connecting hardware)
and rubber spacers for stackable desktop configuration 

1 set of each per server; 
use mount type required

required

Ethernet switch (includes power transformer and rubber 
spacers)

1 required

Ethernet LAN cables 2 per server required

MSS-specific components:

COM2 port adapter to RMB cable 1 required

External modem adapter for RMB with long cable 1 required only for 
International customers

DVD backup media 1 box required

MAS-specific components:

USB modem (includes USB cable) 1 per MAS server required

Port board cables (see Table 2-2) 1 set per port board required
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Table 2-2 lists supported port boards. These cards are preinstalled in the MAS, but the 
external cabling must be connected, and the cards must be configured during initial 
administration. The cabling varies per type of card. 

Other:

Monitor (includes power cord and VGA cable) 1 optional; may be 
customer-provided

Keyboard and mouse (includes cords and Y cable) 1 set optional; may be 
customer-provided

KVM switch (includes power transformer)

KVM switch cable to each server

includes 1 set of rack-mount brackets if needed for 
rack-mount setup

1 KVM switch

1 cable per server

1 set if needed

optional; other models 
of switching devices 
may be used

Uninterruptible power supply (UPS) with required power 
cord

includes 1 set of rack-mount brackets and rubber spacers 
for a stackable setup

1 • required for the 
MSS-H; model may 
vary

• optional for the 
MSS-S and MAS

Extended battery module (EBM) with required power cord

includes 1 set of rack-mount brackets and rubber spacers 
for a stackable setup

1 to 4 optional; may be 
ordered with the UPS

Table 2-1. Required and optional hardware 

Item Quantity Required/optional

Table 2-2. Supported MAS port boards 

Protocol Ports Port boards Max # Dialogic documents on CD

Analog 4 - 8
12 - 48

Dialogic 4-port T/R board
Dialogic 12-port T/R board

2
4

D/41JCT-LS (PDF 133K)
D/120JCT-LS (PDF 131K)

Digital Set 
Emulation

8 - 40 Dialogic D/82JCT-U 5 D/82JCT-U (PDF 240K)

T1-QSIG 23 - 69 Dialogic D/480JCT-T1 (dual) 3 Span JCT boards (PDF 99K)

E1-QSIG 30 - 60 Dialogic D/600JCT-E1 2 Span JCT boards (PDF 99K)
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Required software and documentation

The following software and documentation must be available on site in order to 
successfully install and maintain an S3400 Message Server system: 

� The following server software, if new software is necessary:

— Avaya™ Modular Messaging (MM) Release 1.0 for the Message 
Storage Server (MSS), Issue 1 or later, ED75011-10G10 (one CD).

— Avaya™ Modular Messaging (MM) Release 1.0 for the Messaging 
Application Server (MAS) software, Issue 1 or later, ED75011-10G15 
(two CDs).

� Avaya™ Modular Messaging (MM) Release 1.0 for the Messaging 
Application Server (MAS) application software, Issue 1 or later, 
ED75011-10G20 (one CD).

� Avaya™ Modular Messaging (MM) Release 1 Documentation, Issue 1, 
ED75011-10G5 (two copies of this CD).

� Detailed documentation for setting up the MAS port boards and using 
Modular Messaging applications. This includes the following (all 
available on the documentation CD):

— The appropriate port board installation documents listed in Table 2-2

— The Avaya™ Modular Messaging (MM) Subscriber Options User 
Guide (585-310-789, PDF 1 MB)

— The Avaya™ Mailbox Manager User Guide (PDF 1 MB)

— The backup procedures for the MSS. See “Backing up system files 
(attended)” and “Backing up system files (unattended)”.

� The configuration notes for integrating the Dialogic port boards installed 
in an MAS with the PBX or switch at this site. To view these: 

a. Access the support.avaya.com web site. 

b. Under Technical Database, click Messaging.

c. Scroll down to Modular Messaging and click General Info.

d. Download or print the appropriate configuration notes for your switch 
integration.

You can also access an editable Microsoft Word version of the planning 
forms from Appendix A, ‘‘System planning forms,’’ from this web site. 
Under the Modular Messaging link above, click R1.0 to access this file.

http://support.avaya.com
a_sysbr_2.htm
a_sysbr_2.htm
a_sysbr_3.htm
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Saving the packing materials

Save the shipping cartons and all packing materials in case any of the hardware needs 
to be returned to the manufacturer. If you ordered more than one MAS, saving one 
carton and one set of packing materials should be sufficient. Packing materials include: 

� Antistatic bags 

� Cardboard and foam inlays 

Also save the shipping cartons for all peripheral devices, such as the modems, 
Ethernet switch, monitor, keyboard/mouse, and UPS and EBM (if used). 

Installing the system hardware

This section covers how to install the required and optional system hardware. 
Hardware components that are optional are noted in the text. For more information 
about required and optional hardware, see Table 2-1 on page 2-3. 

The system can be installed in one or more customer-provided commercial cabinets as 
a rack-mounted system, or without a commercial cabinet as a stackable desktop 
system. This section includes instructions on how to install both rack-mounted and 
stackable desktop systems.

Only one Message Storage Server (MSS), either an MSS-S or an MSS-H, is installed 
per system. Up to four Messaging Application Server (MAS) units may be installed per 
system. 

Figure 2-1 on page 2-7 shows an example of an installed rack-mounted system. 

Note: The packing materials may include a plastic bag designed to 
protect the system from moisture during shipment. Discard this 
bag. It is not reusable. 

Note: The sample figure shows the MSS and MAS servers with their front 
bezels removed.
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Figure 2-1. Example of an installed rack-mounted system (front view)
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3COM

Alert

Power

1       2       3       4       5       6       7       8

Green = 100M, Yellow = 10M, Flash = Activity

Port Status

1       2       3       4       5       6       7       8

OfficeConnect Dual Speed Switch 8 plus

Duplex

On = full

MultiModem USB

MultiTechSoftware
PWR

7

1

2

3

4

5

6

8

1 Customer-provided cabinet (type may vary; see physical requirements in 
"Installation area requirements" on page 1-3)

2 EBM (optional; 0 to 4 may be installed with a UPS)

3 UPS (required for MSS-H, optional for MSS-S; model may vary)

4 Required Message Storage Server (MSS), may be MSS-H or MSS-S

5 Messaging Application Server (MAS); 1 to 4 units may be present

6 KVM switch (type may vary)

7 Ethernet switch (one is always required)

8 External modem, one required for every MAS unit
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Installing the UPS and optional EBMs

This section describes how to install an uninterruptible power system (UPS) and one or 
more optional extended battery modules (EBMs). 

� Customers may order a different model of UPS, or supply their own. See 
the documentation that came with the UPS for instructions if needed.

� If the customer did not purchase a UPS, continue with the next section, 
"Installing the S3400 servers" on page 2-12.

The UPS is a required component for the MSS-H but is optional for the MSS-S. The 
UPS protects the system from most common power problems including power failures, 
power sags, power surges, and so on. 

The EBM is an optional component that works in conjunction with the UPS to add 
additional run time for the system. The customer has the option of adding up to four 
EBMs per UPS. For more information, see the documentation that was shipped with 
the EBM and UPS.

Installing the UPS and any EBMs into a rack

If you are installing a rack-mounted system, continue with this task. Otherwise, 
continue with "Installing the UPS and any EBMs as a stackable configuration" on page 
2-10. 

The UPS and EBMs must be positioned in the rack below the S3400 servers, with the 
EBM units in the lowest-available rack position. 

To install the UPS and EBMs into a rack:

1. Gather the necessary rack-mount hardware, including the mounting 
handles, brackets, and screws. 

2. Place the UPS on a flat, stable surface with the front of the UPS facing 
toward you.
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3. Attach the mounting handle to each bracket using the supplied screws. 
See item 1 in Figure 2-2.

4. Align the mounting brackets with the screw holes on the side of the UPS 
and secure using the supplied screws. See item 2 in Figure 2-2.

5. If you are installing one or more EBMs, repeat steps 1 through 4 for each 
EBM. 

6. Place the EBM into the rack in the lowest-available rack position and 
attach the EBM to the rack using customer-provided screws. 

7. Place the UPS into the rack in the lowest-available rack position above 
any EBMs and attach the UPS to the rack using customer-provided 
screws.

8. Continue with the "Cabling the UPS and any EBMs" on page 2-11.

Figure 2-2. Attaching mounting handles and bracket for a rack-mounted UPS

Note: The EBMs must be installed below the UPS.

Note: If additional EBMs need to be installed into the rack, install 
them above the first installed EBM.

brvyupsm LAO 110202

1

2
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Installing the UPS and any EBMs as a stackable configuration

To configure the UPS and any EBMs in a stackable configuration:

1. If you are installing one or more EBMs, remove the adjacent corner 
screws from the rear panels. See Figure 2-3 for the location of these 
screws. If you do not have any EBM units, go to step 4.

2. Install the EBM brackets by aligning each bracket with the screw holes 
and secure the bracket the supplied screws as shown in Figure 2-3.

3. Repeat steps 1 and 2 for each additional EBM.

4. On the bottom unit (either the UPS, or an optional EBM), secure four 
rubber spacers to the bottom of the unit, one at each corner.

5. Set the unit on a stable platform. This unit will form the base of the 
S3400 system.

Figure 2-3. Attaching connecting brackets between a UPS and EBM (back view)
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Cabling the UPS and any EBMs

To cable the UPS and any EBM units: 

1. Connect the EBM cable to the battery connector on the UPS. See item 1 
in Figure 2-4. 

2. If you need to connect additional EBMs, plug the EBM cable of the 
second EBM into the battery connector on the first EBM. 

3. Repeat step 2 for each additional EBM. Up to four EBMs may be 
connected to the UPS. 

Figure 2-4. Connecting a UPS and an EBM (back view)

COMM PORT
IOIOI

ISOLATED
ALARM PORT

crvyupse LAO 110702

1

2

3

4

5

1 UPS (model may vary; see the provided documentation for details)

2 EBM (optional; 0 to 4 may be installed)

3 EBM battery cable to UPS

4 Battery connectors for additional EBMs if needed (optional)

5 UPS power cable to a grounded AC power outlet
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Installing the S3400 servers

This section describes each of the S3400 servers, and how to install them in a 
customer-provided commercial cabinet or in a stackable desktop configuration. 

Identifying the server components

This section describes the key components of each of the S3400 servers, including the 
MSS-S, MSS-H, and MAS. 

Key components of the MSS-S

Figure 2-5 shows the Message Storage Server Standard configuration (MSS-S). 

Figure 2-5. MSS-S standard configuration (front view with bezel removed)
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1 Redundant chassis fans

2 Chassis fan retaining screw

3 System reset button

4 Disk drive access indicator

5 System power indicator

6 System power on/off button

7 DVD-RAM drive

8 IDE RAID disk drive C (hdc)

9 IDE RAID disk drive A (hda)
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Figure 2-6 shows the back view of a Message Storage Server Standard configuration 
(MSS-S). 

Figure 2-6.  MSS-S standard configuration (back view)
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1 Power supply

2 AC power receptacle

3 Power supply on/off switch

4 Latch for top cover

5 Mouse connector

6 Keyboard connector

7 Serial port (COM1)

8 Parallel port (not used)

9 Serial port (COM2), used for RMB

10 Corporate LAN interface

11 USB ports

12 Audio connectors (not used)

13 Video card (contains monitor connector)

14 Network interface card (used for private LAN to MAS units)

15 Remote Maintenance Board (connects to analog line for alarm reporting and 
servicing; international versions require an external modem)
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Key components of the MSS-H

Figure 2-7 shows the Message Storage Server High-availability configuration (MSS-H). 

Figure 2-7. MSS-H high-availability configuration (front view with bezel removed)
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1 Redundant chassis fans

2 Chassis fan retaining screw

3 System power indicator

4 Disk drive access indicator showing activity on any hard disk drive

5 System reset button

6 Power supply failure indicator

7 Power supply alarm buzzer reset switch

8 Disk drive access indicator for each hard disk drive (HDD 0, 1, and 2)

9 System power on/off button

10 DVD-RAM drive

11 SCSI RAID drive 0

12 SCSI RAID drive 1

13 SCSI RAID drive 2

14 SCSI fan tray
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Figure 2-8 show the back view of a Message Storage Server High-availability 
configuration (MSS-H). 

Figure 2-8.  MSS-H high-availability configuration (back view)
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1 Redundant power supply

2 Power supply on/off switch 

3 AC power receptacle

4 Latch for top cover

5 Mouse connector

6 Keyboard connector

7 Serial port (COM1)

8 Parallel port (not used)

9 Serial port (COM2), used for RMB

10 Corporate LAN interface

11 USB ports

12 Audio connectors (not used)

13 Video card (contains monitor connector)

14 Network interface card (used for private LAN to MAS units)

15 SCSI RAID controller card

16 Remote Maintenance Board (connects to analog line for alarm reporting and 
servicing; international versions require an external modem)

17 Reset switch for faulty power supply alarm
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Key components of the MAS

Figure 2-9 shows the Messaging Application Server (MAS). You may have up to four 
MAS units per S3400 system. 

Figure 2-9. MAS (front view with bezel removed)
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Figure 2-10 shows the back view of a Messaging Application Server (MAS). 

Figure 2-10.  MAS (back view)
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1 Power supply

2 AC power receptacle

3 Power supply on/off switch

4 Latch for top cover

5 Mouse connector

6 Keyboard connector

7 Serial port (COM1)

8 Parallel port (not used)

9 Serial port (COM2)

10 Corporate LAN interface

11 USB ports, one of which is used for the required modem

12 Audio connectors (not used)

13 Video card (contains monitor connector)

14 Network interface card (used for private LAN to MSS)

15 Port boards (type varies from machine to machine). Up to five port boards can 
be installed in each unit (depending on the type of board and traffic 
requirements), typically starting from the end of the cabinet. 
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Attaching the front bezel

The front bezel must be attached to each S3400 server unit as described. 

1. Insert the bottom of the front bezel into the chassis. See item 1 in Figure 
2-11.

2. Push the bezel upright until the two upper tabs snap into place under the 
top cover. 

Installing the S3400 servers in a rack-mount or stackable setup

The S3400 servers can be installed either in a commercial cabinet in a rack-mount 
configuration, or stacked on top of one another in a desktop configuration. Identify the 
installation method to be used at your site, then see the appropriate section: 

� "Installing the servers in a rack-mount configuration" on page 2-19

� "Installing the servers in a stackable desktop configuration" on page 
2-21

Figure 2-11. Attaching the front bezel
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CAUTION: The S3400 servers are heavy. Get another person 
to assist you with lifting and placing the server 
units.

!
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Installing the servers in a rack-mount configuration

The task describes how to install an MSS-S or MSS-H and one or more MASs in a 
commercial cabinet. This is also called a rack-mount configuration.  

Before you begin to install the servers into the rack, verify that the necessary 
rack-mount hardware is on site. Required equipment is summarized in Table 2-3.

To install a server into a rack:

1. Gather the necessary rack-mount hardware as listed in Table 2-3. 

2. Place the server on a flat, stable surface.

3. If the mounting handles are not already attached, attach them now:

a. Connect the handles to the bracket using the supplied flat-head screws. 
See item 1 in Figure 2-12 on page 2-20.

b. Align the mounting bracket with the screw holes on the side of the server 
and secure using the supplied flat-head screws. See item 2 in Figure 2-12.

4. Attach the rack-mount rails to the server as follows:

a. Remove the two screws and retaining bar on the rail slide just before the 
server-retaining latch. Set them aside for later. See item 3 in Figure 2-12.

Note: The MSS-S or MSS-H is typically installed directly above the UPS. 
If the customer did not purchase a UPS, install the MSS-S or 
MSS-H in the lowest available position in the cabinet. The first 
MAS is typically installed directly above the MSS-S or MSS-H. 

If the customer purchased more than one MAS, you typically install 
each additional MAS above the first MAS. However, all the servers 
in an S3400 system do not have to be in the same cabinet.

Table 2-3. Required rack-mount hardware

Part Quantity

Extension bracket (two different lengths may be shipped) 2 per server

Right-side rack-mount rails and slides 1 set per sever

Left-side rack-mount rails and slides 1 set per sever

Front panel handle set (handles and mounting brackets; these 
may already be assembled on some units)

1 set per server

Miscellaneous screws and mounting hardware 1 set per server

Customer-provided: Mounting hardware to secure the extension 
bracket and rack-mount slide to the customer-provided rack.

1 set per rack-mount rail 
and extension bracket
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b. Disassemble the slide (necessary to access all three screw holes).

c. Place the flat piece of the rail slide against the server and secure it with the 
three supplied flat-head screws. See item 4 in Figure 2-12.  

5. Position the extension bracket on end of the rail slide to provide the 
depth needed for the server to fit in the rack. A couple of extension 
brackets may be shipped; choose the correct length for your cabinet. 
See item 5 in Figure 2-12.

6. Attach the extension bracket to the rear of the rail slide using the 
supplied screws and retaining bar (2 pan-head screws per bracket). See 
item 6 in Figure 2-12.

7. Connect the extension bracket and rail slide to the customer-provided 
four-post rack using the correct customer-provided hardware for that 
model of cabinet. See item 7 in Figure 2-12.

8. Fully extend the rail slides to the locked-out position.

9. With another technician supporting the unit, align the front of the rail 
slide with the rack-mount rail that is attached to the server.

10. Push the unit onto the rail slide far enough so that the safety catch 
engages.

Note: The rack-mount rails are labeled L for left and R for right. Verify 
that you are installing the correct rail on the correct side.

Figure 2-12. Attaching server mounting handles, bracket, and rack-mount rail assembly
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11. Slide the server completely into the rack. Ensure that the server moves 
smoothly in an out of the rack.

12. Reattach the two screws and retaining bar on the rail slide just before 
the server-retaining latch (item 3 in Figure 2-12, from step 4a).

13. Repeat steps 2 through 10 for each server that needs to be installed.

14. When all servers are mounted, continue with "Connecting the S3400 
power cables" on page 2-22.

Installing the servers in a stackable desktop configuration

If the system is to be installed in a stackable desktop configuration, you must install 
four rubber spacers on the bottom on each of the servers. This allows you to stack the 
servers on top of one another. 

See Figure 2-13 for a sample configuration.

CAUTION: For safety, do not stack more than two servers atop one 
another; use multiple stacks if needed. If you have a UPS 
and an EBM, stack only one server on top of them.

!

Figure 2-13. Installing rubber spacers for a stackable desktop configuration
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To install the servers in a stackable desktop configuration:

1. Gather the rubber spacers shipped with each server.

2. Attach the rubber spacers to the bottom of each of the servers, one at 
each corner. See Figure 2-13 for an example.

3. Place the MSS-S or MSS-H on top of the UPS (if present). If the 
customer did not purchase a UPS, place the unit in an appropriate 
location. See Chapter 1, ‘‘Site requirements,’’ for more information. 

4. Place the first (required) MAS on top of the MSS-S or MSS-H. 

5. If the customer purchased additional MAS units, create a second stack, 
placing each additional MAS on top of the last one.

Connecting the S3400 power cables

See the figures in "Installing the S3400 servers" on page 2-12 if you need help locating 
the power connections on the back of the servers. 

To connect the power cables:

1. Connect the female end of the power cable for the required MSS to the 
male power connector located on the back of the MSS-S or MSS-H.

2. Connect the male end of the MSS-S or MSS-H power cable to an AC 
receptacle located on the back of the UPS (if present), or to an 
appropriate AC power outlet. See Figure 2-14 for an example.

3. For an MSS-H: repeat steps 1 and 2 for the second MSS-H power 
supply.

4. Connect the female end of the MAS power cable to the male power 
connector on the back of the MAS.

5. Connect the male end of the MAS power cable to AC receptacle on the 
back of the UPS (if present), or to an appropriate AC power outlet.

6. If you have more than one MAS: repeat steps 4 and 5 for each MAS.

7. If the customer is using a UPS, connect the UPS power cable into an 
appropriate AC power outlet.
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Figure 2-14. Attaching power cables to a UPS (sample configuration)
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1 UPS (model may vary; see the provided documentation for details)

2 EBM (optional; 0 to 4 may be installed)

3 UPS power cable to a grounded AC power outlet

4 AC power cable to required MSS

5 AC power cable to required MAS

6 AC power cable for redundant power supply on MSS-H (if an MSS-H is 
installed) or for additional optional MAS (up to 4 may be installed)

7 AC-to-DC transformer for Ethernet switch

8 Additional AC sockets; use as needed for external modems, the KVM switch 
and monitor (if desired), or any additional MAS units
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Connecting the MAS port boards

Each MAS unit may have up to five voice port boards. See Table 2-2 on page 2-4 for a 
list of supported Dialogic port boards and their associated documentation (copies of 
which are on the documentation CD). 

Connect the cables supplied with your voice port board to the switch as described in 
this section.

1. Identify the type of port boards installed in your MAS.

2. Connect each port on the port boards to the switch (PBX) as required:

� For analog boards: 

a. Connect each port on the installed analog boards to one end of a standard 
RJ-11 tip/ring cord (individual tip/ring cables and a 12-port harmonica may 
also be used). Note which cables connect to which ports.

b. The other end of the cable should be connected to an analog line on the 
corporate switching system. The entity responsible for maintaining the 
corporate switch should make this connection (see the customer contract 
or the statement of work).

� For set emulation boards: 

a. Connect each port on the Dialogic set emulation board using the provided 
PBX station interface cable (06-0155-001).

b. The other end of the cable should be connected to a 4-wire punch-down 
block on the corporate switching system.The entity responsible for 
maintaining the corporate switch should make this connection (see the 
customer contract or the statement of work). 

� For T1- or E1-QSIG boards: 

a. Connect each port on the Dialogic T1-QSIG or E1-QSIG board using the 
provided RJ-48C (Ethernet) cable.

b. The other end of the cable should be connected through a patch panel to a 
4-wire punch-down block on the corporate switching system.The entity 
responsible for maintaining the corporate switch should make this 
connection (see the customer contract or the statement of work). 

Note: Check the numbering on the board’s faceplate to make sure 
that you are connecting the correct cord to the correct port. 
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Installing the KVM switch

A keyboard, video, and mouse (KVM) switch is currently required for all S3400 
systems. However, the model of KVM switch and the specific monitor, keyboard, and 
mouse used may vary from site to site (for example, a flat-panel monitor setup may be 
used instead). See Figure 2-1 on page 2-7 for a sample installation. 

To install the Belkin OmniView Pro2 Series KVM switch:

� For rack-mounted installations, see Installing the KVM switch in a 
rack-mount configuration. 

� For a stackable desktop configuration, see "Installing the KVM switch in 
a stackable configuration" on page 2-26.

Installing the KVM switch in a rack-mount configuration

To install the Belkin OmniView Pro2 Series KVM switch in a commercial cabinet:

1. Gather the necessary rack-mount hardware, including the adjustable 
mounting brackets and screws. 

2. Select a bracket-hole scheme to determine how far the KVM switch 
should protrude from the rack. 

3. Install the two rack-mount brackets on the KVM switch using the 
provided screws. See Figure 2-15.

4. Install the KVM switch into the rack above the last installed MAS.

5. Continue with "Connecting the KVM cables" on page 2-26.

Figure 2-15. Attaching mounting brackets for a rack-mounted KVM

brvykvmm LAO 120502
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Installing the KVM switch in a stackable configuration

To install the Belkin OmniView Pro2 Series KVM switch in a stackable desktop 
configuration: 

1. Place the KVM switch on top of the uppermost MAS. Rubber spacers 
are already in place. 

2. Continue with connecting the KVM cables.

Connecting the KVM cables

The Belkin OmniView Pro2 Series KVM switch must first be connected to the keyboard, 
monitor, and mouse, and then to the MSS and MAS units, as described in this section. 

Connecting the KVM switch to the keyboard, monitor, and mouse

The KVM switch setup for the keyboard, monitor, and mouse may vary from site to site, 
depending on the equipment and cabling used. This section provides instructions for a 
Belkin OmniView Pro2 Series KVM switch setup. 

To connect the KVM switch to the keyboard, monitor, and mouse:

1. If a new monitor or keyboard/mouse was ordered for this system, 
unpack them now. Otherwise, continue with step 2. 

� Set up the monitor in the desired location.

� Connect the keyboard/mouse to the monitor.

� Plug the female end of the monitor’s power cable into the monitor.

� Plug the male end of the monitor’s power cable into a free UPS 
receptacle (if available) or into a grounded AC outlet.

2. Connect the VGA cable from the monitor to the female port on the back 
of the KVM switch labeled “Console VGA.” See item 1 in Figure 2-16 on 
page 2-27.

3. Tighten the thumbscrews on the video cable connector with your fingers 
or with a small flatblade screwdriver.

Note: If a new monitor was not purchased with the system, any 15" or 
greater monitor can be used.
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4. Connect the PS/2 cables for the mouse and keyboard to their 
corresponding connectors on the back of the KVM switch in the 
“Console” section using the Y cable. See item 2 in Figure 2-16.

The mouse connector is color-coded green, and the keyboard connector 
is color-coded purple. 

Figure 2-16. Connecting a Belkin OmniView Pro2 Series KVM switch (rear view)
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5. Attach the KVM power cable to the DC power jack labeled “DC 12V, 1A” 
on the rear of the KVM switch. 

6. Connect the other end of the KVM power cable (the AC-to-DC 
transformer) to a receptacle located on the back of the UPS (if present) 
or to an appropriate power outlet.

When power is connected, the LED for port 01 begins flashing.

7. Push the direct-access port selectors for ports 01 through 08 in order. 
The corresponding LED should flash as each button is pressed, 
indicating that the port is ready for the server connection. 

Connecting the KVM switch to the S3400 servers

To connect the KVM switch to the installed MSS and MAS units: 

1. Using the provided KVM cable, plug the male VGA connector into the 
VGA port on the MSS unit. See Figure 2-16 on page 2-27.

2. Connect the PS/2 keyboard and mouse connectors of the KVM cable to 
the keyboard and mouse ports on the back of the MSS unit.  

3. Connect the other end of the KVM cable to the port on the back of the 
KVM switch labeled VGA 01.

4. Connect the ends of the cables to the keyboard and mouse ports located 
directly underneath the VGA 01 port.

5. Using the second provided KVM switch cable, plug the male VGA 
connector into the VGA port on the first MAS unit. This port is in the first 
PCI card slot on every S3400 server.

6. Connect the PS/2 keyboard and mouse connectors of the KVM cable to 
the keyboard and mouse ports on the MAS unit.

7. Connect the other end of the KVM cable to the port on the back of the 
KVM switch labeled VGA 02.

8. Connect the ends of the cables to the keyboard and mouse ports located 
directly underneath the VGA 02 port.

9. Repeat steps 5 through 8 for each additional MAS unit, connecting to 
port VGA 03, VGA 04 and so on, as needed.

Note: The mouse connector is color-coded green, and the keyboard 
connector is color-coded purple.
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Connecting the Ethernet cables

A pair of standard Ethernet cables is shipped with every S3400 server. Use these 
cables to make the two required LAN connections: one to a private LAN through an 
Ethernet switch, and one to the corporate LAN. Both of these connections are covered 
in this section. 

Connecting the S3400 servers to the private LAN

The private LAN allows the MSS and any MAS units to communicate. 

To connect the S3400 servers to the private LAN:

1. Unpack the Ethernet switch. This section assumes you are using a 
3COM Office Connect Dual Speed Switch 8 Plus model.

2. Attach the rubber spacers to the four marked areas in each corner on 
the bottom of the Ethernet switch. See Figure 2-17 on page 2-30. 

3. Place the Ethernet switch on top of the KVM switch unit.

4. A suitable power cord and transformer for your region should have been 
shipped with your Ethernet switch. 

a. Peel back the label, then insert the end of the Ethernet switch power cable 
into the DC power connector on the back of the switch.

b. Connect the other end of the AC-to-DC transformer to the back of the UPS 
(if present) or to an appropriate AC power outlet.

5. Connect the private LAN cables for each of the S3400 servers. See 
Figure 2-17 for an example.

� MSS: Connect the provided Ethernet cable between the RJ45 
jack on the NIC and the first Ethernet interface on the back of the 
switch, labeled 1.

� MAS: Connect the provided Ethernet cable between the RJ45 
jack on the NIC and the second Ethernet interface on the back of 
the switch, labeled 2.

� Additional MASs (if present): Connect the provided Ethernet cable 
between the RJ45 jack on the NIC in each unit with the next 
Ethernet available interface on the back of the switch, labeled 3, 
4, and so on. 

CAUTION: Do not connect the private LAN switch to the corporate LAN.!



585-310-326, Issue 2

Avaya™ S3400 Message Server Release 1 Installation

2–30 June 2003

 
Figure 2-17. Connecting the MSS and MAS servers to an Ethernet switch (rear view)
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Connecting the S3400 servers to the corporate LAN

To connect each MSS and MAS unit to the corporate LAN: 

1. Connect one end of the standard Ethernet cable (provided with the 
server) to the RJ45 connector on the back of the server. See Figure 2-17 
on page 2-30.  

2. The other end of this cable should be connected to an Ethernet interface 
on the corporate LAN. The entity that is responsible for maintaining the 
corporate LAN should make this connection (see the customer contract 
or the statement of work).

3. Repeat steps 1 and 2 for each S3400 server in your configuration.

Attaching ferrites

Ferrites must be attached to the following S3400 system video cable and to each T1- 
or E1-QSIG port board cable (if present on the MAS) to meet electromagnetic 
conductance (EMC) regulations. The optional flat-panel monitor with an integrated 
KVM switch also requires ferrites. 

To install a ferrite on a cable: 

1. For all systems: Locate the video connector in the first slot on the back 
of the S3400 system unit.

2. Open the ferrite by gently pulling the fastener away from the body of the 
ferrite. See Figure 2-18 on page 2-32.

7 Ethernet interface to private LAN on first MAS (typically Ethernet switch port 2); 
subsequent MAS units would use ports 3, 4, and so on

8 Private LAN interface on MAS (NIC card in second PCI slot)

9 Ethernet interface to corporate LAN on MAS 

Note: Make sure that you connect the Ethernet cable for the 
corporate LAN to the Ethernet interface on the back of the 
server. The Ethernet interface on the NIC in the PCI slot is 
used for the private LAN.

CAUTION: Handle all ferrites with care. They are easily broken. Do not 
use any that are broken or fractured. Damaged ferrites are 
no longer effective for EMC control.

!
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3. Place the cable cord in the groove inside the ferrite, then gently snap the 
ferrite shut.  

4. Attach a large cable tie directly behind the ferrite to secure it. Trim the 
cable tie. 

5. For systems that use a T1- or E1-QSIG port board: Repeat steps 2 
through 4 to attach a ferrite to each QSIG port board cable.

6. For systems that use a flat-panel monitor: Repeat steps 2 through 4 to 
attach a ferrite to the mouse and keyboard cables at each server. One 
ferrite can be used for both cables.

Connecting the USB modem on the MAS

A USB modem is required for each installed MAS. The type of modem you have may 
vary depending on your location. See the documentation included with your modem if 
you have questions about modem installation, setup, or operation. 

This section describes a MultiTech USB modem setup. See Figure 2-19 on page 2-33 
for an example.

Note: Place ferrites as close as possible to the chassis to minimize 
the amount of cable between the ferrites and the chassis.

Figure 2-18. Attaching a ferrite to a cable
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To connect a USB modem:

1. Attach the rubber spacers to the four marked areas in each corner on 
the bottom of the modem (if spacers are not already in place).

2. Place the USB modem on top of the KVM switch or in a secure location 
as required. 

3. Connect one end of the USB cable to the back of the USB modem.

4. The other end of the USB cable will be attached to one of the USB ports 
on the back of the MAS when you set up remote access. USB port A is 
recommended as shown in Figure 2-19.  

5. Connect the RJ-11 cable to the LINE connector on the modem. 

Note: Do not actually plug the cable into the USB port until directed in 
"Setting up remote access" on page 4-20.

Figure 2-19. Connecting a USB modem to an MAS server (rear view)
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6. The other end of the cable should be connected to an analog line on the 
corporate switching system. The entity responsible for maintaining the 
corporate switch should make this connection (see the customer 
contract or the statement of work).

7. Repeat steps 1 through 5 for each MAS modem that needs to be 
installed.

Connecting the MSS RMB 

A Remote Maintenance Board (RMB) is installed in every MSS unit. This board sends 
system alarms to a remote maintenance center, and allows Services personnel to dial 
in to repair or update the S3400 system. 

The RMB setup varies depending on your location: 

� A domestic (United States) setup uses an on-board modem. See Figure 
2-20 on page 2-35.

� An international setup uses an external modem that meets the operating 
requirements for that region. See Figure 2-21 on page 2-36 for a sample 
setup.  

To install the RMB:

1. Connect the adapter end of the RMB-to-COM2 cable to the COM2 serial 
port on the back of the MSS. Tighten the thumbscrews on the adapter. 

2. Attach the other end of the cable to the lower RJ45 jack on the RMB 
faceplate. Make sure the jack snaps securely in place.

3. Make the appropriate connections based on the type of RMB installed: 
either an on-board model or an external modem.

Note: The type of external modem used with the RMB varies 
depending on geographical location. See the documentation 
included with your modem if you have questions about modem 
installation, setup, or operation.
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� On-board modem (United States): Connect a standard modular 
telephone cord to the RJ11 jack near the top of the RMB 
faceplate. See Figure 2-20. 

� External modem (international): Connect the RMB as described. 
See your modem documentation for details if needed:

� Connect the modular end of the RMB-to-modem adapter cable to the 
upper modular jack on the RMB. See Figure 2-21 on page 2-36.

� Plug the adapter end of the cable into the external modem’s RS-232 
connector. Tighten the thumbscrews on the adapter. 

� Connect the required telephone cord to the external modem.

Figure 2-20. Connecting an RMB with an on-board modem (rear view)
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4. The other end of the telephone cord should be connected to an analog 
line on the corporate switching system. The entity responsible for 
maintaining the corporate switch should make this connection (see the 
customer contract or the statement of work).

Figure 2-21. Connecting an RMB with an external modem (rear view)
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3
Powering up the system and

performing initial MSS
administration

This chapter describes how to power up the S3400 system and perform initial 
administration on the Message Storage Server (MSS).  

Note: Before you can successfully complete the tasks in this section, you 
must have successfully completed the hardware installation tasks 
in Chapter 2, ‘‘Installing the system hardware.’’ 

Section Page

Powering up the S3400 system 3-2

Logging in to the MSS server 3-3

Setting up the monitor 3-4

Setting the time and date 3-5

Setting up network addressing 3-6

Administering the message core 3-10

• Accessing the messaging administration screens 3-10

• Setting up the MSS host machine profile 3-11

• Setting up the trusted servers 3-12

Rebooting the MSS 3-14
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Powering up the S3400 system

This task assumes that you have already assembled and correctly connected all 
required hardware components. 

To power up the S3400 system:

1. Verify that the power cables for the S3400 servers and all peripheral 
equipment are connected to the UPS or an appropriate AC power outlet. 
See Figure 2-14 on page 2-23 for an example:

� UPS (if present): connected to an appropriate AC power outlet.

� MSS and any MAS units: each connected to the UPS (if present), 
or to an appropriate AC power outlet.

� KVM switch and monitor: optionally connected to the UPS (if 
present), or to an appropriate AC power outlet.

� Ethernet switch: connected to the UPS (if present), or to an 
appropriate AC power outlet.

� External modems: if a power cord is required, it may optionally be 
connected to the UPS (if present), or to an appropriate AC power 
outlet.

2. If a UPS is present: Press the On button located on the front of the UPS. 
The appropriate lamps should light (see your UPS documentation). 

3. Press the monitor’s power button.

The power lamp on the monitor should light.

4. If an external modem is present, press the On button if needed. The 
appropriate lamps should light (see your modem documentation). 

5. Verify that the power lamps for the Ethernet switch and KVM switch are 
lit (these units do not have on/off buttons).

6. Power up the MSS unit first. 

a. Toggle the power switch at the rear of the unit to on (| is on, 0 is off).

b. Press the power button on the front of the unit.

The LEDs on the front of the unit will flash once, then the LEDs will 
light to indicate system power and drive activity.

c. Wait up to 1 minute for the display to appear on the monitor.

Note: Always power up the UPS first, if a UPS is installed.
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7. Power up the MAS units next, using the same procedures as in step 6. 

� See the figures in ‘‘Installing the S3400 servers‘‘ on page 2-12 if you 
need help locating the power switch or power button on each server.

� The power lamp on the front of each server should light when the unit 
is powered on.

Logging in to the MSS server

When the S3400 system is powered up, you must first log in to the MSS server. (either 
the MSS-S or MSS-H). Because this system is not yet administered, you can only 
access the MSS from the console (monitor) directly connected to the KVM switch. 

To log in to the MSS from the console:

1. The KVM switch should be connected to the MSS through the first 
computer port (VGA 01). Verify that the monitor is showing the MSS boot 
procedure.

� If the monitor is not showing the correct server boot procedure, 
see ‘‘Connecting the KVM cables‘‘ on page 2-26 and verify the 
cable connections. To correct cabling problems, power down the 
system correct the cabling, then power up the system again. 

� For a Belkin OmniView Pro2 KVM: To have the monitor show a 
different server, press slowly in sequence Scroll Lock, then Scroll 
Lock, then the up (or down) arrow key to change to the server 
connected to a higher or lower port number. 

You can alternatively type the port number instead of pressing the 
up or down arrow key (such as 02 for port 2). See your KVM 
switch documentation for complete user instructions.  

2. As the MSS boots up, a splash screen appears. 

Optional: To bypass this screen and speed up the initial boot procedure:

� Press Esc to clear the splash screen.

� Press the space bar to bypass the memory check.

3. When the boot completes and you see a “Press Enter to return to 
prompt...” message, press Enter. 

Note: You may need to load the operating system from a CD if new 
software was shipped with the system. In this case, continue 
with Appendix C, ‘‘Loading the operating system on an MSS.’’
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4. At the localhost login prompt, log in to the MSS server as craft using the 
default password.

5. The Netscape license agreement screen appears the first time you log 
in. Click Accept to continue.

The server displays the Messaging Administration main menu. 

Setting up the monitor

If the display quality is poor, you have to perform additional steps to correct it before 
attempting to administer the system. 

� If the monitor displays system information well enough to do initial 
administration, continue with ‘‘Setting the time and date‘‘ on page 3-5.

� If the monitor does not display system information well enough to do 
initial administration, do the following procedure.

To adjust the monitor display:

1. Click Log Off. 

If the display is so poor that you cannot see the mouse pointer well 
enough to exit or log off, you can exit by simultaneously pressing 
CTRL+ALT+BACKSPACE. 

2. Log in at the console as monitor with the password of monitor. 

The server displays the Monitor setup screen.

3. Attempt to find the brand name of the monitor to be used. Use the down 
arrow or PageDown keys to scroll through the list of many available 
monitors, or try typing the first letter of the brand name. 

4. Highlight the name of the monitor that most closely matches the model 
you are using.

5. Tab to Set and press Enter. 

The monitor screen flashes during testing and adjusting, then the cursor 
returns to the localhost login prompt. 

6. Log in to the system as craft and see if the display has improved. 

7. If the display is still poor, relogin as monitor and select one of the 
Generic monitor settings. 
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8. If there is still no improvement, the customer must supply a different 
monitor.

Setting the time and date

The first time you log in to a new MSS, you need to set the time and date. 

� If you installed the operating system from a CD, you already set the time 
and date. Continue with ‘‘Setting up network addressing‘‘ on page 3-6.

� If you have not yet set the time and date, do the following procedure.

Set the time of day, date, and time zone as follows:

1. Starting from the Messaging Administration main menu, select:

Basic System Administration
Date and Time Administration

The server displays the Linux Date and Time screen.

2. In the Date field, select the month and day. Type the current year (such 
as 2002).

3. In the AM/PM field, select the type of time you are using (AM, PM, or 
24-hour clock), then select the hours and minutes in the Time field.

4. In the Time Zone field, select your current time zone.

5. When finished, click Save.

The new settings are saved, and you are prompted to log off. 

6. Click Log Off.

7. Log in as craft using the default password.

Note: If you did not make any changes to this screen (the time and 
date were already correct), you are not prompted to log off. 
Continue with ‘‘Setting up network addressing‘‘ on page 3-6.



585-310-326, Issue 2

Avaya™ S3400 Message Server Release 1 Installation

3–6 June 2003

Setting up network addressing

You need to set up the MSS to work correctly on the corporate local area network 
(LAN) and the private LAN to any MAS units. 

To set up the MSS to work correctly on the private and corporate LANs:

1. Starting from the Messaging Administration main menu, select:

Basic System Administration
TCP/IP Administration

Network Addressing

The server displays the Network Addressing screen. See Figure 3-1 for 
an example of a completed Network Addressing screen. 

CAUTION: Use the S3400 system planning form in Appendix A, 
‘‘System planning forms,’’ to enter the correct values.!

Figure 3-1. Network Addressing screen, sample Ethernet 0 interface
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Complete the Networking Addressing screen using the information from 
the S3400 system planning form on page A-6. Click the Help button or 
field name for additional information about each field.  

2. Enter the MSS Host Name, also known as the NetBIOS machine name 
(such as zigzag). This is item 1 on the S3400 system planning form on 
page A-6.  

3. For Default Gateway Address, enter the corporate default gateway IP 
address for the MSS. This is item 10 on your planning form. 

4. To administer the corporate LAN settings, select TCP/IP Interface eth0. 

� For Primary Name + Domain, enter the MSS corporate FQDN 
for Eth0 (such as zigzag.loc.avaya.com). This is item 7 on your 
planning form.

� For IP Address, enter the MSS corporate IP address for Eth0 
(see item 8 on your planning form).

� For Subnet Mask, enter the MSS corporate subnet mask for Eth0 
(such as 255.255.255.0). See item 9 on your planning form.

� For Network Media Type, select the correct type (usually Auto_
Detect).

The following fields must be filled in if a corporate DNS is used:

� Set Enable DNS to Yes if a corporate DNS is used (if this screen 
has a pushbutton, click the button so that it is dark).

� For Domain Name, enter the corporate domain name (see item 6 
on your planning form).

� For Name Server, add any IP addresses listed for MSS corporate 
DNS servers IP addresses (see item 11 on your planning form). 
Press Enter after each IP address.

Note: The format of the Network Addressing screen varies 
depending on how it is accessed. For example, at the console 
interface, the Enable DNS field shows a diamond instead of a 
radio button. To enable DNS, verify that the Yes diamond is 
pushed in (looks gray or shaded).

Note: The first letter may not appear when you type the new name. 
Complete this procedure, then verify the name in step 8.

CAUTION: Use the information from the S3400 system planning form on 
page A-6 for these fields. Do not use the examples shown.!
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� For Search Order, always enter the domain shown in the Domain 
Name field first. Press Enter. 

Add any other domain names listed for the MSS Search order of 
DNS domains, pressing Enter after each domain name (see item 
12 on your planning form).

5. Click Save.

6. You always see a message to logoff and restart the browser when you 
change the host name. Click OK. 

7. If you see a confirmation message, click Continue Submission to 
proceed.  

8. Click Logoff to log off now. 

If you wait, the server logs you off automatically. The system then 
displays the following prompt:

host name login:

9. Verify that host name in the login prompt is the same name you entered 
in step 2. If not, you have to re-enter it in step 12, and relogin again. 

10. Log back in to the MSS server as craft using the appropriate password.

The system displays the Messaging Administration main menu. 

11. Access the Network Addressing screen again. Click the links for:

Basic System Administration
TCP/IP Administration

Network Addressing

12. Verify the private LAN settings as follows. See Figure 3-2 on page 3-9 
for an example. 

� Select TCP/IP Interface eth1.

� For Primary Name + Domain, use the predefined MSS default 
private system name: mss1 (see item 13 on the S3400 system 
planning form on page A-6).

Note: You can deselect the “Show this alert next time” option in the 
message box (click the button so it is light in color) to prevent 
the confirmation message from appearing again. This message 
will not be noted again in these instructions.

Note: Follow the instructions on the Logoff screen. For example, you 
may be advised to wait 1 minute before logging back in.
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� For IP Address, use the MSS private IP address for Eth1 (should 
be 192.168.1.1, as shown in item 14 on your planning form). 

� For Subnet Mask, use the MSS private subnet mask for Eth1 
(should be 255.255.255.0, as shown in item 15 on the planning 
form). 

� For Network Media Type, verify that the correct type is selected 
(usually Auto_Detect).

13. If you made any adjustments, click Save.

14. Click Return to Main.

Figure 3-2. Network Addressing screen, sample Ethernet 1 interface
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Administering the message core

Use the tasks in this section to set up basic messaging functions on the MSS. Message 
core administration is done through a command prompt screen. The tasks in this 
section must be completed in the order presented. 

Accessing the messaging administration screens

To access the screens used to administer the message core:

1. Starting from the Messaging Administration main menu, select:

Global Administration
Messaging Administration

The system displays the administration command prompt screen and 
and the SSH dialog box, which provides protection for this screen. You 
are re-prompted to enter your password for security reasons.

2. Re-enter your login and password, then click Login. 

3. If you are prompted for a terminal type, use vt100.  

Note: The administration command prompt screen function keys do not 
always work from all terminal emulators. If the function keys are not 
working in your terminal emulator, try using the key sequences 
associated with each of the function keys as shown in Table 3-1. 

Table 3-1. Function key sequences

Function Key sequence Function key

Cancel  Ctrl+X F1

Refresh Ctrl+L F2

Enter Ctrl+E F3

Clear Field (ClrFld) Ctrl+K F4

Help Ctrl+W F5

Choices Ctrl+C F6

Next Page (NextPg) Ctrl+N F7

Previous Page (PrevPg) Ctrl+P F8 

Back space Ctrl+H —
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Setting up the MSS host machine profile

Set up a machine profile for the MSS. Use your S3400 system planning form on page 
A-6 and Required switch and messaging information on page A-12 to complete these 
fields. 

To set up a machine profile for this MSS:

1. At the administration command prompt, type change machine and 
press Enter.

The system displays the Machine Profile screen.

2. Update the fields in the Machine Profile screen as shown in Table 3-2. 

3. When finished, press F7 (Next Page).

Next Field Ctrl+M —

Break out of the webadmin interface 
and return to the Linux prompt

Ctrl+Alt+ 
Backspace

—

Table 3-1. Function key sequences

Function Key sequence Function key

Table 3-2. Machine Profile screen settings

Field Setting

Machine Name Change from “local” to the MSS host name (see item 1 on 
the S3400 system planning form on page A-6).

Machine Type tcpip

Location local [display-only field]

Voiced Name? n

Extension Length 3 through 10

Voice ID 0 [display-only field]

Default Community 1

Start Ext. Enter the appropriate starting extension number for this dial 
plan’s range. For example, for a five-digit dial plan, you might 
enter 00000 (see Required switch and messaging 
information on page A-12 for extension ranges).

End Ext. Enter the appropriate ending extension number for this dial 
plan’s range. For example, for a five-digit dial plan, you might 
enter 99999.
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The server displays the Machine Profile screen, page 2.

4. Type a password to be used for SMTP networking with other messaging 
machines. This password will be known to other machines to allow them 
to communicate. See Required switch and messaging information on 
page A-12.

� Do not change any other fields on this screen. Leave Updates In 
and Out set to n.

� When finished, press F3 (Enter).

Setting up the trusted servers

You must add a trusted server for every MAS unit and every MAS messaging service 
that will be in your domain. Use your S3400 system planning form on page A-6 and 
S3400 password table on page A-9 to provide the correct values for these fields. 

To set up the required trusted servers:

1. At the command prompt, type the following command in the exact format 
as shown:

add trusted-server MASHOSTNAME messaging-application-server 

For example, type add tru ZIPPY m and press Enter.

The system displays the Trusted Server Profile screen as shown in 
Table 3-3. The m suffix in the command prepopulates most of the fields. 

Note: The MAS NetBIOS or host name must be in all-capital letters.

Table 3-3. Trusted Server Profile screen host settings

Field Setting

Trusted-Server Name Shows the host name (NetBIOS name) for the MAS machine in 
all-capital letters (such as ZIPPY). See item 1 for this MAS on the 
S3400 system planning form on page A-6.

Password Type a password that will be known to all machines in this 
network. All trusted servers that have Service Name Messaging 
Application Server must use the same password (see items P1 
through P4 on the S3400 password table on page A-9).

IP Address Type the private IP address for this MAS machine (such as 
192.168.1.250 for the first MAS). See item 14 for this MAS on the 
S3400 system planning form on page A-6.

Service Name Messaging Application Server [This is a display-only field if you 
used the “m” suffix as shown; otherwise, type this in.]

Access to Cross Domain Delivery? n [display-only field]
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2. Update the password and IP address fields in the Trusted Server screen 
using your planning forms. 

3. When finished, press F3 (Enter).

The Trusted Server ID field is populated automatically.

4. If you are installing more than one MAS: Repeat steps 1 through 3 for 
every MAS unit you plan to install. Use the names, passwords, and IP 
addresses on your completed S3400 system planning form on page A-6.

5. Add a trusted server for the Message Waiting Indicator (MWI) server. At 
the command prompt, type add tru VVSTS and press Enter. 

The system displays the Trusted Server Profile screen.

6. Update the fields in the Trusted Server screen as shown in Table 3-4. 

7. When finished, press F3 (Enter).

The Trusted Server ID field is populated automatically.

Default Community Number 1 [display-only field]

 Trusted Server ID Field will be filled in automatically. 

Minutes of Inactivity Before Alarm 10

Table 3-3. Trusted Server Profile screen host settings

Field Setting

Table 3-4. Trusted Server Profile screen service settings

Field Setting

Trusted-Server Name Shows VVSTS

Password Type a password that will be known to all machines in this 
network. See item P5 on the S3400 password table on 
page A-9. 

IP Address Type the private IP address for the MAS machine that will 
have the MWI server installed. Check your MAS features 
list on page A-11 to verify which MAS this is.

Service Name  Type MWI Server (enter this name exactly as shown).

Access to Cross Domain Delivery? n

Default Community Number 1

 Trusted Server ID Field will be filled in automatically.

Minutes of Inactivity Before Alarm 0
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8. Finally, you must modify the first IMAP trusted server to match the new 
settings.

At the administration command prompt, enter change trusted-server 
Imap4TS1 and press Enter. Type the trusted server name exactly as 
shown in upper and lower case. 

The system displays the Trusted Server Profile screen for this service.

9. Type the IMAP4 password (see item P6 on the S3400 password table on 
page A-9). 

10. Press F3 (Enter).

Check the status line to verify that the trusted server information was 
successfully updated.

11. At the command prompt, type exit and press Enter.

12. Scroll down and click Return to Main.

Rebooting the MSS

To make sure that the MSS is working correctly, reboot it now as follows: 

1. Starting from the Messaging Administration main menu, select:

Utilities
Reboot System

The server displays the Reboot System screen. 

2. Click Reboot.

3. At the reboot warning message, click OK to proceed.

Status messages display as the server shuts down the messaging 
software. This may take several minutes. Proceed with the installation.
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4
Administering the MAS

This chapter describes how to perform basic administration on the Messaging 
Application Server (MAS).   

Note: Before you can successfully complete the tasks in this section, you 
must have successfully completed the initial MSS administration 
tasks in Chapter 3, ‘‘Powering up the system and performing initial 
MSS administration.’’ 
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Changing the administrator account name and password 4-5

Changing the machine name 4-6

Assigning IP addresses for this MAS 4-7
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Adding an MAS to the Windows domain 4-18

Setting up remote access 4-20

Updating the Modular Messaging account settings 4-25

Synchronizing the time and date with the MSS 4-26

Configuring and testing the port boards 4-27

Setting up the MAS messaging services 4-37
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Introduction

You need to set up the MAS to work correctly on the corporate local area network 
(LAN) and the private LAN (the required MSS and any other MAS units). You also need 
to configure the port boards and install any required MAS services. 

To successfully install an MAS, you need:

� A completed copy of all the forms in Appendix A, ‘‘System planning 
forms.’’ These include the S3400 system planning form, the S3400 
password table, the S3400 logon accounts form, the MAS features list, 
and the Required switch and messaging information form.

� The software and documentation listed in "Required software and 
documentation" on page 2-5. 

� All required hardware, including the MAS voice port boards, installed as 
described in Chapter 2, ‘‘Installing the system hardware.’’

� Initial MSS administration completed as described in Chapter 3, 
‘‘Powering up the system and performing initial MSS administration.’’

Because an S3400 system installation requires many steps, use your copy of the 
checklist in Appendix B, ‘‘Installation checklist.’’ Check off items as you complete them 
to track your progress.

CAUTION: Use your completed planning forms from Appendix A, 
‘‘System planning forms,’’ to enter the correct values. You 
cannot use these examples or guess at the values. If you try, 
the current operation of the customer LAN may be damaged.

!
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Setting up the MAS machine

Do this task on every MAS machine.

Switching the monitor to show the correct server

The KVM switch is normally connected to the required MAS through the second 
computer port (VGA 02). Subsequent MASs (if present) are connected to computer 
ports VGA03, VGA 04, and so on. 

To switch the monitor to show the server that you need to administer:

1. For a Belkin OmniView Pro2 KVM: Press slowly in sequence Scroll 
Lock, then Scroll Lock, then the up (or down) arrow key to change to the 
server connected to a higher or lower port number. 

You can alternatively type the port number instead of pressing the up or 
down arrow key (such as 02 for port 2). See your KVM switch 
documentation for complete user instructions.

2. If you cannot access the correct server, see "Connecting the KVM 
cables" on page 2-26 and verify the cable connections. To correct 
cabling problems, power down the system correct the cabling, then 
power up the system again.

Logging in for the first time

You must log in as the known administrator to begin administration of an MAS unit. 

The machine begins to boot after power up. To log in to a newly installed MAS:

1. Optional: When the system begins to boot, you can:

� Press Esc when the splash screen appears.

� Press the space bar to skip the memory check. 

Note: If new MAS software is provided, it must be copied to the hard 
disk on each new MAS server before administration can begin. 
To reload the operating system, continue with Appendix D, 
‘‘Loading the operating system on an MAS.’’

Note: If you are installing more than one MAS, you see an error 
message about an IP address conflict with another system on 
the network. Press OK to ignore the message. This error 
persists until a unique IP address is assigned to each MAS.
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2. When the boot completes, press Ctrl+Alt+Del to log on as follows:

a. On the Log On to Windows screen, verify that the logon name is 
VSSystemAdmin.

b. Enter this password exactly as shown: 3825_STul 

c. Press Enter or click OK. 

Setting up regional settings, date, and time

Set up this MAS for its region and time zone. 

1. Set up regional settings as follows:

a. Click the Start button, then select Settings, then select Control Panel. 

b. In the Control Panel window, double-click Regional Options.

c. On the Regional Options window, on the General tab:

(1) Select your locale from the drop-down list.

(2) Update your language settings if needed.

d. Click the other tabs in order, and verify that your Numbers, Currency, 
Time, and Date settings are correct for this system. The defaults should be 
adjusted to reflect the locale you selected.

e. Click the Input Locales tab. Verify your locale and keyboard settings.

f. When finished, click OK to close the Regional Options window.

g. If you removed the default locale, you are prompted that it will be removed 
the next time you reboot the system. Click OK. 

2. Set the time and date as follows:

a. In the Control Panel window, double-click Date/Time. 

b. On the Date/Time Properties window, click the Time Zone tab.

c. Set the time zone and daylight savings values as needed.

d. Click Apply. 

Note: Submenu choices are indicated with a right angle sign (>) in 
the rest of this document. For example, the procedure above 
would appear as Start > Settings > Control Panel.

Note: Set and apply the time zone first. If you enter the time first, it 
may become incorrect when you set the time zone.
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e. Click the Date & Time tab.

f. Set the date, year, and time. 

g. Verify your settings, then click OK. 

h. Close the Date/Time Properties window.

i. Close the Control Panel window.

Changing the administrator account name and 
password

Do this task on every MAS machine. 

You need to change the default administrator account name and password on every 
MAS for security reasons.  

To rename the default administrator account:

1. Right-click My Computer and select Manage.

2. On the Computer Management window, under System Tools, click Local 
Users and Groups, then click Users. 

The VSSystemAdmin account is listed in the Users container.

3. Right-click the account name and select Rename. 

a. Rename the account as appropriate for this MAS (case is not important). 
See items A1 to A4 on the S3400 logon accounts form on page A-10. 

b. Type the new name and press Enter.

4. Right-click the new administrator account name and select Set 
Password. 

Note: This account on MAS#1 will become the domain administrator 
account. It is important to set it up correctly now, as it will be very 
difficult to change later. See the S3400 logon accounts form on 
page A-10 for the account names and passwords to use at this site.

Note: In this document, the example dom-admin is used for the first 
MAS, which is the domain administrator. Each subsequent 
MAS will have a unique, local administrator account name (for 
example, mas2-admin). Do not leave the account name set to 
VSSystemAdmin for security reasons.
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a. Enter and confirm the new password (case is important). See items A1 to 
A4 on the S3400 logon accounts form on page A-10.

b. Click OK. 

c. Click OK again if prompted to continue.

5. Close the Computer Management window.

Changing the machine name

Do this task on every MAS machine. 

You need to change the machine name from GENERIC-VS as follows:

1. Right-click My Computer and select Properties.

2. On the System Properties window, click the Network Identification tab.

3. Click the Properties button. The Identification Changes window 
appears.

a. Change the Computer name to the required host name (NetBIOS name) 
for this MAS (such as zippy). See item 1 on your S3400 system planning 
form on page A-6.

b. Make sure the Member of Workgroup radio button is selected. Click OK.

c. Click OK when prompted to reboot the computer.

d. Click OK to close the System Properties window. 

4. Do not restart the machine when prompted (click No).

You will restart the machine after you assign the IP addresses. 

Note: The default is to reboot the system. If you just press enter, the 
system will reboot. 

If you are installing more than one MAS, you again see an error 
message about an IP address conflict with another system on 
the network. Press OK to ignore the message. This error 
persists until a unique IP address is assigned to each MAS.
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Assigning IP addresses for this MAS

Do this task on every MAS machine. 

You need to assign IP addresses and other TCP/IP properties for the corporate and 
private LANs that this MAS will use. Use your completed S3400 system planning form 
on page A-6 to enter the correct values.

Setting up the corporate LAN interface

To assign corporate IP addresses to this MAS: 

1. Click Start > Settings > Network and Dial-up Connections.

The Network and Dial-up Connections window appears.

2. Rename the two Local Area Connection items as follows:

a. Right-click Local Area Connection and click Rename.

b. Change the name to Private LAN.

c. Right-click Local Area Connection 2 and click Rename.

d. Change the name to Corporate LAN.

3. Right-click Corporate LAN and select Properties.

The Corporate LAN Properties window appears. 

4. On the General tab, select Internet Protocol (TCP/IP) and click 
Properties.

The Internet Protocol (TCP/IP) Properties window appears. See Figure 
4-1 on page 4-8 for an example. 
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5. On the Internet Protocol (TCP/IP) Properties window:

a. Click the “Use the following IP address” radio button.

b. Change the IP address, Subnet mask, and Default gateway to the 
corporate LAN values for this MAS listed in the S3400 system planning 
form on page A-6 (items 8, 9, and 10). 

c. Click “Use the following DNS server addresses.” Specify the corporate 
DNS IP addresses as follows:

(1) For the Preferred DNS server, enter the first Corporate DNS 
server IP address from your planning form (item 11, if any). 

(2) For the Alternate DNS server, enter the next Corporate DNS 
server IP address from your planning form (item 11, if any).

(3) Click the Advanced button.

The Advanced TCP/IP Settings window appears. 

Figure 4-1. Sample corporate LAN TCP/IP properties 
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(4) Click the DNS tab. See Figure 4-2 for an example. 

(5) On the Advanced TCP/IP Settings DNS tab, enter the following: 

� If you need to add IP addresses for any additional corporate DNS 
servers, click Add (see item 11 on the S3400 system planning 
form on page A-6). Click OK to approve each entry. 

� Select the radio button for “Append these DNS suffixes (in order)”. 
Click Add.

� On the TCP/IP Domain Suffix window, in the Domain suffix field, 
enter any corporate domain suffixes listed for Search order of DNS 
domains using item 12 on the system planning form (for example, 
loc.avaya.com and avaya.com). After each entry, click Add. 
Repeat as needed to add all required suffixes.

� In the “DNS suffix for this connection” text box, enter the suffix for 
the fully qualified corporate LAN domain name (do not include the 

Figure 4-2. Sample advanced TCP/IP settings for the corporate LAN
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machine name). For example, loc.avaya.com (see item 6 on the 
S3400 system planning form on page A-6).

(6) Click OK to return to the Internet Protocol (TCP/IP) Properties 
window.

6. Click OK to close the Internet Protocol (TCP/IP) Properties window.

7. Click OK to close the Corporate LAN Properties window.

Setting up the private LAN interface

To assign private IP addresses to this MAS: 

1. On the Network and Dial-up Connections window, right-click Private 
LAN and select Properties.

The properties window for the private LAN connection appears. 

2. In the scroll box, select Internet Protocol (TCP/IP) and click 
Properties.

The Internet Protocol (TCP/IP) Properties window appears. See Figure 
4-3 for an example.
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3. On the Internet Protocol (TCP/IP) Properties window:

a. Click the Use the following IP address radio button.

(1) Verify or update the IP address for this particular MAS as follows:

� For the first MAS, you should be able to use the default IP settings 
as shown (such as 192.168.1.250).

� For an additional MAS, you need to change the default settings as 
listed in item 14 on your S3400 system planning form on page 
A-6. For example, the second MAS should be 192.168.1.249. 

(2) Use the default subnet mask (255.255.255.0).

(3) Leave Default gateway blank.

(4) Leave the Preferred DNS server as shown (blank is okay).

(5) Leave the Alternate DNS server blank.

Figure 4-3. Sample private LAN TCP/IP properties 
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b. Click OK to close the Internet Protocol (TCP/IP) Properties window.

c. If you see an error message that the DNS server list is empty, click OK. 

4. Click OK to close the Private LAN Properties window.

5. Restart the system now:

a. Click Start > Shut Down. 

b. On the Shut Down Windows screen, select Restart, then click OK.

Testing IP addresses on the private network

To test if the IP addresses are correct and working on the private Ethernet interface: 

1. When the reboot completes, press Ctrl+Alt+Del and log in as follows:

a. On the Log On to Windows screen, change the user name to your new 
administrator account name (such as dom-admin). See items A1 to A4 on 
the S3400 logon accounts form on page A-10.

b. Enter the password for this account (see the logon accounts form).

c. Press Enter or click OK. 

2. Click Start > Run to open a Command prompt window. In the Run box, 
type cmd in the Open field and press Enter.

3. Test ping over the private Ethernet interface.

a. At the command prompt, ping all IP addresses administered on the private 
network. For example, ping 192.168.1.1 and verify success. See item 14 
on your S3400 system planning form on page A-6. 

b. If the ping test fails, verify that your network connections between the MAS 
and MSS are good. If so, check your administration.

Note: If you skipped a Found New Hardware wizard by pressing Esc, 
the wizard runs now. Complete the wizard to continue. See 
Appendix D, ‘‘Loading the operating system on an MAS,’’ for 
details if needed.
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See Figure 4-4 for an example of a successful ping by IP address.  

c. Optional: If you are using a corporate DNS, you may also want to test ping 
over the corporate Ethernet interface to make sure it is set up correctly. For 
example, you could ping any corporate IP addresses on your system (such 
as items 8 through 11 on your S3400 system planning form on page A-6). 

You could also ping the MSS machine the corporate FQDN (such as 
ping zigzag.loc.avaya.com). Any name tests should show the 
corporate IP address for the entity you ping. 

4. When finished, close all open windows.

Continue with administration depending on your MAS

Continue with MAS administration as follows:

� If you are setting up the first MAS in the system, continue with "Setting 
up the first MAS as the domain controller" on page 4-14.

� If you are adding an MAS to a multiple MAS setup, continue with 
"Adding an MAS to the Windows domain" on page 4-18.

Figure 4-4. Example of successful ping by IP address

Note: In order for a name test to succeed, the MSS names must be 
administered on the corporate DNS. If a corporate DNS is not 
used, ping will not be able to resolve the corporate name.
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Setting up the first MAS as the domain controller 

One MAS in every system must be set up as the domain controller. This setup provides 
an easily administrable, scalable, and secure solution for the S3400 system. 
 

Temporarily enabling DNS service on the first MAS 

To enable the pre-installed DNS service on the first MAS:

1. Double-click the Monitor icon on the desktop. 

The Services (Local) item in the left-hand pane should be selected. If it 
isn’t, click it now.

2. Double-click DNS Server in the right-hand pane of the Monitor window. 

3. On the DNS Server Properties window, on the General tab, set the 
“Startup type” to Manual, and click Apply.

4. Click Start.

5. Wait for services to start, then click OK to close the Properties window.

6. Close the Monitor window.

Promote the first MAS to a domain controller using DCPromo 

You need to run the DCPromo program to make the first MAS a domain controller. You 
must have a working private LAN connection for DCPromo to install successfully. 

A script file named answer.txt has been supplied on the C:\ drive. To update this file:

1. Open the answer.txt file for editing:

a. Click Start > Run.

b. In the Run box Open field, type notepad C:\answer.txt and press Enter.

CAUTION: Do this task on the first MAS only. !

Note: This icon has a .msc extension and is labeled Monitor.msc.

Note: To show entries in the right-hand pane alphabetically, click the 
Name column header.
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2. Customize the answer.txt file for this installation as follows:

� NewDomainDNSName=AVMM.com (Replace AVMM.com with 
the MAS#1 private FQDN item 2 on the S3400 system planning 
form on page A-6, such as zodiac.com)

� DomainNetbiosName=AVMM (Replace AVMM with the Windows 
NetBIOS domain name item 3 on the S3400 planning form, such 
as zodiac)

� SafeModeAdminPassword=AVMM (Replace AVMM with the safe 
mode administrator account password, item A8 on the S3400 
logon accounts form on page A-10) 

3. When finished, click File > Save, then close the editor.

4. Run DCPromo using the answer.txt file as follows:

a. Click Start > Run.

b. In the Run box, in the Open field, type the following and press Enter:

dcpromo /answer:c:\answer.txt 

This step takes about 10 minutes, then the machine reboots. Windows 
start up will be slow as it does its configuration in the background.

Disabling DNS service on the first MAS 

Disable DNS service on the first MAS as follows: 

1. When the reboot completes, press Ctrl+Alt+Del to log back in using the 
domain administrator account name (such as dom-admin) and 
password. Press Enter or click OK.

2. Double-click the Monitor icon on the desktop.

The Services (Local) item in the left-hand pane should be selected.

3. Double-click DNS Server in the right-hand pane.

4. On the DNS Server Properties window, on the General tab, set the 
“Startup type” to Disabled, and click Apply.

5. Verify that “Service status” is stopped. If needed, click Stop to stop 
service.

6. Click OK to close the DNS Server Properties window.

7. Close the Monitor window.
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Creating user accounts and adding them to groups

 

You need to create three new user accounts on the first MAS that will be used by all 
MAS units in the system. The new accounts are automatically added to the Domain 
Admins group so that they can log on to and install software on the MAS. 

To create the user accounts and add them to the appropriate groups:

1. Click Start > Run.

2. In the Run box, type the following in the Open field and press Enter:

cscript c:\avaya_support\scripts\createmmaccount.vbs <mmlogon> 
<password>

where <mmlogon> and <password> are the customer-provided Modular 
Messaging account logon name (such as mmacct) and its password. 
See item A5 on the S3400 logon accounts form on page A-10.

Wait up to 1 minute for this command to set up the account.

3. Click Start > Run again.

4. In the Run box, type the following in the Open field and press Enter:

cscript c:\avaya_support\scripts\createsvcaccount.vbs <svclogon> 
<password>

where <svclogon> and <password> are the customer-provided Services 
account logon name (such as craft) and its password. See item A6 on 
the S3400 logon accounts form on page A-10.

5. Click Start > Run again.

6. In the Run box, type the following in the Open field and press Enter:

cscript c:\avaya_support\scripts\createcustomeraccount.vbs 
<customerlogon> <password>

where <customerlogon> and <password> are the customer-provided 
Customer account logon name (such as custacct) and its password. See 
item A7 on the S3400 logon accounts form on page A-10.

CAUTION: Do this task on the first MAS only. !
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7. Optional. To verify that the accounts were created correctly: 

a. Double-click the Configure icon on the desktop. 

b. In the left-hand pane of the Configure window:

(1) Expand the Active Directory Users and Computers directory.

(2) Expand the directory for the domain name (for example, 
zodiac.com).

(3) Click Users.

c. In the right-hand pane on the Configure window, verify that the three 
following accounts have been created:

� Customer Account

� MM Account

� Services Account

d. If any of the accounts are missing, rerun the appropriate script to create 
that account (see steps 1 through 6). 

When all three accounts are present, continue.

8. Log in to the newly created Modular Messaging account:

a. Click Start > Log off admin-account.

b. On the Log Off Windows screen, click Yes.

c. Press Ctrl+Alt+Del to log on.

d. On the Log On to Windows screen, change the User name to the Modular 
Messaging account name (such as mmacct).

e. Enter the password for this account. See item A5 on the S3400 logon 
accounts form on page A-10.

f. Press Enter or click OK.

9. Continue with "Setting up remote access" on page 4-20.

Note: This icon has a .msc extension and is labeled Configure.msc.
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Adding an MAS to the Windows domain

 

If you are adding an additional MAS to the system, it must join the Windows domain 
that you already created for the first MAS so that it can be administered. 

To add an MAS to the existing Windows domain:

1. Right-click My Computer and select Properties.

2. On the System Properties window, click the Network Identification tab. 

3. Click the Properties button. The Identification Changes window 
appears.

a. Click the Member of Domain radio button. 

b. Enter the name of the Windows domain that you already created (such as 
zodiac). See item 3 on the S3400 system planning form on page A-6).

c. Click OK.

d. On the Domain Username And Password window:

(1) Enter the Modular Messaging account name (such as mmacct) in 
the format domain\account name (such as zodiac\mmacct). See 
item A5 on the S3400 logon accounts form on page A-10.

(2) Enter the Modular Messaging account password.

(3) Click OK.

It may take several minutes to join the domain.

e. A Network Identification box welcomes you to the domain. Click OK to 
close this box.

f. When prompted to reboot, click OK. 

g. Click OK to close the System Properties window. 

4. Restart the machine when prompted (click Yes).

CAUTION: Do this task only on an additional (second, third, or fourth) 
MAS unit. !

CAUTION: If you are restoring an additional MAS to service after a 
catastrophic disk failure, you need to first create a workgroup 
entry before you can join the domain. See Recovering from a 
catastrophic disk failure on page F-1 for details. 

!
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5. When the reboot completes, press Ctrl+Alt+Del to log back in using the 
Modular Messaging account name for this system.

a. On the Log On to Windows screen, click Options.

b. Expand the “Log on to” drop-down list and select the Windows domain 
(such as zodiac). 

c. Change the user name to the Modular Messaging account name (such as 
mmacct).

d. Enter the password for this account. See item A5 on the S3400 logon 
accounts form on page A-10.

e. Click OK.

Note: It may take a few minutes for the personal settings to load.
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Setting up remote access

Do this task on every MAS. 

You should now be logged on to the server using the MAS Modular Messaging logon 
(such as mmacct) and its password. See item A5 on the S3400 logon accounts form on 
page A-10.

To set up this MAS for remote access:

1. Disable digital signature checking as follows:

a. Right-click My Computer and select Properties.

b. On the System Properties screen, click the Hardware tab.

c. Under Device Manager, click Driver Signing.

d. On the Driver Signing Options screen, click the Ignore radio button. 

e. Click OK. 

f. Click OK to close the System Properties screen.

2. Connect the USB cable for each MAS’s external modem to the 
recommended USB port A on the back of the MAS. See "Connecting the 
USB modem on the MAS" on page 2-32 for complete steps. 

A Found New Hardware message appears when the system locates the 
modem.

3. Double-click the Monitor icon on the desktop.

The Services (Local) item in the left-hand pane should be selected. If it 
isn’t, select it now.

4. In the Monitor window, scroll down to Routing and Remote Access in 
the right-hand pane. Double-click it to bring up the Properties window.

5. On the Routing and Remote Access Properties window:

a. On the General tab, set the “Startup type” to Automatic.

b. Click Apply. 

c. Under Service Status, click Start. 

d. Wait for service to start, then click OK to close this window.

6. Close the Monitor window.
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7. Double-click the Configure icon on the desktop. 

8. Expand Routing and Remote Access.

a. Expand the server name (such as ZIPPY).

Note the green upward-pointing arrow on the server’s icon that 
indicates that remote access service (RAS) is running.

b. Right-click Ports and select Properties.

c. On the Ports Properties window, make sure the modem is highlighted, then 
click Configure.

d. On the Configure Device - <model> Modem window, verify that the box to 
activate Remote access connection (inbound only) is checked.

e. Click OK.

f. Click OK to close the Ports Properties window.

g. Click Ports in the left-hand pane.

h. In the right-hand pane, verify that there is an entry for the modem attached 
to this MAS, such as MultiTech ZBA-USB-V92. 

� If the modem entry is present, go to step 9.

� If the modem entry is missing: 

(1) Verify that the modem is plugged into the recommended USB port 
on the MAS (see "Connecting the USB modem on the MAS" on 
page 2-32).

(2) Click Start > Settings > Control Panel.

(3) Double-click Phone And Modem Options.

(4) The first time you select Phone and Modem Options, a wizard 
runs. Complete the wizard following the steps on each screen to 
configure your locale settings. When finished, your new entry 
appears in the Locations box on the Dialing Rules tab.

(5) On the Phone And Modem Options window, click the Modems 
tab.

(6) Verify that the modem is present and attached to a port (typically 
COM3 if you used the recommended USB port).

(7) If the modem is not present or attached to a port, you may need to 
remove the modem entry, then reinstall the modem.

Note: This icon has a .msc extension and is labeled Configure.msc.
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(8) When finished, click OK to close the Phone And Modem Options 
window.

(9) Close the Control Panel.

(10) Return to step 8-g and verify that the modem is now present.

9. Set up a static IP address pool as follows:

a. In the left-hand pane, right-click the server name (such as ZIPPY) and 
select Properties.

b. Click the IP tab.

c. Under “IP address assignment,” select “Static address pool”. 

d. If an IP address range of 0000 to 0000 appears, select it and click Edit. (If 
no address appears, click Add.)

e. In the New Address Range properties box, enter the start and end IP 
addresses depending on the MAS you are installing as follows: 

� MAS#1: 192.168.2.200 to 192.168.2.201

� MAS#2: 192.168.2.202 to 192.168.2.203

� MAS#3: 192.168.2.204 to 192.168.2.205

� MAS#4: 192.168.2.206 to 192.168.2.207 

f. Number of addresses is automatically assigned 2.

g. Click OK.

h. For the Adapter field, select “Allow RAS to select adapter.”

i. Click OK to close the Properties window.

10. Proceed with remote access administration as follows:

� If you are administering the first MAS, continue with "Administering 
the first MAS for remote access" on page 4-23.

� If you are administering a subsequent MAS, continue with "Adding a 
subsequent MAS to the remote access group" on page 4-24.

Note: These IP addresses use a 2 (not a 1) in the third number place.



June 2003

Administering the MAS

4–23585-310-326, Issue 2

Administering the first MAS for remote access

Continue the previous procedure on the first MAS as follows: 

1. In the left-hand pane of the Configure window:

a. Expand the Active Directory Users and Computers directory.

b. Expand the directory for the domain name (for example, zodiac.com).

c. Click Users.

2. In the right-hand pane on the Configure window, double-click RAS and 
IAS Servers to bring up the Properties window.

3. On the RAS and IAS Servers Properties window:

a. Click the Members tab.

b. Click Add.

c. In the Select Users, Contacts, Computers or Groups window, locate this 
MAS (such as ZIPPY); it will have a blue terminal icon beside it. 
Double-click it.

d. Verify that the correct computer name appears underlined in the list box.

e. Click OK to close this window.

f. Click OK again to close the RAS and IAS Servers Properties window.

4. In the right-hand pane, double-click Services Account to bring up the 
Properties window.

5. On the Services Account Properties window:

a. Click the Dial-in tab.

b. Under Remote Access Permission (Dial-in or VPN), click the radio button 
to select Allow access.

c. CallBack Options should be left at No Callback.

d. Click OK. 

6. Close the Configure window.

7. Continue with "Updating the Modular Messaging account settings" on 
page 4-25.
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Adding a subsequent MAS to the remote access group

Add subsequent MAS units to the existing remote access group as follows: 

1. Close the Configure window on the MAS that you are administering now. 

2. Switch the monitor to show the first MAS. See "Switching the monitor to 
show the correct server" on page 4-3 for this procedure if needed. 

3. On the first MAS: Double-click the Configure icon on the desktop.

4. In the left-hand pane of the Configure window:

a. Expand the Active Directory Users and Computers directory.

b. Expand the directory for the domain name (for example, zodiac.com).

c. Click Users.

5. In the right-hand pane on the Configure window, double-click RAS and 
IAS Servers to bring up the Properties window.

6. On the RAS and IAS Servers Properties window:

a. Click the Members tab.

b. Click Add.

c. In the Select Users, Contacts, Computers or Groups window, locate this 
MAS (such as ZORRO); it will have a blue terminal icon beside it. 
Double-click it.

d. Verify that the correct computer name appears underlined in the list box.

e. Repeat steps c and d to add all MAS units to this list. See the S3400 
system planning form on page A-6. 

f. Click OK to close this window.

g. Click OK again to close the RAS and IAS Servers Properties window.

7. Close the Configure window.

8. Switch the monitor back to show the MAS that you are currently 
installing. Continue with the installation.

Note: If you are installing three or four MAS units, you may want to do 
this procedure on the final MAS you are installing. That way 
you only have to do this procedure once.

Note: Do this procedure on the first MAS only.
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Updating the Modular Messaging account settings

Do this task on every MAS machine.

To update settings for the Modular Messaging account: 

1. Double-click the Monitor icon on the desktop.

The Services (Local) item in the left-hand pane should be selected.

2. On the Monitor window for local services, make sure that the MAS 
messaging service is stopped as follows:

a. Scroll down to MM Messaging Application Server in the right-hand pane 
and check the status.

� If the Status column shows nothing, the service is already 
stopped.

� If needed, right-click MM Messaging Application Server and 
select Stop.

b. Next, double-click MM Messaging Application Server to open the 
Properties window. 

c. On the MM Messaging Application Server Properties (Local Computer) 
window, click the Log On tab.

(1) For the first MAS only: Click the Browse button. Locate the new 
Modular Messaging account (such as mmacct), then double-click 
it. See item A5 on the S3400 logon accounts form on page A-10.

(2) For a subsequent MAS: Clear the “This account” data-entry field. 
Type the Windows domain\MM account name in the exact format 
shown (such as zodiac\mmacct). See item 3 on the S3400 system 
planning form on page A-6 for the domain name. 

(3) Enter and confirm the account password.

(4) Click OK to close the Properties window.

d. When the “Granted Log On As A Service right” console message appears, 
click OK.

e. Close the Monitor - Services (Local) window.

3. Update the following settings:

a. Click Start > Run.

b. In the Run box, type dcomcnfg in the Open field and press Enter.

The Distributed COM Configuration Properties window appears.
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c. In the Applications box, double-click Modular Messaging Messaging 
Application Server. 

d. On the Properties window, click the Identity tab. 

e. Make sure This user is selected, then click Browse. 

f. On the Browse for Users window, locate the Modular Messaging account 
(such as mmacct), then double-click it. It appears as Windows 
domain\account name (such as ZIPPY\mmacct).

g. Click OK to close this window.

h. On the Properties window, enter and confirm the password.

i. Click OK to close the Properties window.

j. Click OK to close the Distributed COM Configuration Properties window.

Synchronizing the time and date with the MSS

Do this task on every MAS machine. 

You must synchronize the time on the MSS and MAS servers as follows:

1. Click Start > Run to open a Command prompt window.

2. In the Run box, type the following in the Open field and press Enter:

c:\avaya_support\cmd\time.bat

The clocks on the MSS and MAS servers will soon show the same time.



June 2003

Administering the MAS

4–27585-310-326, Issue 2

Configuring and testing the port boards

Do this task on every MAS that contains port boards. 

Drivers for all supported port boards are already installed. However, the port boards on 
the MAS units must be configured and tested as described in this section. 

� Use the configuration notes to administer the port boards for your 
particular PBX or switch integration. See "Required software and 
documentation" on page 2-5 for instructions on obtaining the 
configuration notes. 

� See Table 4-5 lists supported Dialogic port boards and their associated 
documents (copies are on the documentation CD). The type of port 
boards installed may vary on different MAS units. 

Continue with the appropriate section for the type of port boards installed on your MAS:

� "Configuring analog port boards" on page 4-28

� "Configuring set emulation boards" on page 4-30

� "Configuring T1- or E1-QSIG boards" on page 4-32

CAUTION: You can only install this system by using the required 
configuration notes for your switch or PBX. The port boards 
must be administered on the switch before you can proceed.

!

Table 4-5. Supported MAS port boards 

Protocol Ports Port boards Max # Dialogic documents on CD

Analog 4 - 8
12 - 48

Dialogic 4-port T/R board
Dialogic 12-port T/R board

2
4

D/41JCT-LS (PDF 133K)
D/120JCT-LS (PDF 131K)

Digital Set 
Emulation

8 - 40 Dialogic D/82JCT-U 5 D/82JCT-U (PDF 240K)

T1-QSIG 23 - 69 Dialogic D/480JCT-T1 (dual) 3 Span JCT boards (PDF 99K)

E1-QSIG 30 - 60 Dialogic D/600JCT-E1 2 Span JCT boards (PDF 99K)
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Configuring analog port boards 

You may have up to four analog port boards installed in your MAS: 

� Dialogic 4-port Tip/Ring board (up to 2; see D/41JCT-LS for details)

� Dialogic 12-port Tip/Ring board (up to 4; see D/120JCT-LS for details)

To configure either of these analog cards:

1. If D/41JCT-LS boards are installed, do the following to add the correct 
settings to the system:

a. Click Start > Run.

b. In the Run box Open field, type the following and press Enter:
c:\Avaya_Support\Registry_Keys\tsffilename.reg 

2. Click Start > Programs > Dialogic System Software > Dialogic 
Configuration Manager - DCM.

The Dialogic Configuration Manager window appears.

3. In the Computer Name popup window, make sure that the radio button 
for Local is selected (verify the MAS name, such as ZIPPY).

4. Click Connect.

The Dialogic Configuration Manager locates any installed port boards.

5. Under Configured Devices, double-click the name of the first Dialogic 
board shown (such as #0). 

6. On the Dialogic Configuration Manager Properties window:

a. Click the Files tab.

The TSFFileName parameter should be selected.  

b. Locate the prerecorded TSF file for your PBX or switch:

Note: If you are using a D/41JCT-LS card, you must highlight the 
“Configured Devices” parameter on the DCM display when 
selecting Configure Device. This is necessary to be able to 
view the TSFFilename parameter.

CAUTION: If you can’t find a suitable TSF file for your PBX, you need to 
build an appropriate tone file now or the integration will not 
work. Cancel out of this screen, then see Appendix E, 
‘‘Creating a new tone file.’’

!



June 2003

Administering the MAS

4–29585-310-326, Issue 2

(1) Click the ... button to browse, then navigate to the C:\Avaya 
Support\Tone_Files directory. 

(2) On the Search File window, select a TSF file that is appropriate for 
the PBX to which you are connecting (for example, 
Avaya-G3-US.tsf). Double-click the file name. 

The appropriate TSF file is inserted in the Value field.

7. After an appropriate TSF file is selected, click the Misc tab.

a. For a D/120JCT-LS board: Click the FirmwareFile parameter, then type 
spfax.fwl in the Value field.

b. Click the TSFFileSupport parameter.

c. Select Yes from the Value drop-down list. 

d. Click the DisconnectTone parameter.

e. Select Yes from the Value drop-down list.

f. Click OK to close the Properties window.

8. Repeat steps 5 through 7 for any other installed Dialogic boards (such 
as #1). Most of the first board’s settings will persist between boards, 
except for the FirmwareFile parameter.

9. When all boards are configured, click the green Start Service button on 
the button bar.

Wait for service to start. The installed boards show a green light when 
service is started, and the Stop Service button becomes active. See 
Figure 4-5 on page 4-30 for an example. 

10. Close the Dialogic Configuration Manager.

11. Continue with "Testing the port boards" on page 4-35.

Note: You must have selected an appropriate TSF file for your PBX 
or switch before setting the TSFFileSupport parameter to Yes, 
or errors may occur.
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Configuring set emulation boards 

You may have up to five 8-port Dialogic Digital Set Emulation boards installed in your 
MAS. See D/82JCT-U for more information on this type of board. 

To configure your digital set emulation boards:

1. Click Start > Programs > Dialogic System Software > Dialogic 
Configuration Manager - DCM.

The Dialogic Configuration Manager window appears. 

2. In the Computer Name popup window, make sure that the radio button 
for Local is selected (verify the MAS name, such as ZIPPY).

3. Click Connect.

The Dialogic Configuration Manager locates any installed port boards. 
See Figure 4-6 for an example.

Figure 4-5. Sample Dialogic Configuration Manager analog window - service started
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4. Under Configured Devices, double-click the name of the first Dialogic 
board shown (such as #0). 

5. On the Dialogic Configuration Manager Properties window:

a. Click the Telephony Bus tab and select the PCMEncoding parameter.

b. On the pull-down list of values, select either A-Law or µ-Law depending 
on your location. Typically, A-Law is Europe and µ-Law is United States.

c. Click the Misc tab and select the PBXSwitch parameter.

d. On the pull-down list of values, select the name of the PBX (for example, 
use Lucent 2-wire for an Avaya G3 switch).

e. Click the Country tab and select the Country parameter.

f. On the pull-down list of values, select your country.

g. Click OK to close the Dialogic Configuration Manager Properties window.

6. Repeat steps 4 and 5 for any other installed Dialogic boards (such as 
#1).

7. When all boards are configured, click the green Start Service button on 
the button bar.

Wait for service to start. The installed boards show a green light when 
service is started, and the Stop Service button becomes active.

Figure 4-6. Sample Dialogic Configuration Manager DSE window - service not started
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8. Check that the boards are operating correctly. 

a. Check the LED display on the Dialogic board faceplate. It flashes a code 
for each port consecutively as follows:

� Ports that are connected to a phone line and functioning correctly 
show 0 and the port number (such as 00 or 01).

� Ports that are not connected to a phone line or not functioning 
correctly show En, where n is the port number. For example, the 
display reads E3 if there is an error on port 3.

b. If any errors (En codes) are present, check your board configuration, the 
physical connections between the board and the PBX, or the PBX 
configuration itself. (For example, make sure you have configured the 
correct PBX). Repeat steps 4 through 8 as needed.

9. Close the Dialogic Configuration Manager.

10. Continue with "Testing the port boards" on page 4-35.

Configuring T1- or E1-QSIG boards 

You may have either of the following QSIG port boards installed in your MAS. See 
Span JCT boards on the documentation CD for more information. 

� Dialogic D/480JCT-T1 board (up to 3 boards per MAS)

� Dialogic D/600JCT-E1 board (up to 2 boards per MAS)

To configure either of these QSIG boards:

1. Click Start > Programs > Dialogic System Software > Dialogic 
Configuration Manager - DCM.

The Dialogic Configuration Manager window appears. 

2. In the Computer Name popup window, make sure that the radio button 
for Local is selected (verify the MAS name, such as ZIPPY).

3. Click Connect. 

The Dialogic Configuration Manager locates any installed port boards. 

4. Under Configured Devices, double-click the name of the first Dialogic 
board shown (such as #0). 

5. On the Dialogic Configuration Manager Properties window:

a. Click the Interface tab and select the ISDNProtocol parameter.

b. Select the correct value for this type of board from the pull-down list:

� For E1-QSIG: select QTE
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� For T1-QSIG: select QTU

c. Click the Telephony Bus tab and select the PCMEncoding parameter.

d. Select the correct value for this type of board from the pull-down list:

� For E1-QSIG: select A-Law 

� For T1-QSIG: select µ-Law 

e. Click the Misc tab:

(1) Select the FirmwareFile parameter. Type Default in the Value 
field.

(2) Select the FirmwareFile2 parameter. Type spfax.fwl in the Value 
field.

f. Click the Country tab and select the Country parameter.

g. On the pull-down list of values, always use United States for either type of 
board. 

h. Click OK to close the properties window.

6. Repeat steps 4 and 5 for any other installed Dialogic boards (such as 
#1).

7. When all boards are configured, click the green Start Service button on 
the button bar.

Wait for service to start. The installed boards show a green light when 
service is started, and the Stop Service button becomes active. See 
Figure 4-7 on page 4-34 for an example. 

8. Check that the boards are operating correctly. 

a. Check the LED display on the Dialogic board faceplate. 

� A red status LED appears on the back of the voice card during 
driver start-up.

� If the drivers start successfully, the LED of the board whose port is 
connected to the PBX is replaced by a green LED within about 20 
to 30 seconds. LEDs on the other boards remain red.

b. If a problem occurs, check your board configuration, the physical 
connections between the board and the PBX, or the PBX configuration 
itself. Repeat steps 4 through 8 as needed. 
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9. Close the Dialogic Configuration Manager.

10. Set up the T1 QSIG or E1 QISG boards for testing as follows: 

a. Select Start > Programs > Avaya Modular Messaging > Dialogic Line 
Tester. 

b. In the Dialogic Line Test Application window, select Tools > Options.

c. In the Options window, select the correct values for each field as follows: 

� For Layer 1 Protocol, select your ISDN protocol from the 
drop-down list.

� For Number Type, select the destination number type.

� For Number Plan, select the destination number plan. 

11. Continue with "Testing the port boards" on page 4-35.

Figure 4-7. Sample Dialogic Configuration Manager QSIG window - service started

Note: The values you select here must be the same as those entered 
on the PBX or switch. Check your configuration notes.
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Testing the port boards 

Before continuing with administration, test all port boards and channels to verify that 
they can receive calls. 

To test port board functionality:

1. Test the incoming call connectivity of all ports as follows:

a. Select Start > Programs > Avaya Modular Messaging > Dialogic Line 
Tester. 

The Dialogic Analog - Line Test Application (or DLTest) window 
appears. The name of the window varies slightly depending on the 
type of port boards installed. 

All port numbers and channel designations should be listed. See 
Figure 4-7 for an example. 

b. From a handset on the same PBX, dial each port individually.

� For analog and set emulation boards, use the individual port 
extensions from Required switch and messaging information on 
page A-12.

� For QSIG cards, repeatedly dial the number for that group of 
ports. The switch connects to the next port in the list each time 
you dial.

Figure 4-8. Sample Dialogic Analog - Line Test Application window
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c. Check the Status column. Verify that each port shows “Received call” 
followed by “Connected.” See Table 4-6 for different status conditions.

The system should answer each connected call with a standard 
welcome message. 

2. Test the outcalling capability of all ports as follows: 

a. Type the number of an extension on this PBX in the Dial Number field near 
the top of the window.

b. Select a Port Number on the Dialogic Line Test Application window.

c. Click Dial Number.

d. When the dialed extension rings, answer the call and hang up.

e. Select the next Port Number, and click Dial Number again. 

f. Repeat steps d and e until all ports have been tested.

g. When finished, close this window.

3. If a problem occurs, check your board configuration, the physical 
connections between the board and the PBX, or the PBX configuration 
itself. For example, make sure that you have configured the correct PBX 
and administered it according to the appropriate configuration notes.

Table 4-6. DL Test status messages 

Status Description Highlight

Channel starting… The channel is being started. Normal

Channels idle… The channel is idle. Normal

Waiting for call… The channel is waiting for an incoming call. Normal

Received call… An Incoming call is being processed. Normal

Dialling number… A number is being dialled to make on outgoing 
call.

Normal

Resetting… The user reset the channel. Normal

Line Busy. An outgoing call was made but a busy tone was 
detected.

Normal

No Answer. An outgoing call was made but the call was not 
answered.

Normal

Connected. A incoming call or outgoing call was answered so 
the call is now connected.

Normal

Call was disconnected. A Incoming or Outgoing was disconnected. Normal

Error. A general error with channel occurred. Error

Error, No Dial tone 
detected.

An outgoing call was made but no dial tone was 
detected before dialling.

Error
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Setting up the MAS messaging services

Do this task on every MAS machine. 

To set up messaging services on the MAS, the following steps are required:

� "Setting up MAS messaging service" on page 4-37

� "Installing additional MAS messaging software" on page 4-39

� "Configuring the voice mail system" on page 4-40

� "Setting up and starting messaging services" on page 4-45

Use your completed S3400 system planning form on page A-6, S3400 password table 
on page A-9, and MAS features list on page A-11 to complete the steps in this section.

Setting up MAS messaging service

To continue setting up messaging services on the MAS:

1. Double-click the desktop icon labeled “Continue with MM Setup”.

The Messaging Application Server - Configuration Wizard appears. 

2. For the Peer Messaging Storage Server Selection screen: 

� Enter the name of the Peer Messaging Storage Server. This is 
always the MSS private system name mss1.

� Click Next.

The Service configuration may take several minutes.

3. For the Voice Mail Domain Selection screen:

� For the first MAS: Click the radio button for “First server in a new 
voice mail domain.”

� For an additional MAS: Click the radio button for “Subsequent 
server in an existing voice mail domain.” 

� Click Next. 

CAUTION: If you are restoring an MAS to service after a disk failure, 
you need to do a different procedure here. See Recovering 
from a catastrophic disk failure on page F-1 for details. 

!
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4. On the first Messaging Application Server Credentials screen: 

� Enter the password for the LDAP service that you previously 
administered on the MSS in both boxes. This is the MAS trusted 
server password specified in "Setting up the trusted servers" on 
page 3-12. See items P1 through P4 on the S3400 password 
table on page A-9, using the password for the appropriate MAS.

� Click Next.

5. For the first MAS only: Another Messaging Application Server 
Credentials screen appears. 

� Enter the password for the IMAPI service that you previously 
administered on the MSS. This is the password for the MWI 
trusted server that activates message-waiting lamps, currently 
called VVSTS. See item P5 on the password table.

� Click Next.

6. For the first MAS only: A third Messaging Application Server Credentials 
screen appears.

� Enter the password for the IMAP4 service that you previously 
administered on the MSS. This is the Imap4TS1 trusted server 
password. See item P6 on the password table. 

� Click Next.

7. On the Voice Mail Domain Selection screen:

� For the first MAS: Enter the unique voice mail domain name for 
this pair of MAS and MSS servers (such as zebra). See item 4 on 
the S3400 system planning form on page A-6.

� For an additional MAS: Select the existing voice mail domain 
name from the voice mail domain (VMD) drop-down box (such as 
zebra). 

� Click Next. 

The VMD configuration may take several minutes.

8. For a subsequent MAS: The Caller Application screen appears if Caller 
Applications are deployed in the domain. 

� Use the default setting for this step.

� Click Next. 

9. For the User Information screen, just click Next.

10. For the Setup Complete screen, click Finish.
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Installing additional MAS messaging software

You need to install additional required messaging software on the MAS to bring it into 
full service. Check your MAS features list on page A-11 for the software packages that 
are required for this particular MAS. 

To install the additional required messaging software:

1. Run the Modular Messaging Installation wizard as follows:

a. Click Start > Run.

b. In the Run box Open field, type C:\mm_install\install\setup and press 
Enter.

The software searches for components to install, then the Modular 
Messaging - Installation Wizard configuration window appears.

2. In the components list, check the boxes for any messaging services you 
need to install on this MAS. See the MAS features list on page A-11. 
Services include:

� Call Me Server (includes the Mailbox Monitor Server)

� Caller Applications Editor

� Fax Sender Server

� Message Waiting Indicator (MWI) Server (also includes the 
Mailbox Monitor Server)

� Tracing Server 

� Voice Server Prompt Files for additional languages 

3. When all required services are selected, click Install.

4. Wizards run for all the Modular Messaging software packages you 
selected. Complete each wizard as required. For example:

a. When the Mailbox Monitor Server installation wizard runs, click Next.

b. When prompted, enter name of this MAS machine (such as zippy). Click 
Next. 

c. When prompted, enter the password for the MAS Modular Messaging 
account (such as mmacct). See item A5 on the S3400 logon accounts 
form on page A-10. Click Next. 

d. Click Install.

Note: Administration Tools, Diagnostic Tools, Messaging Application 
Server, and one set of prompt files are already installed on 
each MAS.
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e. When done, click Finish.

5. Each wizard prompts for the same information as shown in step 4. 
Complete all wizards as they appear.

6. When finished with all wizards, click Close.

7. Click Restart when prompted to restart the system now. 

Configuring the voice mail system 

This procedure can only be completed using the configuration notes for your particular 
PBX or switch integration. Use the MAS features list on page A-11 and Required switch 
and messaging information on page A-12 to complete this section. 

To configure the MAS for correct PBX integration:

1. When the reboot completes, press Ctrl+Alt+Del to log back in. Use the 
Modular Messaging account name (such as mmacct) and its password 
(see item A5 on the S3400 logon accounts form on page A-10).

2. Start the MAS messaging service as follows:

a. Double-click the Monitor icon on the desktop.

The Services (Local) item in the left-hand pane should be selected.

b. In the right-hand pane of the Monitor window, scroll down to MM 
Messaging Application Server. Right-click it and select Start. 

The system begins a messaging service startup. 

c. Use the following procedure to monitor startup progress:

(1) In the left pane, expand Event Viewer (Local), then click 
Application.

(2) Refresh the window periodically until you see Telephony User 
Interface event 1241, “TUI service has been enabled.” It is now 
safe to proceed.

Note: When you restart messaging service, the Monitor window 
immediately shows a status of Started. However, the service 
may actually take up to 5 minutes to start, depending on the 
number of port boards installed.

CAUTION: You cannot install this system without using the required 
configuration notes for your PBX or switch. See "Required 
software and documentation" on page 2-5 for instructions on 
obtaining the configuration notes.

!
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d. When service is started, minimize the Monitor window. 

3. Click Start > Programs > Avaya Modular Messaging > Voice Mail 
System Configuration. 

The Voice Mail System Configuration window appears. All MAS units 
present in the S3400 system are listed. 

4. On the first MAS: Double-click Telephone User Interface.

a. On the General tab, set the “Number of Digits in a Mailbox” to match the 
number of digits in the extension numbers on the customer’s PBX. See 
Required switch and messaging information on page A-12.

b. Click OK to close this window.

c. If prompted that your extension number changes will invalidate all previous 
mailboxes, click Yes.

5. To set up Call Me service: Do this procedure after the Call Me Server is 
installed on any MAS. See the MAS features list on page A-11.

a. Double-click Call Me.

b. On the Call Me - Voice Mail Domain window, on the General tab, check the 
box to Enable Call Me.

c. For Call Me server, specify the MAS machine name (such as ZIPPY). If 
this field is blank:

� Click the ... button next to the field.

� On the Select Computer window, double-click the name of the first 
MAS that supports Call Me (such as ZIPPY).

� Click OK to close this window.

6. To set up MWI service: Do this procedure after the Message Waiting 
Indicator Server is installed on any MAS. See the MAS features list on 
page A-11.

a. Double-click Message Waiting Indicator.

b. On the Message Waiting Indicator - Voice Mail Domain window, on the 
General tab, check the box to Enable Message Waiting Indicator (MWI).

c. For MAS MWI server, specify the machine name (such as ZIPPY). If this 
field is blank:

� Click the ... button next to the field.

Note: Although you are prompted to restart service several times 
during this procedure, you actually need to restart service only 
before entering the port board extension numbers in step 13 
and at the end, when configuration is complete.
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� On the Select Computer window, double-click the name of the first 
MAS that supports MWI (such as ZIPPY).

d. In the “Messaging Application Servers that support MWI” box, list all MAS 
servers that have the MWI software installed. To add a server’s name:

� Double-click inside the top of the big list box (or click the Add 
dashed-box button just above the list box).

� A data entry field and ... button appear in the list box. Click the ... 
button.

� On the Select Computer window, double-click the name of the first 
MAS that supports MWI (such as ZIPPY).

e. Click OK to close this window.

7. To set up fax service: Do this procedure if the Fax Sender Server is 
installed on any MAS. See the MAS features list on page A-11.

a. Double-click Fax.

b. On the Fax - Voice Mail Domain window, on the General tab:

(1) Check the box for Fax Enable.

(2) Next to MAS Fax Sender server, click Browse.

(3) On the Select Computer window, double-click the name of the 
MAS machine that contains the Fax Server software. See the 
MAS features list on page A-11.

(4) For Fax Mailbox, enter the extension for the fax mailbox (this 
mailbox must be set up on the MSS as well). See the Required 
switch and messaging information on page A-12.

(5) For Company Fax Number, enter the externally diallable number 
that callers should use to send faxes to subscribers. This number 
also appears on any outgoing fax cover page.

c. Click the Advanced button.

(1) On the Advanced Fax window, change the Max Concurrent 
Outgoing Calls number to a customer-specified number to allow 
faxes to be sent. See the MAS features list on page A-11.

(2) Adjust any other options if required.

(3) When finished, click OK to close this window.

d. Click OK to close the Fax - Voice Mail Domain window.

e. On the Voice Mail System Configuration window, expand Security.

f. Double-click Messaging Servers Administration.
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g. On the Message Servers - Voice Mail Domain window, on the Message 
Servers tab:

(1) The Credentials list shows entries for LDAP, IMAPI, and IMAP4. 

(2) Click the key button above the list to add a new entry for fax.

The FAX value should appear in the box.

(3) Click in the Password column next to the new Fax entry.

(4) Type the password for the fax mailbox and press Enter. This 
value must be numeric (see the Required switch and messaging 
information on page A-12).

(5) Click OK to close this window.

8. On the first MAS: Set up access permissions for the system. 

a. On the Voice Mail System Configuration window, expand Security (if not 
already expanded). 

b. Double-click System Administration.

(1) On the Permissions for System Administration window, click Add.

(2) On the Select Users, Computers, or Groups window, scroll down 
to Domain Admins. Double-click it, then click OK.

(3) Click OK to close this window.

c. Double-click Subscriber Administration.

(1) On the Permissions for Subscriber Administration window, click 
Add.

(2) On the Select Users, Computers, or Groups window, scroll down 
to Domain Admins. Double-click it, then click OK.

(3) Click OK to close this window.

9. On the first MAS: Set up the PBX service for the system.

a. On the Voice Mail System Configuration window, right-click PBXs and 
select Add New PBX Type.

b. For Telephony Type, select the type of Dialogic board that is installed in 
this MAS (such as Dialogic Analog).

c. In the PBX field, select the type of switch you have (such as Dialogic 
Avaya G3).

d. Click OK to close this window.

e. Return to the Voice Mail System Configuration window and expand PBXs.
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f. Double-click the PBX entry you just added.

g. Using the configuration notes for your PBX or switch, set up the specific 
PBX parameters required for this integration of the system. 
 

10. On the Voice Mail System Configuration window, expand Messaging 
Application Servers. 

a. For the first MAS: The first time you access this item, a Telephony 
Configuration Wizard runs to help you set up the basic PBX integration 
details for all MASs in this domain. Complete the wizard as prompted. 

b. For a subsequent MAS: Right-click the server name (such as ZORRO), 
then select Telephony Configuration Wizard to run the wizard. Complete 
all steps in the wizard as prompted. 

11. When the wizard completes:

a. Expand Messaging Application Servers again, then expand the directory 
for this server’s name.

b. Check your configuration notes and add any additional detailed data that 
are dependent on the switch and the integration type.

12. When the configuration note programming is complete, restart service 
as follows: 

a. Return to the Monitor window.

b. Click Services (Local) in the left-hand pane.

c. Scroll down to MM Messaging Application Server. Right-click it, then 
select Stop.

d. When service is stopped, right-click MM Messaging Application Server 
again and select Start.

e. Restart can take up to 5 minutes. To monitor startup progress:

(1) In the left pane, expand Event Viewer (Local), then click 
Application.

(2) Refresh the window periodically until you see Telephony User 
Interface event 1241, “TUI service has been enabled.” It is now 
safe to proceed. 

f. When service is restarted, minimize the Monitor window.

Note: If the wizard does not start automatically, right-click the server 
name (such as ZIPPY), then select Telephony Configuration 
Wizard.

CAUTION: PBX configuration should be done on the first MAS only. 
CLAN, Inband, DSE, and QSIG integrations are supported. !
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13. On the Voice Mail System Configuration window, expand Messaging 
Application Servers. 

a. Expand the entry for your server name (for example, ZIPPY). 

b. Double-click Telephony Interface. Configure the port boards in this MAS. 
Use your configuration notes. See the Required switch and messaging 
information on page A-12 for port board extensions.

c. Click PBX Type. Select the same type of PBX service as you did in step 9.

d. Click PBX Integration and configure the integration type for your system. 
Use your configuration notes to specify or confirm the detailed settings 
required by your switch integration. 

14. When configuration is complete, restart service again (see step 12). 

15. When finished, close the Monitor and Voice Mail System Configuration 
windows.

Setting up and starting messaging services

To set up recovery procedures and start MAS messaging services:

1. Click Start > Run.

2. In the Run box Open field, type the following and press Enter:

c:\avaya_support\scripts\serverrecovery.vbs 

The script takes a few seconds to run. When it completes, all installed 
MM services will be started.

3. Optional. To verify that all services are started: 

a. Double-click the Monitor icon on the desktop.

The Services (Local) item in the left-hand pane should be selected.

b. In the Monitor window, scroll down to the list of Modular Messaging (MM) 
services. Make sure that the Status column shows that service is started 
for each installed messaging service.

c. If service is stopped or the Status column is blank, right-click on the 
appropriate MM service and select Start.

Note: Some values may already be set. Follow the configuration 
notes for your PBX integration.

Note: To set the maximum number of MWI sessions allowed at one 
time, see MAS features list on page A-11.
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Continue with administration as required

Continue with administration as required based on the number of MASs in the system:

� If you have another new MAS to install (up to four may be present), 
return to "Setting up the MAS machine" on page 4-3. Follow the 
instructions in each section for setting up an additional MAS. 

� If all your MASs are now installed, continue with Chapter 5, ‘‘Completing 
initial administration,’’ and complete all steps in order.
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5
Completing initial administration

This chapter describes how to complete the basic administration on the Message 
Storage Server (MSS) and the Messaging Application Server (MAS) to bring the S3400 
system into full service.  

Note: Before you can successfully complete the tasks in this section, you 
must have successfully completed the installation tasks in Chapter 
4, ‘‘Administering the MAS.’’ 

Section Page

Completing required administration on the MSS 5-2

• Verifying customer options 5-2

• Administering Internet messaging 5-3

• Updating MAS host information 5-4

• Placing the MSS in the Windows domain 5-6

• Administering special mailboxes and classes of service 5-7

• Adding a test subscriber 5-9

Performing acceptance tests 5-10

Removing the test subscriber 5-14

Setting up remote access on the MSS 5-15

Administering SMTP networking (if required) 5-18

Setting up Mailbox Manager 5-19

Backing up the system 5-22
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Completing required administration on the MSS

After you complete the initial administration of all MAS units in your S3400 system, you 
need to return to the MSS to complete the basic messaging administration and perform 
acceptance tests. The amount of administration varies depending on the optional 
features the customer has chosen to implement. 

Final administration tasks include:

� "Verifying customer options" on page 5-2

� "Administering Internet messaging" on page 5-3

� "Updating MAS host information" on page 5-4

� "Placing the MSS in the Windows domain" on page 5-6

� "Administering special mailboxes and classes of service" on page 5-7

� "Adding a test subscriber" on page 5-9

Verifying customer options

To make sure that the customer has enough mailboxes to support all subscribers: 

1. Switch the monitor to show the MSS server.

� For a Belkin OmniView Pro2 KVM: Press slowly in sequence 
Scroll Lock, then Scroll Lock, then the down arrow key to change 
to the MSS server (usually connected to port one).

� See "Switching the monitor to show the correct server" on page 
4-3 for more information if needed.

You rebooted the MSS at the end of Chapter 3, ‘‘Powering up the system 
and performing initial MSS administration.’’ You need to relogin now.

2. You should see a “Press Enter to return to prompt...” message. Press 
Enter. 

3. At the login prompt, log in to the MSS server as craft using the current 
password.

The server displays the Messaging Administration main menu. 

4. Starting from the Messaging Administration main menu, select:

Global Administration
Customer Options

The Customer Options screen appears. 
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5. Check that the number of mailboxes purchased on the system is 
sufficient to provide every subscriber with a mailbox.

If the number of mailboxes is insufficient, contact the remote service 
center.

6. Click Return to Main.

Administering Internet messaging

Complete the following task to activate Internet messaging. Plan to activate Internet 
messaging before load is running or when server usage is low.

To activate Internet messaging:

1. Starting from the Messaging Administration main menu, select:

Feature Administration
Internet Messaging

General Options and Settings

The General Options and Settings screen appears.

2. Click on the Yes radio buttons to enable POP3 and IMAP4. 

Enabling these protocols allows other clients such as Microsoft Outlook 
to access their mailboxes using these protocols.

3. Click Submit to save your changes. 

4. Click Return to Main.

Note: A security certificate acceptance dialog box may appear when 
you make changes to this screen. Use the default values to 
accept the certificate, and then proceed.
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Updating MAS host information 

Host information for each MAS must be entered and then sent to all machines in the 
S3400 system. See your S3400 system planning form on page A-6 for system 
information. 

To update the host information for one or more MAS machines:

1. Starting from the Messaging Administration main menu, select:

Basic System Administration
TCP/IP Administration

MAS Host Information Setup

The MAS Host Information Setup screen appears. 

2. Select the MAS machine whose information you want to change (MAS1 
through MAS4). Click Edit. 

3. On the MAS Host Information Setup screen, update the host information 
to identify this MAS on the corporate and private networks:

a. Public System Name is the corporate fully qualified domain name or 
FQDN of the MAS (such as zippy.loc.avaya.com). See item 7 on your 
S3400 system planning form on page A-6. 

If this name has a domain qualifier (such as loc.avaya.com), then you 
should include just the host name (such as zippy) as an alias.

b. Public IP Address is the corporate IP address of the MAS (see item 8 on 
your planning form).

c. Public Aliases must include at least the following:

� The host name of the public MAS system name (such as zippy for 
zippy.loc.avaya.com). See item 1 on your planning form.

� Any other required aliases. Separate names with a space.

d. Do not change any information in the Private System Name and Private IP 
Address fields for a new system.

e. Private Aliases must include the private FQDN for the private network 
(such as zippy.zodiac.com). See item 5 on your S3400 system planning 
form on page A-6.

CAUTION: It is strongly recommended that you do not change any 
default private host information (such as the private host 
machine name or its IP address). A change to these values 
could prevent the system from working.

!
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4. For Administrator Login, enter the MAS domain administration 
account login (such as dom-admin) and its password to make any 
changes. See the S3400 logon accounts form on page A-10.

5. When finished, click Save.

The MSS system updates its internal information, and then sends this 
information to all MASs in the network.

� The system reports whether or not the information was successfully 
updated. Check that all machines in the network were updated.

� If an update to a machine failed, check your network operation using 
a ping test as follows: 

a. Click Return to Main.

b. Starting from the Messaging Administration main menu, select:

Diagnostics
TCP/IP Diagnostics

Send & Receive Packets To & From (Ping Test)

c. On the ping test screen, enter the name or IP address of the MAS machine 
to establish connectivity. 

d. Repeat the test as needed to try to isolate the problem.

e. Once the problem is corrected, try to send the host information again using 
the MAS Host Information Send screen (under Basic System 
Administration > TCP/IP Administration).

6. Continue as follows:

� If you have one MAS, click Return to Main.

� If you have more than one MAS:

a. Click Back, then click Back again to return to the MAS Host Information 
Setup screen.

b. Repeat steps 2 through 5 for every MAS in this system.

c. When finished, click Return to Main. 

7. If you changed a private MAS IP address (NOT recommended), you 
need to repeat the procedure for "Synchronizing the time and date with 
the MSS" on page 4-26.
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Placing the MSS in the Windows domain

The MSS must be added to the Windows domain you set up on the MAS. 

To add the MSS to the Windows domain:

1. Starting from the Messaging Administration main menu, select:

Basic System Administration
TCP/IP Administration

Windows Domain Setup

The Windows Domain Setup screen appears. 

2. Enter the following information in each field:

a. In the Eth1 NetBIOS Name field, type the MSS private system name mss1 
(see item 13 on the S3400 system planning form on page A-6).

b. In the NetBIOS Domain Name field, type the Windows NetBIOS domain 
name (such as zodiac) that was created on the first MAS (see item 3 on 
your planning form).

c. In the Fully Qualified Domain Controller Name field, type the MAS private 
system name for the first MAS (by default mas1 as shown in item 13 on 
your planning form). 

d. In the Domain Controller Administrator field, type the domain administrator 
account name (such as dom-admin). See item A1 on the S3400 logon 
accounts form on page A-10. 
 

e. In the Domain Controller Administrator Password field, type the password 
for this account.

3. When finished, click Save.

4. Click Return to Main.

CAUTION: This same account must be used to set up system backups 
on every MAS (see "Backing up the system" on page 5-22).!
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Administering special mailboxes and classes of service

You need to administer a class of service that will be used for the PostMaster and fax 
mailboxes and for the required test subscribers. Use the Required switch and 
messaging information on page A-12 to complete the information in this section. 

To set up a new class of service and the required mailboxes:

1. From the Messaging Administration main menu, select:

Global Administration
Subscriber Management

Manage Classes-of-Service

The Manage Classes-of-Service screen appears. 

a. Select the class of service to modify (such as class00). You may set up 
different classes of service if required (for example, you may use a 
different class of service for the PostMaster and fax-enabled subscribers).

b. Click Edit the Selected COS.

c. On the Edit a Class-of-Service screen, scroll down to Subscriber 
Features and Services. Activate the following features:

(1) Set Outbound Fax Calls to Yes (required for fax service).

(2) Set Record Mailbox Greetings to Yes.

(3) Adjust other feature values if directed. Generally, you enable 
features that you have installed and must test.

d. When finished, click Save.

e. Click Back.

2. Set up the mailbox for the subscriber who is to receive PostMaster 
messages. Use the name and extension specified on the Required 
switch and messaging information on page A-12. 

On the Managing Subscribers submenu, next to Local Subscribers for 
this MSS machine (such as zigzag), click Manage.

The Manage Local Subscribers screen appears.

a. Click Add a New Subscriber.

Note: Typically an existing subscriber such as the system administrator is 
set up to receive postmaster messages. If the PostMaster 
message volume is large, you may set up a secondary mailbox for 
a subscriber to receive postmaster messages, but that secondary 
mailbox must be checked regularly (on a daily basis if possible).
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b. On the Add Local Subscriber screen, enter the following information:

(1) In the Last Name field, type the last name of the subscriber who is 
to receive the postmaster messages.

(2) In the First Name field, type the subscriber’s first name.

(3) Enter the subscriber’s mailbox password (see the planning form).

(4) In the Mailbox Number field, type a valid mailbox extension 
number; enter 3-to-10 digits as required by your dial plan. 

(5) In the Numeric Address field, type a unique number for that 
mailbox in the network. For example, you could prepend a 1 or the 
area code to the mailbox number.

(6) Select the required class of service.

c. Scroll down and click Save.

3. If fax service is installed: Set up the required fax service mailbox using 
the Required switch and messaging information on page A-12.

On the Manage Local Subscribers screen:

a. Click Add a New Subscriber.

b. On the Add Local Subscriber screen, enter the following information:

(1) In the Last Name field, type fax.

(2) Enter a password (see the planning form).

(3) In the Mailbox Number field, type a valid mailbox extension 
number. This number should not be a real telephone extension on 
your system, or the fax feature will not work correctly.

(4) In the Numeric Address field, type a unique number for that 
mailbox in the network.

(5) Select the required class of service.

c. Scroll down and click Save.

4. Click Back to return to the Managing Subscribers submenu.

5. From the Managing Subscribers submenu, select:

Configure Subscriber Management

The Configure Subscriber Management screen appears. 

a. In the Special Subscribers section:
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(1) For the Fax Mailbox Number, enter the extension for the Mailbox 
Number that you used in step 3. 

(2) For the Internet Postmaster Mailbox Number, enter the 
extension for the Mailbox Number that you used in step 2.

b. Click Save.

You return to the Managing Subscribers submenu.

Adding a test subscriber

You need to set up at least one local subscriber to test the system. 

To add a test subscriber:

1. From the Managing Subscribers submenu, next to Local Subscribers for 
this MSS machine (such as zigzag), click Manage.

The Manage Local Subscribers screen appears. 

2. Click Add a New Subscriber.

The Add Local Subscriber screen appears. 

3. Fill in the fields in the Subscriber Information section as shown in Table 
5-1 on page 5-9. Use the Required switch and messaging information on 
page A-12 for mailbox extension numbers and passwords.

Click Help if you need details about completing any fields on this screen. 

4. When finished, scroll down and click Save. 

5. Click Return to Main.

Table 5-1. Subscriber screen sample settings

Field Setting

Last Name Smith

First Name Test

Password 1111 (must comply with minimum password length)

Mailbox Number Type a valid mailbox extension number; enter 3-to-10 digits 
as required by your dial plan.

COS 0 (Use the one you modified or as directed; it must have all 
the features that you need to test activated.)

Numeric Address Type a unique number for that mailbox in the network (for 
example, you could prepend a 1 or the area code to the 
mailbox number)
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Performing acceptance tests

After installing the system, verify that it is working correctly by doing the following tests. 
 

Creating and sending a call answer message

The following test works only if call-coverage has been assigned on the switch to route 
unanswered calls to the test subscriber’s extension.

To create and send a call answer test message:

1. Call the test-subscriber extension from any other telephone. Allow the 
S3400 messaging system to answer.

2. Speak into the telephone and record the following or a similar test 
message after the tone:

“This is a test call answer message.”

3. Hang up the telephone to disconnect. 

Retrieving test messages in integrated mode

Test the fully integrated operation of the system as directed below. You need access to 
the actual telephone whose extension number is assigned to the test-subscriber 
mailbox to perform this test. 

To verify the receipt of your test messages in integrated mode:

1. If MWI is installed: Check the message waiting indicator (MWI) on the 
test-subscriber telephone. The MWI may be a light, a screen display, or 
a dial-tone stutter when you pick up the phone. 

If the MWI does not indicate that a call was received:

a. Check that the Mailbox Monitor and MWI services are started. Double-click 
the Monitor icon on the MAS desktop, then scroll down to these MM 
services in the right-hand pane and verify status. If needed, select Start.

CAUTION: You must wait 5 minutes for the MSS and MAS to 
synchronize their data after adding any test subscribers. 
Otherwise, the acceptance tests will not run correctly.

!

Note: The message-waiting lamp may take up to 1 minute to light on 
the appropriate telephone after a test message is sent.
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b. If service is started, check for a problem with the test subscriber 
administration, the switch integration or switch integration software, or the 
switch number administration for the test telephone. 

2. From the test-subscriber telephone, dial the S3400 messaging system 
message retrieval number.

The system voices the test subscriber’s name.

3. Enter the password for this mailbox and press . 

4. The first time you access this mailbox, you answer a series of prompts to 
set up the mailbox for operation. Answer all voice prompts as directed.

5. After the mailbox is set up, press  to review your new messages.

6. Press  to retrieve a voice message.

7. Listen to the message. If the message does not play properly, contact 
your remote support center.

8. Press  to erase this message.

9. Follow the voice prompts to retrieve the next message (if any), or press 
 to return to the main menu.

10. Hang up the telephone to disconnect when finished.

11. If MWI is installed: Check the MWI on the test-subscriber telephone. The 
MWI should be off. If it is not off, check your MWI administration.

Creating and sending a test message in nonintegrated mode

To create and send a test message in nonintegrated mode: 

1. Dial the S3400 messaging system message retrieval number from any 
telephone that is not administered on the system.

The system voices the “Welcome to Avaya Messaging” prompt.

2. Press  to skip the system introduction. 

3. Enter the extension number for test-subscriber mailbox and press .

4. Enter the password for this mailbox and press . 

5. Press  to create a new message.

6. Speaking into the telephone, record the following or a similar test 
message after the tone.

 “This is a test voice mail message.”

#

1

1

7

*

#

#

#

2
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7. Press  to approve your message.

8. Enter the mailbox number for the test subscriber when prompted for the 
extension, followed by .

9. Press  twice (as prompted) to approve the message.

10. Press  again to send the test message to the test-subscriber mailbox.

11. Hang up the telephone to disconnect. 

12. Retrieve the message as described in "Retrieving test messages in 
integrated mode" on page 5-10.

Creating and printing a fax message

Do this test if the Fax Sender Server is installed. 

To create and send a test fax message:

1. From a fax machine, send a fax to the test-subscriber mailbox. This 
subscriber mailbox should have been set up to be fax enabled.

2. Wait a few minutes for the fax to be delivered. The MWI lamp (if present) 
on the test-subscriber telephone should light.

3. From the fax machine, dial the S3400 messaging system message 
retrieval number for that telephone.

4. Press  to access the test subscriber’s mailbox. 

5. Enter the extension number for the test-subscriber mailbox and press 
.

6. Enter the password and press .

7. Press  to retrieve new messages.

8. Press  to retrieve the fax message.

9. When the prompt finishes, press  to print the fax.

10. Press  to print the fax at this fax machine.

11. Press the Start key on the fax machine. 

12. Verify that the fax prints correctly. The call is then disconnected.

13. If MWI is installed: Check the MWI on the test-subscriber telephone 
again. The MWI should be off. 

#

#

#

#

#

#

#

1

3

2

3
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Testing the outcalling capability

Test the outcalling capability of the system using the Subscriber Options package. 

To test system outcalling:

1. Switch the monitor to show the MAS server. See "Switching the monitor 
to show the correct server" on page 4-3 if needed.

2. To run the Subscriber Options package, click Start > Programs > Avaya 
Modular Messaging > Subscriber Options.

3. On the User Logon window:

a. Enter the mailbox number and password for the test subscriber. See 
Required switch and messaging information on page A-12.

b. Use the host name for the first MAS (such as ZIPPY). See item 1 on the 
S3400 system planning form on page A-6.

c. Click OK.

4. If a message appears about not having multimedia, click OK.

5. Play back the spoken name to test outcalling as follows:

a. On the Modular Messaging Software User Properties window, click the 
Record Greetings tab.

b. Under Standard Greetings, click the Spoken Name radio button.

c. Verify that the telephone will be used for name playback:

(1) Check the icon to the left of the status display. If it shows a 
telephone, continue with step d.

(2) If the icon shows a terminal, right-click and select Telephone. The 
icon changes to show a telephone. Continue with step d.

d. Click the Play button (large black single arrow) on the player near the 
bottom of the window. 

e. Answer the telephone when it rings. 

The picture of the phone should change to become off-hook. 

f. Listen for the system to play the spoken name of the test subscriber. 

g. Hang up the telephone. 

The picture of the phone should change back to being on-hook (this 
may take a couple of seconds).

6. When finished, click OK to close the Modular Messaging Software User 
Properties window.



585-310-326, Issue 2

Avaya™ S3400 Message Server Release 1 Installation

5–14 June 2003

7. Switch the monitor back to the MSS server. 

Removing the test subscriber

Do this procedure on the MSS.

When acceptance testing is completed, remove the test subscriber as follows:

1. Starting from the Messaging Administration main menu, select:

Global Administration
Subscriber Management

2. On the Managing Subscribers submenu, next to Local Subscribers for 
this MSS machine (such as zigzag), click Manage.

The Manage Local Subscribers screen appears. 

3. Select the test subscriber.

4. Click Delete the Selected Subscriber. 
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Setting up remote access on the MSS

Do this procedure on the MSS. 

Complete the steps in this section to allow a remote service center to dial in to the MSS 
to perform troubleshooting or system maintenance. Steps include:

� "Administering PPP logins and passwords" on page 5-15

� "Activating the RMB modem (external modems only)" on page 5-16

� "Setting up the PPP server configuration" on page 5-16

� "Activating alarm origination" on page 5-17

Administering PPP logins and passwords

It is necessary to administer point-to-point protocol (PPP) logins and passwords for all 
systems. These logins are used for maintenance purposes. See PPP logins, 
passwords, and IP addresses on page A-13 for the required PPP logins and passwords 
that must be administered.

To administer PPP logins:

1. Starting from the Messaging Administration main menu, select:

Basic System Administration
Password Administration

Assign/Change Password

The Assign/Change Password screen appears.

2. At the Login drop-down box, select the PPP login that you want to 
administer (for example, sappp). 

3. Enter the appropriate PPP password in the New Password field. See 
PPP logins, passwords, and IP addresses on page A-13 for passwords.

4. In the Re-enter New Password field, type the PPP password again for 
verification.

5. Click Save.

The system displays a confirmation message. 

6. Click the Back arrow in your web browser to return the Assign/Change 
Password screen.

7. Complete steps 2 through 6 for each additional PPP login that needs 
administration.
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8. When finished, click Return to Main.

Activating the RMB modem (external modems only)

The on-board modem for the model of RMB installed in the United States is 
automatically activated. However, international users must activate the external 
modem that is required for their RMB boards. 

To activate the modem for an external RMB board:

1. Starting from the Messaging Administration main menu, select:

Basic System Administration
Modem and Terminal Administration

Install Modem/Terminal Software

The Install Modem/Terminal Software screen appears.

2. Locate Device Type RMB and update the fields for the modem you are 
using. Click Help for information about completing each field. 

3. When finished, click Save.

4. Click Return to Main.

Setting up the PPP server configuration

Use this page to identify the local and remote IP addresses that are required for remote 
access to the system.

To set up PPP service on this machine:

1. Starting from the Messaging Administration main menu, select:

Basic System Administration
TCP/IP Administration

PPP Server Configuration

The PPP Server Configuration screen appears.

2. For each logon that you are to administer, enter the following 
information. See PPP logins, passwords, and IP addresses on page 
A-13.

a. For Local IP Address, type the customer-provided IP address for PPP 
access through the MSS modem. 

b. For the Remote IP Address, type the customer- or Services-provided IP 
address for the remote device that will connect to this MSS. 

3. Repeat step 2 for each of the PPP logins you need to set up.
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4. When finished, click Save.

5. Click Return to Main.

Activating alarm origination

Activating alarm origination causes a remote location, such as the remote service 
center, to receive notification of alarms that occur on the S3400 system. Notification 
can only occur if the maintenance modem for the RMB is installed and active. 

To set up alarm origination: 

1. Clear all alarms.

2. Insert a labeled writable DVD into the DVD drive for the nightly backup. 
The backup disc must be in place before you activate alarm origination.

3. Starting from the Messaging Administration main menu, select:

Basic System Administration
Alarming Administration

The Alarm Management screen appears.

4. Provide the Product ID and Alarm Destination telephone number. See 
PPP logins, passwords, and IP addresses on page A-13.

5. Complete the remaining fields as required. Generally:

a. Alarm Origination should be Active.

b. Alarm Suppression should be Inactive.

c. Click Help for information about completing each field. 

6. When finished, click Save.

7. Click Return to Main.

8. Continue the installation as follows:

� If customers want to implement SMTP networking, continue with 
"Administering SMTP networking (if required)" on page 5-18.

� For all other customers, continue with "Setting up Mailbox Manager" 
on page 5-19.
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Administering SMTP networking (if required)

SMTP (MIME) networking is an optional feature that provides customers with the ability 
to exchange messages with users on other Avaya S3400 messaging systems or those 
connected to an Avaya™ Message Networking Server. 

To administer SMTP networking, you must enter information about the local and 
remote machine on both the local MSS and on the remote machine. Because you 
already entered the local MSS machine information in a previous task, you now only 
have to enter the remote machine information (the machine you want to network to).

To enter information for the remote machine:

1. Starting from the Messaging Administration main menu, select:

Global Administration
Messaging Administration

The system displays the administration command prompt screen and 
and the SSH dialog box, which provides protection for this screen. 

2. Log in as craft using the craft username and default password.

3. At the command prompt, enter add machine name where machine 
name is the name of the remote machine.

4. On Machine Profile screen, set the remote machine name, machine 
type, extension length, start extension, and end extension as needed.

5. Press F7 (NextPage).

The Machine Profile screen, page 2, appears. 

6. Enter the IP address of the remote machine in the IP Address field.

7. In the Password field, enter the networking password for the remote 
machine.

8. Verify that both Updates In and Out fields are set to n. 

9. Press F3 (Enter).

10. Perform the required set-up steps on the remote machine.

Note: SMTP networking is an optional feature. If the customer does not 
require messaging networking, skip this task.

Note: For additional information about networking, check the 
documentation for the remote system that you want to network 
and networking procedures on the S3400 documentation CD.
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Setting up Mailbox Manager

Set up the Mailbox Manager (MBM) software package for the system administrator and 
verify its operation as described in this section. 

Mailbox Manager (MBM) is a Windows interface for administering the MSS. With this 
software tool, administrators can create, edit, and delete subscribers, and edit COS 
profiles. They can also use MBM to Configure Subscriber Management. 

Installing Mailbox Manager

Mailbox Manager is typically installed on a desktop or laptop PC used by the system 
administrator. It can be installed on their current workstation, providing it meets 
minimum requirements as described in the Mailbox Manager User Guide (PDF 1 MB), 
under the Reference section of the documentation CD, and has a static IP address 
needed for the Trusted Server connection. However, if the corporate network has a 
dynamic host configuration protocol (DHCP) environment, Mailbox Manager must be 
installed on the MAS.

This section describes how to set up your trusted server, install Mailbox Manager, 
configure its connection to the MSS, and download your current MSS information.

1. Before you can install MBM, you must set up an additional trusted-server 
on the MSS, following the steps in "Setting up the trusted servers" on 
page 3-12. Use the data in Table 5-2 to set up the MBM trusted-server 
profile:

Note: Remote services must force a nightly audit to run from a tsc login 
(runmp AUD_NIGHTLY from the /VM/bin directory) before you can 
complete the installation and configuration of MBM. The audit 
initializes certain MSS fields that MBM requires to gather 
subscriber and class-of-service information.

Table 5-2. Setting up a Mailbox Manager trusted server

Field Setting

Trusted-Server Name mbmserver 

Password Create a password and note for use in this 
procedure.

IP Address Corporate IP address of the PC where Mailbox 
Manager will be installed. If installing on the MAS, 
use Corporate IP address of MAS#1 from the 
S3400 system planning form on page A-6.

Service Name Mailbox Manager Server

Access to Cross Domain Delivery? n
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2. Install the MBM software using the directions found in the Mailbox 
Manager User Guide (PDF 1 MB) under the Reference section of the 
documentation CD.

3. Configure the network connection between Mailbox Manager and the 
MSS using the instructions in the Mailbox Manager User Guide.

4. Download your current system information using the Autoconfigure 
Procedure in the Mailbox Manager User Guide. 

If your company’s DHCP environment required you to install Mailbox 
Manager on the MAS, continue with step 5. If you were able to install 
Mailbox Manager on your regular workstation PC, continue with "Adding 
MBM test subscribers" on page 5-20.

5. Install Remote Desktop Connection on the System Administrator’s 
regular work PC. This will allow the user to run MBM on the MAS from 
their desktop or laptop. 

6. Continue with "Adding MBM test subscribers" on page 5-20.

Adding MBM test subscribers

Create at least one subscriber to test Mailbox Manager for acceptance. 

Create the subscriber using the procedure for Creating a Subscriber in the Mailbox 
Manager User Guide. Use the information in Table 5-3 for an example.

Default Community Number 1

Trusted Server ID will be filled in automatically

Minutes of Inactivity Before Alarm 0

Table 5-2. Setting up a Mailbox Manager trusted server

Field Setting

Table 5-3. Subscriber record sample settings

Field Setting

Last Name Jones

First Name Test

Password 1111 (must comply with minimum password length)

Mailbox Number Type the mailbox extension number; enter 3-to-10 
digits as required by your dial plan 

COS 0
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Right-click on any field you have a question about and select What’s 
This? for an explanation.

Removing MBM test subscribers

Remove any Mailbox Manager test subscribers as follows: 

1. If Mailbox Manager is not already running, launch it by selecting 
Windows Start > Programs > Mailbox Manager > Mailbox Manager.

2. In the Workspace, expand Enterprise Systems, then your system, so 
that you can see Classes of Service, Ranges, and Subscribers.

3. Double-click Subscribers. A list of all the systems current subscribers 
will appear. It should include your test subscribers and the PostMaster.

4. In the list, select all of the test subscribers by holding down your shift key 
and selecting each test subscriber line, taking care not to select your 
PostMaster. Each of the test subscriber lines should be shaded.

5. Press the Delete key on your keyboard. A Delete Subscriber window 
will appear. Each of the test subscribers should be displayed in this 
window in red type with a line through them. 

Make sure that your PostMaster mailbox does not appear in this list. If it 
does, click once on the PostMaster line and click the Delete check-box 
so that the check-mark is removed. The line will no longer appear in red.

6. Click Send Now. A Send Now dialog will appear.

7. Click Send Now to send the delete commands to your system.

Community ID 1

Numeric Address Type a unique number for that mailbox in the network 
(for example, you could prepend a 1 or the area code 
to the mailbox number)

Table 5-3. Subscriber record sample settings

Field Setting
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Backing up the system

As a final installation task, set up the system to perform regular, scheduled backups. 
Do an attended backup to verify the backup function. 

Setting up and running backups on every MAS

Do this task on every MAS machine.

You need to send MAS backup data to the MSS (a nightly basis is recommended), so 
that it can be backed up with the rest of the system data on DVD-RAM. 

To set up a scheduled backup of data on this MAS machine: 

1. Switch the monitor to show the first MAS. See "Switching the monitor to 
show the correct server" on page 4-3 if needed.

2. To set up a scheduled backup on this MAS, double-click the Scheduled 
Tasks icon on the desktop.

3. In the Scheduled Tasks window, double-click Add Scheduled Task. 

4. The Scheduled Task Wizard window appears. Do the following:

a. On the first screen, click Next. 

b. On the next screen, to locate the backup script, click Browse.

c. In the Select Program to Schedule window, navigate to the script as 
follows: double-click Avaya_Support, then double-click CMD, then 
double-click BackupScript.bat. 

d. On the next screen, specify the task name and frequency:

(1) Type a name for this task (such as BackupMAS1), or you can use 
the default name.

(2) Select the radio button for Daily.

(3) Click Next.

e. On the next screen, set up the time and frequency of the backup:

(1) Enter a Start time for this task as follows:

� For the first MAS, the backup time should be 11 PM. Do not run 
backups from midnight to 4 AM.

� Set the time for each subsequent MAS to run 15 minutes earlier. 
For example, set MAS#2 to run at 10:45 PM, MAS#3 to run at 
10:30 PM, and so on. 
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(2) For Perform this task, select the radio button for Every Day.

(3) Verify that the Start date shows the current date.

(4) Click Next.

f. On the next screen, set up the account to run the backup:

(1) For User Name, verify that the Windows domain and domain 
administrator account appear in the format domain\account name 
(for example, ZODIAC\dom-admin). 

(2) Enter and confirm the correct password. See item A1 on the 
S3400 logon accounts form on page A-10. 

(3) Click Next.

g. On the final screen:

(1) Verify that the checkbox to “Open advanced properties” is clear.

(2) Click Finish.

5. Immediately run an attended backup on this MAS as follows:

a. In the Scheduled Tasks window, right-click the task you just created (such 
as BackupMAS1). 

b. Select Run.

In Scheduled Tasks window, the Status column shows Running as 
the system immediately begins to back up the data on this MAS to 
the MSS. The Status column goes blank (shows nothing) when the 
backup completes.

c. Optional. To verify that the backup completed correctly:

(1) Click Start > Run. In the Open field, type \\mss1\masbackup 

You are prompted for an account name and password.

(2) In the Connect As window, use the domain administrator account 
name (for example, dom-admin) and password. See item A1 on 
the S3400 logon accounts form on page A-9. Click OK.

Windows Explorer will launch.

(3) Confirm that a backup file has been created on the MSS with the 
correct time and date (such as ZIPPYDailyBackup.bkf, where 

CAUTION: Use the same account here that you used for the MSS to join 
the Windows domain or backups will not work. See "Placing 
the MSS in the Windows domain" on page 5-6.

!
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ZIPPY is the host name of this MAS). You can expect an initial file 
size of approximately 264 MB. 

If a backup file has not been successfully created, check your 
configuration. Make sure that the account used to join the MSS to 
the Windows domain matches the account that the scheduled 
task runs under (this should always be the domain administrator 
account, such as ZODIAC\dom-admin).

6. Close the Scheduled Tasks window. 

7. Repeat this procedure for every MAS unit installed. 

Setting up and running an attended backup of the MSS

After you have run an attended backup of every MAS machine, run an attended backup 
on the MSS. 

See the documentation CD-ROM for information on:

� Backing up system files (attended)

� Backing up system files (unattended)

When finished, log off of the system.

a_sysbr_2.htm
a_sysbr_3.htm
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A
System planning forms

Overview

A new S3400 system installation requires careful network planning. Server 
names, IP addresses, domain names, accounts, extensions, and passwords 
must be administered correctly on each of the servers in the system. Some 
information must be provided by the customer in advance, or the installation 
cannot proceed. 

This appendix provides an overview of system planning and a set of forms for 
you to fill out prior to installation with the help of the local LAN, switch, and 
messaging administrators. Information includes:

� Terminology on page A-2 

� Guidelines for completing the forms on page A-4

� S3400 system planning form on page A-6

� S3400 system planning form (completed example) on page A-8

� S3400 password table on page A-9

� S3400 logon accounts form on page A-10

� MAS features list on page A-11

� Required switch and messaging information on page A-12

� Services logins and passwords on page A-13

� PPP logins, passwords, and IP addresses on page A-13
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Terminology

The following terminology applies to the LAN administration process. 

Host name – The unique name of the machine. In Microsoft Windows terminology, this 
is often called the NetBIOS machine name. This name may or may not match one of 
the network interface names. This is often the short name of the public IP interface.

NetBIOS name – The Microsoft Windows term for a host name, also called a NetBIOS 
machine name.

Domain name – A unique designator used to identify a group of related computers on 
the internet (for example, avaya.com). Domain names are hierarchical, and the labels 
go from more specific on the left to more general on the right. There can be any 
number of levels in the hierarchy. 

Domain Name Service (DNS) – An Internet protocol service most often used to 
resolve symbolic names to IP addresses. The DNS service is constructed on 
hierarchical domains with different sets of servers serving each hierarchical layer.

DNS server – A machine that has the DNS service active. Such a machine can resolve 
symbolic names for the DNS domain it serves to an IP address. 

Fully Qualified Domain Name (FQDN) – A domain name which identifies an 
individual computer and the network on which it resides (such as zippy.loc.avaya.com). 
The leftmost label is the host name of the computer.

Private FQDN – An FQDN containing the host name and the private domain name 
(such as zippy.zodiac.com).

Public (corporate) FQDN – An FQDN containing the host name and public domain 
name (such as zippy.loc.avaya.com).

NetBIOS domain – A Microsoft Windows domain that is not fully qualified (has no 
periods). For example, zodiac.

IP address – A value used to identify a computer connected to a network. If a machine 
has multiple network interfaces, then the machine will have multiple IP addresses, one 
for each connection to a different network. IP addresses are usually specified as four 
numbers separated by a period (for example, 10.9.55.183).

Subnet mask – A value used to tell which bits of an associated IP address are the 
network portion and which bits identify the specific host on the network. Each network 
interface has an IP address and an associated subnet mask.

Corporate IP LAN and interface – Each S3400 server has two network IP interfaces. 
One is connected to the LAN infrastructure constructed and maintained by the 
enterprise that purchased the system. The LAN is the corporate IP LAN and the 
interface connected to it is the corporate IP interface. This LAN is also identified as 
Ethernet interface 0, Local Area Connection, or Corporate LAC. This LAN gives the 
S3400 system access to other machines and users.
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Private IP LAN and interface – The second network IP interface in each S3400 server 
is connected to an Ethernet switch provided by Avaya as part of the product. The LAN 
is the private IP LAN and the interface connected to it is the private IP interface. This 
LAN is identified as Ethernet interface 1, Local Area Connection 2, or the Private LAC. 
It is used only to send information between the S3400 servers.

IP gateway – An IP gateway is an IP address where IP packets are routed if the 
specified IP address is not on the network directly connected to an interface on the 
machine. An IP gateway is usually an interface on a router.

Default IP gateway – The IP gateway to use if no other specified gateway is available. 
Each S3400 server has at most one default gateway connected to the corporate IP 
interface. There is no IP gateway on the private LAN.

PPP – Point-to-Point Protocol, an Internet standard protocol used for serial line 
connections, such as dial-up modems.

Voice Mail Domain (VMD) – A group of one or more messaging servers (up to 4 
machines for an S3400 system). Voice Servers in a VMD share configuration 
properties of the VMD and subscribers to the VMD.

Windows domain – A grouping of network objects, such as users, groups, and 
computers. All objects in a domain are stored in Active Directory. Active Directory can 
reside on one or more domain controllers within a domain.
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Guidelines for completing the forms

Use the following guidelines to complete the S3400 system planning form on page A-6 
for each S3400 system you need to install. 

� Anything in the form that is labeled —NOT USED— is not needed for 
that S3400 item. 

� Anything already filled in must be not be changed unless it causes a 
conflict with the corporate network. Work with the LAN administrator to 
identify and correct any addressing problems or conflicts. 

See the S3400 system planning form (completed example) on page A-8 for a sample 
completed form.

To complete the S3400 system planning form:

1. Choose unique NetBIOS machine (host) names for the MSS and all 
MAS units (for example, zigzag, zippy, and zorro). You must keep track 
of what machine you are administering. In this guide, zigzag is the MSS, 
zippy is the first MAS, and zorro is a subsequent MAS. 

2. For MAS#1: Select a fully qualified domain name (FQDN) for the 
Windows domain (for example, zodiac.com). Coordinate this name with 
the LAN administrator (see step 6). 

3. For MAS#1: The Windows NetBIOS domain name is everything up to 
the first period of the previously specified FQDN (for example, zodiac). 

4. For MAS#1: The voice mail domain (VMD) is a simple term different 
from the Windows domain (such as zebra).

5. The private FQDN for an MAS machine is used only on the private 
network (for example, zippy.zodiac.com). 

Note: It is crucial to coordinate the IP addresses that will be used on the 
S3400 system with those on the corporate LAN. If you specify an 
Ethernet address for an Avaya server that conflicts with another 
Ethernet endpoint, the resulting problems with traffic on the local 
area network may be extremely difficult to diagnose and solve.

Note: Names shorter than 10 characters long are recommended for 
ease in completing the online screens. (For CLAN integrations, 
the MSS host name must be no longer than 7 characters.) The 
host and domain names can be any term you want, as long as 
they are unique and comply with your local conventions.

Note: All domain names (FQDN, Windows domain, and VMD) should 
be unique to avoid confusion. See the S3400 system planning 
form (completed example) on page A-8.
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6. The corporate FQDN, LAN addresses, domain names, and default 
gateway (if any) must be supplied by the corporate LAN administrator. 
See items 6 through 12 in the S3400 system planning form.  

� The IP address for any required DNS servers are on the corporate 
LAN and must be supplied by the corporate IP administrator. 

� The domain search order and any domain names must be supplied 
by the corporate LAN administrator in the order required.

7. The default system name for the private LAN, the associated IP 
addresses, and subnet masks (items 13 through 15 in the S3400 system 
planning form) are already specified and do not normally change. 

8. Complete the S3400 password table on page A-9 so you can supply the 
correct passwords for all required services and trusted servers on the 
MSS and MAS machines.

9. Complete the S3400 logon accounts form on page A-10 using the 
customer-provided account names and passwords required for this site.

10. Have the customer specify the messaging services that they want to 
install on each MAS machine using the MAS features list on page A-11.

11. Complete the Required switch and messaging information on page A-12 
with help from the relevant messaging or switch administrator. 

12. Complete the forms for Services logins and passwords on page A-13 
and PPP logins, passwords, and IP addresses on page A-13 with help 
from the customer and the entity responsible for providing ongoing 
services maintenance of the system.  

Note: It is strongly recommended that only static IP addresses be 
assigned to the interfaces and machines in an S3400 system.

IP addresses should be configured on the corporate DNS 
servers (if used) by LAN personnel in keeping with local policy 
and practices. Customers must also register the corporate 
FQDNs for the MSS and each MAS on any relevant corporate 
DNS servers.

Note: Keep a copy of the completed planning forms handy during initial 
administration and system configuration. Save your planning forms 
in a safe place when installation is complete in case changes or 
upgrades are made to the system. 

Be sure to file records of passwords and account names securely.
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Page 1 of 2

S3400 system planning form

# Item MSS MAS #1 MAS #2

1 Host name (machine or 
NetBIOS name)

2 Private fully qualified 
domain name (FQDN)

—USE MAS#1 NAME— —USE MAS#1 NAME—

3 Windows NetBIOS 
domain

—USE MAS#1 NAME— —USE MAS#1 NAME—

4 Voice mail domain —NOT USED—

5 Private FQDN for Eth1 —NOT USED—

6 Corporate domain 
name

7 Corporate FQDN for 
Eth0

8 Corporate IP address 
for Eth0

9 Corporate subnet mask 
for Eth0

10 Corporate default 
gateway IP address

11 Corporate DNS servers 
IP addresses 

12 Search order of DNS 
domains

13 Private system name mss1 mas1 mas2

14 Private IP address for 
Eth1

192.168.1.1 192.168.1.250 192.168.1.249

15 Private subnet mask for 
Eth1

255.255.255.0 255.255.255.0 255.255.255.0
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Page 2 of 2

S3400 system planning form (continued)

# Item MAS #3 MAS #4

1 Host name (machine or 
NetBIOS name)

2 Private fully qualified 
domain name (FQDN)

—USE MAS#1 NAME— —USE MAS#1 NAME—

3 Windows NetBIOS 
domain

—USE MAS#1 NAME— —USE MAS#1 NAME—

4 Voice mail domain

5 Private FQDN for Eth1

6 Corporate domain name

7 Corporate FQDN for 
Eth0

8 Corporate IP address 
for Eth0

9 Corporate subnet mask 
for Eth0

10 Corporate default 
gateway IP address

11 Corporate DNS servers 
IP addresses 

12 Search order of DNS 
domains

13 Private system name mas3 mas4

14 Private IP address for 
Eth1

192.168.1.248 192.168.1.247

15 Private subnet mask for 
Eth1

255.255.255.0 255.255.255.0
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The following planning form shows a completed example for a two MAS system. These sample values are 
used in this guide for illustration purposes. 

S3400 system planning form (completed example)

# Item MSS MAS #1 MAS #2

1 Host name (machine or 
NetBIOS name)

zigzag zippy zorro

2 Private fully qualified 
domain name (FQDN)

—USE MAS#1 NAME— zodiac.com —USE MAS#1 NAME—

3 Windows NetBIOS 
domain

—USE MAS#1 NAME— zodiac —USE MAS#1 NAME—

4 Voice mail domain —NOT USED— zebra zebra

5 Private FQDN for Eth1 —NOT USED— zippy.zodiac.com zorro.zodiac.com

6 Corporate domain name loc.avaya.com loc.avaya.com loc.avaya.com

7 Corporate FQDN for Eth0 zigzag.loc.avaya.com zippy.loc.avaya.com zorro.loc.avaya.com

8 Corporate IP address for 
Eth0

10.9.83.214 10.9.83.72 10.9.83.39

9 Corporate subnet mask 
for Eth0

255.255.255.0 255.255.255.0 255.255.255.0

10 Corporate default 
gateway IP address

10.9.83.254 10.9.83.254 10.9.83.254

11 Corporate DNS servers 
IP addresses 

10.9.1.39
10.9.1.2

10.9.1.39
10.9.1.2

10.9.1.39
10.9.1.2

12 Search order of DNS 
domains

loc.avaya.com 
avaya.com

loc.avaya.com 
avaya.com

loc.avaya.com 
avaya.com

13 Private system name mss1 mas1 mas2

14 Private IP address for 
Eth1

192.168.1.1 192.168.1.250 192.168.1.249

15 Private subnet mask for 
Eth1

255.255.255.0 255.255.255.0 255.255.255.0
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Account and password tables

Fill out the following tables with the customer to assign the passwords, account names, 
and login names at this site. 

 

S3400 password table

# Trusted server on MSS MSS calls this: MAS calls this: Password

P1 MAS #1 host name 
(NetBIOS name)

trusted-server 
MAS#1NAME

LDAP

P2 MAS #2 (if present) trusted-server 
MAS#2NAME

LDAP use MAS #1 password

P3 MAS #3 (if present) trusted-server 
MAS#3NAME

LDAP use MAS #1 password

P4 MAS #4 (if present) trusted-server 
MAS#4NAME

LDAP use MAS #1 password

P5 Message Waiting Indication 
(MWI) server

VVSTS IMAPI

P6 IMAP trusted server Imap4TS1 IMAP4

P7 Mailbox Manager (if 
installed)

mbmserver cn value for 
Connection settings

CAUTION: Passwords should be at least 8 characters long and not 
composed of easily guessed words or numeric 
combinations, including sequential or repeated numbers. For 
best security, use a combination of alphanumeric characters 
(case is not important for trusted-server passwords). At least 
one of the first 7 characters should be a symbol (such as a # 
sign or punctuation mark). 

Be sure to file records of passwords securely.

!
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Account logon names and passwords should be site-specific for security reasons. 

 

S3400 logon accounts form

# Account Logon name (should be 
customer specified) Password Used for

A1 Domain administrator 
account for
MAS#1 (required)

customer specified 
(for example, dom-admin)

Domain controller 
administration and 
system backups

A2 Local administrator 
account for 
MAS #2 (if present)

customer specified 
(for example, mas2-admin)

Local administration 
for this MAS

A3 Local administrator 
account for 
MAS #3 (if present)

customer specified 
(for example, mas3-admin)

Local administration 
for this MAS

A4 Local administrator 
account for 
MAS #4 (if present)

customer specified 
(for example, mas4-admin)

Local administration 
for this MAS

A5 Modular Messaging 
(MM) account

customer specified 
(for example, mmacct) 

MAS messaging 
services 
administration 

A6 Services account customer specified 
(for example, craft)

Services 
administration

A7 Customer account customer specified 
(for example, custacct)

Customer 
administration

A8 Safe mode 
administration 

Administrator SafeModeAdminPassword 
(set in answer.txt file)

Safe mode login 
used for system 
state restoration 

CAUTION: Passwords and account names on the MAS should be at 
least 8 characters long and not composed of easily guessed 
words or numeric combinations, including sequential or 
repeated numbers. For best security, use a combination of 
upper-case, lower-case, and alphanumeric characters. At 
least one of the first 7 characters should be a symbol (such 
as a # sign or punctuation mark), but not a % symbol.

Do not use the examples shown above as the actual account 
names; they are provided for example purposes only.

!
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MAS services and features

Fill out the following table with the customer to specify the messaging services to install 
on each MAS machine. Guidelines include: 

� If only one MAS is installed, all required services are installed on that 
machine. Check the services that the customer wants to install in the 
MAS#1 column. 

� If more than one MAS is installed:

— Install the Call Me Server and MWI Server software on the same 
MAS. These services must be co-resident with the Mailbox Monitor 
Service, and should be installed on the MAS with the smallest 
number of ports if possible, or the second smallest number of ports if 
the Tracing Server is installed.

— Install the Tracing Server on a different MAS than the one that is 
hosting the Call Me and/or MWI software. Always put the Tracing 
Server service on the MAS with the smallest number of ports, or on 
its own machine if possible.

 

* Specify the maximum number of concurrent sessions for each feature based on the 
customer’s expected usage. 

MAS features list

Messaging service to install
Max. # of 
concurrent
sessions:*

 on MAS#1  on MAS#2 on MAS#3  on MAS#4

Call Me Server 

Message Waiting Indicator (MWI) 
Server

(both use Mailbox Monitor Server 
and should be on same MAS)

Caller Applications Editor N/A

Fax Sender Server

Tracing Server N/A

Voice Server Prompt Files

Specify additional languages to 
install if needed; list the desired 
default language first.

Install the same set of languages 
on each MAS.

N/A
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Switch and messaging information 

Collect the required information from the relevant administrator prior to installation. 

CAUTION: You cannot install an S3400 system without obtaining the 
required configuration notes for your switch or PBX. See 
‘‘Required software and documentation‘‘ on page 2-5.

!

Required switch and messaging information

Item Value Notes

Extension numbers for the port boards on the 
MAS, and the switch ports to which they 
connect.
Note: Distribute the port board extensions 

over a number of switch boards if 
possible for greater reliability.

Use format: cabinet carrier slot 
port

Connects to extension 
number:

DID numbers used for:
• MM hunt group for messaging services:
• MSS alarm port number (RMB): 
• MAS dial-in number (modem):

Complete dial-in number

Extension number range for subscriber 
mailboxes in customer dial plan

Starting number Ending number

SMTP networking password used for 
messaging networking (optional feature)

—

Subscriber to act as PostMaster:
• subscriber’s extension number
• password (must be numeric)
• class of service (cos) to use

—

Fax mailbox extension number:
• password (must be numeric)
• complete company fax printer number
• class of service (cos) to use

—

Test subscriber information:
• extension number to test telephone
• password (must be numeric)
• class of service (cos) to use

—
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Services information 

Use the following table if you install new software in Appendix C, ‘‘Loading the 
operating system on an MSS.’’ 

Use the following table to record required customer- or services-provided information 
for establishing a remote access point-to-point (PPP) connection to the Services 
modem on the MSS. 

Other required Services information includes:

Product ID number:

Alarm destination telephone number:

Services logins and passwords

Login  Password

root

craft

tsc

craftppp

PPP logins, passwords, and IP addresses

Login  Password
Local IP address for PPP 
access through MSS modem 
(customer-provided)

Remote IP address for PPP 
access through remote modem 
(may be customer- or 
Services-provided)

sappp

craftppp

Login
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B
Installation checklist

Overview

The following checklist applies to the S3400 system installation. As you 
complete a procedure, make a check mark in the “ ” column.

S3400 system installation checklist 

Task Description Comments

Complete preinstallation planning:

1. Complete the planning forms in Appendix A. See the LAN, messaging, and 
switch administrators as needed. 
Requires customer input.

2. Obtain virus-checking software for the MAS. Customer obtains and installs if 
required for this site. 

3. Arrange for administration of the LAN for the S3400 system. 
Some LANs may be administered in advance; others require 
that new machine administration be done at the time of 
installation.
Note: Avaya Inc. is not responsible for the installation, 
administration, or test of communications between customer 
PCs and the LAN. 

See the LAN administrator.

4. Verify that the switch is administered. See the switch administrator.

5. Review preinstallation site requirements, including:
• environmental requirements
• weight and space requirements
• installation area requirements
• power and grounding requirements

6. Review demarcation points.

 (1 of 4)
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7. Review security issues.

Gather tools and documentation:

8. Gather the necessary tools and test equipment.

9. Assemble the required documentation. CD and web access is required.

Install the hardware:

10. Unpack the S3400 system and peripheral components. Open boxes as instructed to 
reuse packing materials.

11. Assemble and identify the system components.

12. Attach mounting brackets and handles to UPS and any EBM 
units as needed, then cable the units together.

A UPS is optional for an MSS-S, 
but required for an MSS-H; 
EBMs are always optional.

13. Attach the front bezel to each MSS or MAS unit. 

14. Attach rails for rack-mount or rubber spacers for stackable 
configuration to each MSS or MAS unit.

15. Connect the S3400 system power cables.

16. Connect the MAS port boards to the switch or PBX. See the Dialogic documentation.

17. Assemble the KVM switch. Steps include:
• Attach mounting brackets to KVM switch (if needed).
• Connect KVM switch to the monitor and keyboard/mouse.

Procedure varies depending on 
type of KVM switch purchased.

18. Connect the KVM switch to each MSS and MAS unit.

19. Connect each MSS and MAS unit to the Ethernet switch 
(private LAN) and to the corporate LAN.

20. Attach ferrites to the required video and QSIG cables.

21. Set up the external modem for each MAS unit.

22. Connect the RMB (and its external modem if required) to the 
MSS and the switch.

Do initial MSS administration:

23. Power up the S3400 system and peripheral components.

24. Log in to the MSS unit.

25. Adjust the monitor settings if needed.

26. Set the date and time on the system.

27. Set up network addressing on the private and corporate LANs.

S3400 system installation checklist 

Task Description Comments

 (2 of 4)
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28. Administer the message core including:
• Set up the MSS host machine profile.
• Set up all required MAS and MWI trusted servers.

Requires information from LAN 
and messaging administrators 
(use the planning forms).

29. Reboot the MSS.

Do initial MAS administration:

30. Switch the monitor to show the correct MAS.

31. Install the hard disk image from the boot image CD. Do only if new CDs are provided.

32. Login as the known administrator.

33. Install new hardware if found. Complete wizards as prompted.

34. Set up regional settings, time and date.

35. Change administrator account name and password. Use your planning forms.

36. Change the machine name. Use the S3400 system planning 
form.

37. Set up the corporate LAN interface.

38. Set up the private LAN interface.

39. Test the IP addresses on the private network using ping.

40. Test IP addresses on the corporate network using ping. Optional but recommended.

41. Set up the first MAS as the domain controller. Do this on MAS#1 only.

42. Create user accounts and add them to groups. Do this on MAS#1 only.

43. Add an MAS to the Windows domain. Do this on each additional MAS.

44. Set up remote access on each MAS.

45. Add all MAS units to the remote access group. Do this on MAS#1 only.

46. Update the Modular Messaging account settings.

47. Synchronize the MAS time and date with the MSS. 

48. Configure and test the port boards. Configuration notes required.

49. Set up MAS messaging service.

50. Install additional MAS messaging service software as needed.

51. Configure the MAS for the PBX. Configuration notes required.

52. Start MAS messaging services.

S3400 system installation checklist 

Task Description Comments

 (3 of 4)
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53. Administer each additional MAS. Repeat Chapter 4 as needed.

54. Install virus-checking software on every MAS. Customer obtains and installs if 
required for this site. 

Complete initial administration: Do these tasks on the MSS 
unless otherwise noted.

55. Verify customer option settings.

56. Administer Internet messaging.

57. Update MAS host information and test using ping.

58. Place the MSS in the Windows domain.

59. Modify classes of service for special mailboxes.

60. Set up the PostMaster and fax mailboxes.

61. Administer a test subscriber.

62. Perform acceptance tests. These include:
• Creating and receiving test messages in both integrated 

and nonintegrated mode
• Creating and printing faxes (if fax service is installed)
• Testing system outcalling using Subscriber Options

63. Remove the test subscriber.

64. Set up remote access on the MSS, including:
• Administering PPP logins and passwords
• Activating the modem
• Setting up the PPP server configuration
• Activating alarm origination 

65. Administer digital networking. Optional - do if required.

66. Set up Mailbox Manager for the administrator. Do this on the MAS or another 
PC as directed.

67. Schedule unattended backups and perform an attended 
backup on every MAS.

Do this on each MAS.

68. Perform an attended backup on the MSS.

69. Set up unattended backups on the MSS.

70. Save the planning forms in a safe place.

S3400 system installation checklist 

Task Description Comments

 (4 of 4)
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C
Loading the operating system on an

MSS

Overview

This appendix describes how to load operating system software on a Message Storage 
Server (MSS). This procedure may be used to install new software on a new system, or 
to put the operating system on the hard disk if the system suffered a catastrophic disk 
failure and the hard disks all had to be replaced. 

The new MSS software is provided on a CD-ROM. 

Loading new MSS software

To copy new software to the MSS:

1. The KVM switch should be connected to the MSS through the first 
computer port (VGA 01). Verify that the monitor is showing the MSS boot 
procedure.

� If the monitor is not showing the correct server boot procedure, 
see ‘‘Connecting the KVM cables‘‘ on page 2-26 and verify the 
cable connections. To correct cabling problems, power down the 
system correct the cabling, then power up the system again. 

� For a Belkin OmniView Pro2 KVM: To have the monitor show a 
different server, press slowly in sequence Scroll Lock, then Scroll 
Lock, then the up (or down) arrow key to change to the server 
connected to a higher or lower port number. 

You can alternatively type the port number instead of pressing the 
up or down arrow key (such as 02 for port 2). See your KVM 
switch documentation for complete user instructions.
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2. Insert the software boot CD into the MSS’s DVD drive. 

� For a picture of the MSS-S, see Figure 2-5 on page 2-12.

� For a picture of the MSS-H, see Figure 2-7 on page 2-14.

3. To reboot the system, press Ctrl + Alt + Del.

The machine begins to boot, then displays the following options:

To install on a “standard availability” platform,
type: standard <ENTER>.
To install on a “high availability” platform, type:
high <ENTER>.
To reboot, remove the CD and press the
<Ctrl><Alt><Delete> keys.

4. Type the word for the model of MSS that you installed and press Enter:

� Type standard for the MSS-S (no drive handles on the front).

� Type high for the MSS-H (has drive handles on the front). 

The system takes about 20 minutes to copy the software. 

When the copy is finished, you are prompted to remove the CD from the 
drive as follows:

Please, remove the Install CD from the CD drive, and
press <ENTER>.

5. Remove the software CD from the MSS’s DVD drive. 

6. When the CD is removed, press Enter to reboot the system.

7. At the Avaya Messaging welcome screen, press Enter to select OK.

The server displays the Time Date Selection screen. 

8. Set the time and date as follows:

a. Use the up or down arrow keys to highlight your time zone.

b. Press Tab to move to the New Time section.

Note: Make sure that the CD is seated solidly between the plastic 
clips.

Note: Do not leave the CD in the drive, or the system will boot from it.
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c. Enter the current time in hh:mm (hours and minutes) format, based on a 
24-hour clock.

d. Press Tab to move to the New Date section.

e. Enter the current time in mm:dd:yy (month, day, and year) format, such as 
04/21/03 for April 21, 2003.

f. Make sure an asterisk (*) appears in the Set hardware clock to GMT box. If 
not, press the space bar to add one.

g. Press Tab to move to the OK field, then press Enter.

9. When prompted to log in, type root and press Enter.

10. Put the MSS software CD back in the DVD drive. 

11. At the # prompt, type autoinstall and press Enter.

12. When prompted to continue or quit, press Enter to continue.

13. You are prompted to change several passwords. 

� Enter the passwords you are provided for the following logins: 
root, craft, tsc, and craftppp. See Services logins and 
passwords on page A-13.

� It is okay to ignore any warnings that the passwords are too short.

When the autoinstall program completes, you are prompted to remove 
the MSS software CD from the drive as follows:

Please remove the Installation CD from the CD drive
and press <ENTER>.

14. Remove the software CD from the MSS’s DVD drive. 

15. When the CD is removed, press Enter to reboot the system.

16. Continue with step 2 in ‘‘Logging in to the MSS server‘‘ on page 3-3.

Note: Wait for the drive’s light to stop flashing before you proceed.

CAUTION: Do not leave the CD in the drive. If the system reboots from 
the CD, you must remove the CD and press Ctrl + Alt + Del 
when you see the menu listed in step 3. If you fail to do this 
and enter the machine type again, all your data will be 
erased, and you will have to install the software again.

!
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D
Loading the operating system on an

MAS

Overview

This appendix describes how to load operating system software on a Messaging 
Application Server (MAS). This procedure may be used to install new software on a 
new system, or to put the operating system on the hard disk if the system suffered a 
catastrophic disk failure and an MAS hard disk had to be replaced. 

The new MAS software is provided on two CD-ROMs. 

Loading new MAS software

To copy new software to the MAS:

1. The KVM switch should be connected to the MAS through one of the 
computer ports (such as VGA 02). Verify that the monitor is showing the 
MAS boot procedure.

� If the monitor is not showing the correct server boot procedure, 
see ‘‘Connecting the KVM cables‘‘ on page 2-26 and verify the 
cable connections. To correct cabling problems, power down the 
system correct the cabling, then power up the system again. 

� For a Belkin OmniView Pro2 KVM: To have the monitor show a 
different server, press slowly in sequence Scroll Lock, then Scroll 
Lock, then the up (or down) arrow key to change to the server 
connected to a higher or lower port number. 

You can alternatively type the port number instead of pressing the 
up or down arrow key (such as 02 for port 2). See your KVM 
switch documentation for complete user instructions.
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2. Insert the first boot-image CD into the MAS’s CD drive. See Figure 2-9 
on page 2-16 if needed.

3. Press Ctrl + Alt + Del to reboot the system.

a. On the Windows Security window, click Shut Down...

b. On the Shut Down Windows screen, select Restart and click OK.

The machine begins to boot from the CD.

� The CD image begins to copy to the MAS hard disk.

� If you are prompted to Cancel, click Yes. This message only appears 
if you skipped the RAM test, which you should not do. Reload the 
software starting with step 3. 

4. About 70% through completion (up to 10 minutes), you are prompted to 
“Insert media 2.” 

� Remove the first boot-image CD, and place the second CD in the 
drive. 

� Wait for the CD to spin up, then press OK. 

The entire copy procedure may take over 20 minutes. The system will 
reboot automatically on completion. When the reboot completes, a 
splash screen appears.

5. Remove the second boot CD from the drive.

6. On the Windows 2000 Server Setup screen, type the Windows product 
key for this MAS (each unit has a unique product key).

This number must be entered exactly as shown. It is located on a sticker 
or tag on the side or rear of each MAS machine. 

7. Click Next.

8. When the Licensing Modes screen appears, just wait. The installation 
should complete automatically from this point on. When finished, it 
automatically restarts the machine.

A splash screen appears as the system reboots.

Note: If you are installing an additional MAS, you see an error 
message about an IP address conflict with another system on 
the network. Press OK to ignore the message. This error 
persists until a unique IP address is assigned to the new MAS.

CAUTION: Do not touch the keyboard once the system begins to boot, 
or the software will not install properly.!
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9. When the boot completes, press Ctrl+Alt+Del to log on as follows:

a. On the Log On to Windows screen, verify that the logon name is 
VSSystemAdmin.

b. Enter this password exactly as shown: 3825_STul 

c. Press Enter or click OK. 

10. A Found New Hardware wizard appears for all new devices installed in 
the system (such as the Dialogic port boards). Follow the prompts to 
complete each wizard. 

The hardware wizard appears once for every Dialogic port board 
installed in the system. Disable the Dialogic hardware for now as follows:

a. On the Welcome screen, click Next. 

b. On the Install Hardware Device Drivers screen, accept the default option 
(Search for a suitable driver) and click Next.

c. On the Locate Driver Files screen:

(1) Clear the checkbox for “Specify a location.”

(2) Check the box for “CD-ROM drives.” Click Next.

d. On the Driver Files Search Results screen, make sure that “Disable the 
device” is selected. Click Finish.

e. Repeat steps a through d for each repetition of the wizard.

11. If a modem is already attached, a Digital Signature Not Found wizard 
pops up. Click Yes to install the driver and continue the installation. 

12. After the wizards run, continue with ‘‘Setting up regional settings, date, 
and time‘‘ on page 4-4.

Note: If you are installing an additional MAS, you see an error 
message about an IP address conflict with another system on 
the network. Press OK to ignore the message. 

Note: If the wizard comes up in a tiny window, press Esc to cancel 
this wizard (subsequent wizards should run in a normal-sized 
window). The skipped wizard will reappear the next time the 
system restarts; run it then.

Note: After your next reboot, you may see a Found New Hardware 
wizard reporting a USB device error. Click Finish to continue.
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E
Creating a new tone file

Overview

This appendix describes how to build a tone file for analog port boards by using the 
PBXpert utility to learn PBX tones. 

This procedure must be done after the port boards are administered on the switch, but 
before you configure them using the Dialogic Configuration Manager (see ‘‘Configuring 
analog port boards‘‘ on page 4-28). 

You can use PBXpert either automatically or manually to learn the call progress tones 
for your PBX and store them in a Tone Set File (TSF). Many tone sets can be stored in 
a single TSF file. 

� Automatic Learning: PBXpert uses two different channels on the Dialogic 
voice board to set up tones and learn the resulting call progress tones 
automatically. See Learning tones automatically on page E-2.

� Manual Learning: PBXpert uses one channel on the Dialogic voice board 
and a telephone to set up tones and learn the resulting call progress 
tones manually. PBXpert prompts you how and when to use the 
telephone. See Learning tones manually on page E-7.  

Note: If only one line is connected to the Dialogic voice board, you 
must use Manual Learning.

CAUTION: Use the configuration notes to administer the port boards for 
your particular PBX or switch integration. See ‘‘Required 
software and documentation‘‘ on page 2-5 for instructions on 
obtaining the configuration notes. The port boards must be 
administered on the switch before you can proceed.

!
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Learning tones automatically

This section describes the following procedures:

� Running the PBXpert wizard on page E-2 

� Consolidating and saving the TSF file on page E-6

� Using the new TSF in Dialogic Configuration Manager on page E-6

Running the PBXpert wizard

The PBXpert wizard guides you through learning the tones used by your PBX and 
saving the information as a TSF file. PBXpert can learn the following tones: 

� Dial tone

� Ringback

� Busy

� Reorder (fast busy)

� Disconnect

To run the PBXpert wizard: 

1. Start the Dialogic voice cards. 

a. You should have already started the Dialogic Configuration Manager. See 
steps 2 through 4 in ‘‘Configuring analog port boards‘‘ on page 4-28. 

b. Click the green Start Service button on the button bar. 

The installed boards show a green light when service is started, and 
the Stop Service button becomes active.

2. Click Start > Programs > Dialogic System Software > PBXpert.

The PBXpert main window appears (see Figure E-1 on page E-3). Most 
fields are blank until tones are learned.

� If you are using PBXpert for the first time after installation, the 
PBXpert wizard starts automatically.
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� If the PBXpert wizard does not start automatically, click Tones > Tone 
Wizard.  

Complete the PBXpert wizard screens as follows: 

1. When the PBXpert Wizard Welcome screen appears, click Next. 

2. On the PBX Information page:

� Under PBX, enter the name of the manufacturer (such as Mitel) and 
the model of the PBX (such as SX-2000).

� You can use the automatically created Tone Set File name as it 
appears, or alter it as desired.

� Click Next.

3. On the TAPI Information page, just use the default values. Click Next.

Note: You can change the default settings in the wizard if you are 
familiar with your PBX environment and the Dialogic API. Any 
settings that you change are saved when you exit PBXpert. For 
help on a particular screen, click the Help button in the wizard.

Figure E-1. PBXpert main window
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4. On the Select a Board screen:

� Select the Dialogic board to use.

� Click Next.

5. On the Select the Calling Resource screen, for the Line A Calling 
Channel: 

� For “Select the Channel,” enter the port number or channel to use.

� For “Phone Number,” enter the extension number of this port. See 
Required switch and messaging information on page A-12 for port 
board extensions.

� Click Next.

6. On the Select the Calling Resource screen, for the Line B Called 
Channel: 

� For “Select the Channel,” enter a different port number or channel to 
use.

� For “Phone Number,” enter the extension number of this port. 

� Click Next.

7. On the Settings Confirmation screen:

� Verify your settings. Click Back if you need to change anything.

� Make sure that the Run Wizard Auto-Test box is checked.

� Click Next.

8. The Auto Line Test window appears while PBXpert verifies the 
connection between the two specified channels. 

� If you see a “Test finished successfully!” message, click OK to close 
this window and proceed.

� If the line test fails, click OK to close this window. Click Back on the 
wizard, adjust your settings, and try the test again.

9. On the Learn Tones screen, click Next to begin learning tones 
automatically.

The Learn Tones window appears. See Figure E-2 on page E-5.  

Note: You can click Cancel at any time during the test to stop 
automated learning.
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10. When PBXpert completes learning, buttons appear allowing you to keep 
or discard the data.

� If the tones were learned without errors, select Keep Data. The 
Learn Tones window closes and you can proceed.

� If errors occurred, select Discard Data. The window closes. Click 
Back on the wizard, adjust your settings, and try to learn the tones 
again. You cannot test or save the tone file if it contains errors. 

11. On the Verifying the Learn screen, click Next to test the learned tones.

� If the test succeeds, click OK to close the test window and proceed.

� OK to close this window. Click Back on the wizard, adjust your 
settings, and try the test again. 

12. The Summary of Results page shows the final wizard status and tone 
definitions. Click Finish.

Tone definitions are displayed in the main window (see Figure E-3 on 
page E-6). 

Figure E-2. Learn Tones window (learning in progress)
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Consolidating and saving the TSF file

You must consolidate and save the new TSF file so that you can use it with the Dialogic 
voice driver. To do this:

1. Click Tones > Consolidate.

2. When finished, click File > Save to save the new TSF file.

a. On the Save As screen, use the default DATA directory. 

b. Specify a file name with file type of TSF (such as Mitel-SX-2000.tsf).

Using the new TSF in Dialogic Configuration Manager

To use the new TSF that you just created: 

1. Return to the Dialogic Configuration Manager window.

2. Click the red Stop Service button on the button bar.

Figure E-3. Sample tone definitions in main window 
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3. Return to step 5 in ‘‘Configuring analog port boards‘‘ on page 4-28 and 
complete board configuration and testing.

Learning tones manually

This section describes the following procedures:

� Running PBXpert on page E-7 

� Adding a new tone set on page E-8 

� Learning tone definitions on page E-8 

� Testing the tone set on page E-10

� Consolidating and saving the TSF file on page E-10 

� Using the new TSF in Dialogic Configuration Manager on page E-10 

Running PBXpert

To run PBXpert manually: 

1. Start the Dialogic voice cards. 

a. You should have already started the Dialogic Configuration Manager. See 
steps 2 through 4 in ‘‘Configuring analog port boards‘‘ on page 4-28. 

b. Click the green Start Service button on the button bar. 

The installed boards show a green light when service is started, and 
the Stop Service button becomes active.

2. Click Start > Programs > Dialogic System Software > PBXpert.

The PBXpert main window appears (see Figure E-1 on page E-3). Most 
fields are blank until tones are learned.

3. If you are using PBXpert for the first time after installation, the PBXpert 
wizard starts automatically. If the PBXpert32 Wizard starts, check the 
“Don’t run wizard at startup” checkbox and click the Cancel button.

A new, empty TSF is now active.

4. In the PBXpert main window, click Settings on the button bar.
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5. In the Settings window:

a. For Line A, enter the Board Number (such as 1) and the Channel 
Number or port number.

b. The Manual mode checkbox should be checked.

c. For Line B, for Phone Number, enter extension for this port or channel. 
See Required switch and messaging information on page A-12 for port 
board extensions

You can use the default values for all the other fields on this screen. 
Click Help for more information if needed.

d. Click OK.

Adding a new tone set

To add a new tone set to a TSF:

1. From the PBXpert main window, click Edit > New Tone Set.

2. In the New Tone Set window:

a. Enter the PBX Manufacturer (such as Mitel) and Model name (such as 
SX-2000).

b. Click OK.

The PBXpert main window shows the manufacturer and model names 
you entered. The tone definitions are set to zero.

Learning tone definitions

To add tone definitions to the new tone set:

1. From the PBXpert main window, click Tones > Learn.

2. On the Start Learn window:

a. Select the tones for the Dialogic cards to learn (the default is all tones). 

b. Click Start Learn to have PBXpert start learning tones.

Note: If you are familiar with your PBX environment and the 
Dialogic API, you can change these default settings. Any 
settings that you change are saved when you exit PBXpert.
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The Learn Tones window appears (see Figure E-4 on page E-9). 

3. You are prompted to listen for ringing, and to pick up or replace the 
telephone handset during the test. When the message box pops up, do 
the requested action, then click OK. 

4. When the learning process has finished, tone definitions appear in the 
Learn window. Keep or discard the data as follows:

� If the tones were learned without errors, select Keep Data. The 
Learn Tones window closes and you can proceed.

� If errors occurred, select Discard Data. The window closes. Click 
Back on the wizard, adjust your settings, and try to learn the tones 
again. You cannot test or save the tone file if it contains errors. 

The Learn window closes. The new tone definitions appear in the 
PBXpert main window. See Figure E-3 on page E-6 for an example. 

Note: Click Cancel at any time to stop learning.

Figure E-4. Learn Tones window (learning complete)
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Testing the tone set

The Test function checks that the consolidated tone set in the active TSF works 
correctly with the Perfect Call call-progress analysis utility. 

To test the newly learned tones:

1. In the main PBXpert window, Tones > Test.

2. A Test window appears. 

When testing is complete, test results are displayed in the Test window.

3. Check that the tone definitions of the learned tones are correct.

Consolidating and saving the TSF file

You must consolidate and save the new TSF file so that you can use it with the Dialogic 
voice driver. To do this:

1. Click Tones > Consolidate.

2. When finished, click File > Save to save the new TSF file.

a. On the Save As screen, use the default DATA directory. 

b. Specify a file name with file type of TSF (such as Mitel-SX-2000.tsf).

Using the new TSF in Dialogic Configuration Manager

To use the new TSF that you just created: 

1. Return to the Dialogic Configuration Manager window.

2. Click the red Stop Service button on the button bar.

3. Return to step 5 in ‘‘Configuring analog port boards‘‘ on page 4-28 and 
complete board configuration and testing.
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F
Recovering from a catastrophic disk

failure

Overview

This appendix summarizes the procedure for restoring an MAS machine if the hard disk 
drive failed and had to be replaced. The procedures are slightly different if you are 
restoring the first MAS in the system, or a subsequent MAS. 
 

To recover from a catastrophic disk failure, you will need:

� Avaya™ Modular Messaging (MM) Release 1.0 for the Messaging 
Application Server (MAS) software, Issue 1 or later, ED75011-10G15 
(two CDs).

� This guide and other required documentation for system installation. See 
‘‘Required software and documentation‘‘ on page 2-5 for a complete list.

� A copy of the completed planning forms, which should be on file. See 
Appendix A, ‘‘System planning forms.’’ 

Note: Make sure that the planning forms are accurate and up-to-date. 
When you restore the MAS machine, you must duplicate exactly 
the information from your original setup (machine names, domain 
names, passwords, and so on) to avoid problems.

CAUTION: This procedure is only valid for the following cases:
• The first MAS was damaged and there is no other MAS in 

the domain. 
• A subsequent MAS was damaged but the first MAS is 

fine.
All other failure cases must be escalated at this time.

!
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Recovery procedure

To restore an MAS system following a catastrophic disk failure:

1. The faulty drive must be replaced and the system powered back up. See 
“IDE drive replacement” on the documentation CD for these steps.

2. Install the operating system on the new disk drive. Follow the steps in 
Appendix D, ‘‘Loading the operating system on an MAS.’’

3. Continue restoring the system depending on the MAS as follows:

� If you are restoring the first MAS: Continue with ‘‘Restoring the first 
MAS‘‘ on page F-2.

� If you are restoring a subsequent MAS: Continue with ‘‘Restoring a 
subsequent MAS‘‘ on page F-3.

Restoring the first MAS

To restore the first MAS (which is also the domain controller):

1. Follow the steps in Chapter 4, ‘‘Administering the MAS,’’ from ‘‘Setting 
up regional settings, date, and time‘‘ on page 4-4, through ‘‘Setting up 
the MAS messaging services‘‘ on page 4-37. 

2. In the section ‘‘Setting up MAS messaging service‘‘ on page 4-37, for 
step 3 (the Voice Mail Domain Selection screen), you must select the 
radio button for “Subsequent server in an existing voice mail domain.”

3. Complete the rest of Chapter 4, ‘‘Administering the MAS.’’ 

4. On the MSS machine, repeat the procedure for ‘‘Placing the MSS in the 
Windows domain‘‘ on page 5-6.

5. Continue with restoring the first MAS as follows:

� If this MAS is the only MAS in the system, continue with ‘‘Completing 
system restoration on every MAS‘‘ on page F-4.

� If any additional MASs are in the system, continue with step 6.

CAUTION: The procedure for restoring the first MAS to service after a 
disk failure is slightly different from the procedure listed in 
‘‘Setting up MAS messaging service‘‘ on page 4-37. Follow 
the instructions below exactly to restore the first MAS. 

!

mdide.htm
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6. Log in to each subsequent MAS as the local administrator as follows:

a. On each additional MAS, click Start > Log off admin-account.

b. On the Log Off Windows screen, click Yes.

c. Press Ctrl+Alt+Del to log on.

d. On the Log On to Windows screen, change the User name to the Local 
Administrator account name for this MAS (such as mas2-admin). See 
items A2 through A4 on the ‘‘S3400 logon accounts form‘‘ on page A-10.

e. Enter the password for this account. 

f. Log on to the machine name for this MAS (for example, zorro). See item 1 
on the ‘‘S3400 system planning form‘‘ on page A-6.

g. Press Enter or click OK.

7. Now make this MAS a member of a workgroup as follows:

a. Right-click My Computer and select Properties.

b. On the System Properties window, click the Network Identification tab.

c. Click the Properties button. The Identification Changes window appears.

d. Click the Member of Workgroup radio button. 

e. Name the workgroup (WORKGROUP is okay) and click OK.

f. Click OK to close the System Properties screen.

g. Reboot the system when prompted.

8. Log back in as the local machine administrator (the same account you 
used in step 6).

9. Do the section ‘‘Adding an MAS to the Windows domain‘‘ on page 4-18 
to join the existing Windows domain (such as zodiac).

10. Repeat steps 6 through 9 for every additional MAS in the system.

11. To complete the system restoration, continue with ‘‘Completing system 
restoration on every MAS‘‘ on page F-4.

Restoring a subsequent MAS

To restore the second, third, or fourth MAS in a multiple-MAS system:

1. Follow the steps in Chapter 4, ‘‘Administering the MAS,’’ from ‘‘Setting 
up regional settings, date, and time‘‘ on page 4-4, through ‘‘Configuring 
and testing the port boards‘‘ on page 4-27.

2. Before you begin the section ‘‘Setting up MAS messaging service‘‘ on 
page 4-37, delete the old account for this machine as follows:
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a. Double-click the Configure icon on the desktop.

b. In the left-hand pane of the Configure window, expand the Active 
Directory Users and Computers directory.

c. Expand the Computers directory.

d. Locate the name of the MAS machine that had the failed drive (the 
machine that you are now restoring).

e. Right-click this machine name and select Delete.

f. Close the Configure window. 

3. Continue with the section ‘‘Setting up MAS messaging service‘‘ on page 
4-37 and complete the steps as documented.

4. Complete the rest of Chapter 4, ‘‘Administering the MAS.’’ 

5. To complete the system restoration, continue with ‘‘Completing system 
restoration on every MAS‘‘ on page F-4.

Completing system restoration on every MAS

To complete restoring the system for any MAS: 

1. Reinstall any previously installed patches on this MAS.

2. Restore data files from backup including spooled messages, customized 
caller applications and prompts, and the hosts file. 
 

a. Run the Restore Wizard as described in “Restoring backed-up MAS data 
(after a non-catastrophic failure)” on the documentation CD. 

b. Restore the following:

� hosts file

� CABACKUP folder (contains Caller Applications)

� Spool directory

� custom prompt files (if they have been changed by the customer) 

CAUTION: You must delete the old account for this MAS before you 
begin ‘‘Setting up MAS messaging service‘‘ on page 4-37. !

Note: Do not restore the System State.

CAUTION: Do not restore the System State following a catastrophic disk 
failure.!

AG_MAS_br_4.htm
AG_MAS_br_4.htm
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c. Complete the restoration wizard as directed.

3. To complete the restoration of Caller Applications, do the following:

a. Click Start > Run to open a Command prompt window.

b. In the Run box, type the following in the Open field and press Enter:

C:\Avaya_Support\CMD\CARestore.bat 

4. As a precaution, preserve a copy of the existing backup file as follows:

a. Click Start > Run. In the Open field, type \\mss1\masbackup 

You are prompted for an account name and password.

b. In the Connect As window, use the domain administrator account name 
(for example, dom-admin) and password. See item A1 on the ‘‘S3400 
logon accounts form‘‘ on page A-9. Click OK.

Windows Explorer will launch.

c. Locate the backup file for the MAS that you are restoring (such as 
ZIPPYDailyBackup.bkf, where ZIPPY is the host name of this MAS). 
Right-click the file name and select Rename.

d. Type a new name for this backup file (such as OldZIPPYDailyBackup.bkf) 
and press Enter.

5. Do ‘‘Performing acceptance tests‘‘ on page 5-10.

6. Reinstall other software if required.

a. If Mailbox Manager was installed on this MAS, reinstall it as directed in 
‘‘Setting up Mailbox Manager‘‘ on page 5-19. 

b. Reinstall any other software that was previously installed on this MAS (for 
example, virus-checking software).

7. When you are satisfied that the system is running correctly, do the 
‘‘Backing up the system‘‘ on page 5-22 procedure for the MAS that you 
just restored. 

Note: This step works only on Release 1 systems after installing 
RFU1.01. Without this patch, the Caller Applications files could 
be lost unless they were backed up in another way.

Note: If you restored the first MAS, when you repeat the procedure 
for ‘‘Setting up and running backups on every MAS‘‘ on page 
5-22, you need to re-enter the domain-administrator account 
and password for every MAS in the system to schedule 
backups again.
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documentation needed, 2-5
Ethernet switch, 2-29, 2-31
ferrites, 2-31
front bezel, 2-18
hardware list, 2-3 to 2-4
KVM switch, 2-25 to 2-26, 2-28
packing materials, 2-6
port board cables, 2-24
port boards, 2-4, 4-27
power cables, 2-22
required software, 2-5
RMB, 2-34 to 2-35
S3400 servers, 2-12, 2-18 to 2-19, 2-21 to 2-22
sample installed system, 2-6, 2-21
unpacking the hardware, 2-3 to 2-4
UPS and EBMs, 2-8
USB modem, 2-32, 4-20

help using the system, xi
host information for MAS machines, 5-4
host machine profile setup, 3-11
host name, 4-6, A-2
how to use this book, x
humidity requirements, 1-2
hunt group for messaging services, A-12
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I
IMAP trusted server setup, 3-14
inband integration, 4-44
initial administration for PBX/switch and LAN, 1-6, A-5
initial MSS administration

logging in, 3-3
message core administration, 3-10
monitor setup, 3-4
MSS host machine profile, 3-11
MSS trusted servers, 3-12 to 3-13
network addressing, 3-6
reboot MSS, 3-14
set time and date, 3-5

Install Modem/Terminal Software screen, 5-16
installation

administering the MAS, 4-1
checklist, B-1
completing initial administration, 5-1
creating a new tone file, E-1
hardware installation, 2-1
initial MSS administration, 3-1
load new operating system, C-1, D-1
planning forms, A-1
powering up the system, 3-1 to 3-2
site requirements, 1-1

installing additional MAS messaging software, 4-39, 
A-11
integrated mode test, 5-10
intended audience, ix
Internet messaging on MSS, 5-3
Internet Protocol (TCP/IP) Properties window, 4-7, 4-10
IP address, A-2
IP address administration, 3-6, 4-7, 4-22, 5-16, A-4 to 
A-5
IP gateway, A-3

J
joining a domain, 4-18, 4-37 to 4-38, 5-6

K
key components

MAS, 2-16
MSS-H, 2-14
MSS-S, 2-12

keyboard, monitor and mouse setup, see KVM switch
known administrator, 4-3
KVM switch

installation, 2-25 to 2-26, 2-28
showing the correct server, 3-3, 4-3

L
LAN

administration, 3-6, 4-7
demarcation points, 1-7
initial administration, A-5
terminology, A-2

languages, A-11
Learn Tones window, E-4, E-9
learning tones, E-1 to E-2, E-7
Linux Date and Time screen, 3-5
loading new MAS software, D-1
loading new MSS software, C-1
local administrator account, 4-5, A-10
Local Area Connection, 4-7, A-2
locales, 4-4
logging in

to MAS server, 4-3
to MSS server, 3-3

logon accounts, A-10

M
machine name, 4-6
Machine Profile screen, 3-11, 5-18
Mailbox Manager (MBM) package, see MBM, 5-19
Mailbox Monitor Server, 4-39, A-11
Manage Classes-of-Service screen, 5-7
Manage Local Subscribers screen, 5-7, 5-9, 5-14
MAS

key components, 2-16
trusted server setup, 3-12 to 3-13

MAS administration
access permissions, 4-43
assigning IP addresses, 4-7
back up data, 5-22
changing the administrator account name and 
password, 4-5
changing the machine name, 4-6
configuring port boards, 4-26
configuring the voice mail system, 4-40
creating user accounts on first MAS, 4-16
installing additional software, 4-39
load new software, D-1
logging in, 4-3
Modular Messaging account settings, 4-25
overview, 4-1 to 4-2
regional settings, date, and time, 4-4
scheduling backups, 5-22
setting up first MAS as domain controller, 4-14 to 
4-15
setting up messaging services, 4-37
setting up remote access, 4-20
showing the correct server, 4-3
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subsequent MAS, 4-11 to 4-12, 4-18, 4-24 to 
4-25, 4-37 to 4-38, 4-44, 4-46, 5-22, 5-24, D-2
synchronize time with MSS, 4-26
testing IP addresses, 4-12
testing port boards, 4-35
updating host information on MSS, 5-4

MAS Host Information Setup screen, 5-4
MAS services and features, A-11
maximum number of concurrent sessions, A-11
MBM

installing, 5-19
required audit, 5-19
test subscribers, 5-20 to 5-21
trusted server, 5-19

Message Networking Server, 5-18
Message Servers - Voice Mail Domain window, 4-43
Message Storage Server High-availability configuration, 
see MSS-H
Message Storage Server Standard configuration, see 
MSS-S
Message Waiting Indicator - Voice Mail Domain 
window, 4-41
Message Waiting Indicator (MWI) Server, 4-39, 4-41, 
A-11
Message Waiting Indicator, see MWI
messaging administration on MSS, 3-10
Messaging Application Server - Configuration 
Wizard, 4-37
Messaging Application Server Credentials, 4-38, 4-43
Messaging Application Server, see MAS
messaging service recovery procedures, 4-45
messaging services setup, 4-37
messaging services to install, A-11
MM Messaging Application Server, 4-25, 4-40, 4-44
MM Messaging Application Server Properties (Local 
Computer) window, 4-25
mmacct, see Modular Messaging account, 4-16
modem configuration, 4-21
modem installation, 2-32, 2-34 to 2-35, 4-20
Modular Messaging account, A-10

creating, 4-16
logging in, 4-17, 4-19
settings, 4-25

Modular Messaging Installation wizard, 4-39
monitor

display quality, 3-4
setup, 3-4
showing the correct server, 3-3, 4-3

monitor and keyboard/mouse setup, see KVM switch.
Monitor icon, 4-14, 4-20, 4-25, 4-40, 4-45, 5-10
monitor messaging service startup, 4-40, 4-44

MSS
adding to Windows domain, 5-6
administering Internet messaging, 5-3
administering special mailboxes and classes of 
service, 5-7
alarm origination, 5-17
assigning IP addresses, 3-7
host machine profile, 3-11
host name setup, 3-7
load new software, C-1
network addressing, 3-7
PPP logins and passwords, 5-15
rebooting, 3-14
required administration, 3-6, 5-2
setting up remote access, 5-15
trusted servers, 3-12 to 3-14, 5-19, A-9
updating MAS host information, 5-4
verifying customer options, 5-2

MSS-H key components, 2-14
MSS-S key components, 2-12
MultiTech modem, 2-32, 4-21
MWI

configuring, 4-41
installing software, 4-39
maximum number of sessions, 4-45, A-11
testing operation, 5-10, 5-12
trusted server, 3-13, 4-38

N
NetBIOS domain, A-2, A-4
NetBIOS name, A-2, A-4
network addressing on MAS, 4-7
network addressing on MSS, 3-6
Network Addressing screen, 3-6, 3-8
Network and Dial-up Connections window, 4-7, 4-10
network identification, 4-6, 4-18
network planning, A-1
networking messaging systems, 5-18
nonintegrated mode test, 5-11

O
online help, xi
outcalling test, 4-36, 5-13

P
passwords

guidelines, A-9 to A-10
PPP logins, 5-15, A-13
S3400 logon accounts form, A-10
S3400 password table, A-9
security, 1-8, A-5, A-10
Services logins, A-13
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SMTP networking, 3-12
PBX

configuration notes, 2-5, 4-27, 4-40
configuring, 4-43
demarcation points, 1-7
integration, 4-45
planning form, A-12
supported integrations, 4-43

PBXpert utility for tones file, E-1, E-7
PBXpert wizard, E-2
performing acceptance tests, 5-10 to 5-13
Permissions for Subscriber Administration window, 4-43
Permissions for System Administration window, 4-43
Phone And Modem Options window, 4-21
ping IP addresses, 4-12 to 4-13, 5-5
planning forms, x, 1-6, A-1

MAS features list, A-11
PPP logins and passwords, A-13
S3400 logon accounts form, A-10
S3400 password table, A-9
S3400 system planning form, A-6 to A-8
services logins and passwords, A-13
switch and messaging information, A-12

Point-to-Point Protocol, see PPP, A-3
port boards

configuring, 4-27, 4-30, 4-32, 4-45
connecting cables, 2-24
extension numbers, A-12
hardware wizard, D-3
supported boards, 2-4, 4-27
testing, 4-32, 4-34 to 4-36

Ports Properties window, 4-21
PostMaster mailbox, 5-7, 5-9, A-12
power cables for S3400 system, 2-22
power requirements, 1-4
powering up the system, 3-2
PPP logins and passwords, 5-15 to 5-16, A-13
PPP Server Configuration screen, 5-16
preinstallation planning, 1-6, A-1
printing a test fax, 5-12
private FQDN, A-2, A-4
private LAN

cabling, 2-29
default values, A-5
names and aliases, 5-4
settings on MAS, 4-10
settings on MSS, 3-8
terminology, A-3
testing addresses with ping, 4-12, 5-5

Product ID number, A-13
public FQDN, A-2
public LAN, see corporate LAN

Q
QSIG integration, 4-44

R
rack-mount setup

KVM switch, 2-25
S3400 servers, 2-19
sample installed system, 2-6
UPS and EBMs, 2-8

RAS and IAS Servers Properties window, 4-23 to 4-24
recovering from a catastrophic disk failure, F-1
Regional Options window, 4-4
regional settings, date, and time, 4-4
related resources, xi
remote access setup, 4-20, 4-23 to 4-24, 5-15
remote machine for networking, 5-18
Remote Maintenance Board, see RMB
remote support center, xi
removing test subscribers, 5-14, 5-21
rename administrator account, 4-5
rename Local Area Connection, 4-7, 4-12
rename machine, 4-6
restart messaging service, 4-40, 4-44
restricted-access location, 1-3
retrieving test messages, 5-10
RMB cabling, 2-34 to 2-35
RMB modem, 2-34 to 2-35, 5-16 to 5-17
Routing and Remote Access Properties window, 4-20

S
S3400 servers

cabling, 2-28 to 2-29, 2-31
configuration, 2-2
installation, 2-18 to 2-19, 2-21 to 2-22, 2-24
key components, 2-12
weight, height, and depth, 1-2

S3400 system
overview, 2-2
powering up, 3-2

S3400 system planning form, A-4, A-6 to A-8
safe mode password, 4-15, A-10
safety requirements, 1-3 to 1-4
scheduled backup, 5-22, 5-24
Scheduled Tasks window, 5-22 to 5-23
security, 1-8

passwords, A-5, A-9 to A-10
Security - Voice Mail Domain, 4-43
sending test messages, 5-10 to 5-12
Services account, 4-16, A-10



Avaya™ S3400 Message Server Release 1 Installation

IN-vi  June 2003585-310-326, Issue 2

Services Account Properties window, 4-23
set emulation boards

cabling, 2-24
configuring, 4-30
testing, 4-35

setting up remote access, 4-20, 4-23 to 4-24, 5-15
setting up the monitor, 3-4
site requirements, 1-1

customer-provided cabinet, 1-3
demarcation points, 1-7
environmental conditions, 1-2
installation area, 1-3
LAN and PBX/switch administration, 1-6
power and ground, 1-4
security, 1-8
test equipment, 1-5
tools, 1-5
weight and space considerations, 1-2

SMTP networking, 3-12, 5-18, A-12
software shipped with system, 2-5
space considerations, 1-2
stackable configuration

KVM switch, 2-26
S3400 servers, 2-21
UPS and EBMs, 2-10

start messaging service, 4-40, 4-45
static IP addresses, 4-22, A-5
stop messaging service, 4-25
subnet mask, A-2
Subscriber Options package, 5-13
switch and messaging information, A-12
switch, see PBX
synchronizing MAS time with the MSS, 4-26
system configuration, 2-2
system hardware, see hardware installation
system planning forms, A-1
System Properties window, 4-6, 4-18, F-3
system security, 1-8

T
T1/E1 connections, 1-3
T1-QSIG boards

cabling, 2-24
configuring, 4-32
testing, 4-34 to 4-35

TCP/IP settings, 3-7, 4-7 to 4-8, 4-10
technical assistance, xi
Telephone User Interface, 4-41
telephones for acceptance testing, 1-5, 5-10
Telephony Configuration Wizard, 4-44

Telephony Interface configuration, 4-45
temperature requirements, 1-2
terminology, A-2
test equipment, 1-5, 5-10
test subscriber

add, 5-9, 5-20
planning form, A-12
remove, 5-14, 5-21

testing IP addresses using ping, 4-12
testing outcalling capability, 4-36, 5-13
testing port boards, 4-35
time and date setup, 3-5, 4-4
tones file, 4-29, E-1 to E-2, E-7
tools for installation, 1-5
Tracing Server, 4-39, A-11
trademarks, x
training, xi
Trusted Server Profile screen, 3-12 to 3-14
trusted server setup, 3-12 to 3-14

U
uninterruptible power system, see UPS
unpacking the system hardware, 2-3
UPS installation, 2-8
USB modem, 2-32, 4-20 to 4-21

V
ventilation of servers, 1-3
verifying customer options, 5-2
voice mail domain, 4-37 to 4-38, 4-41, A-3 to A-4
Voice Mail Domain Selection screen, 4-37 to 4-38, F-2
voice mail system configuration, 4-40
Voice Mail System Configuration window, 4-41
Voice Server Prompt Files, 4-39, A-11

W
weight and space considerations, 1-2
Windows domain, 4-18, 5-6, A-3 to A-4
Windows Domain Setup screen, 5-6
Windows product key, D-2
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